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§1.1. Cəmiyyətin informasiyalaşdırılmasında  
kitabxanaların rolu 

 
Bəşər sivilizasiyasının "qızıl yaddaşı" adlanan kitab-

xanalar ən böyük informasiya mənbəyi olub, óçóí ÿñðëÿð áîéó 
müxtəlif tarixi şəraitlərdə və úÿìèééÿòëÿðäÿ  ôÿàëèééÿò 
ýþñòÿðìèø, úÿìèééÿòèí òÿðÿããèñèíÿ õèäìÿò åòìèøëÿð. Kitab-
xanaların çox qədim və zəngin bir tarixi vardır. Onlar  qədim 
dünyanın, orta əsrlərin kasıb fondlu kitabxanalarından 
başlayan, kompüterləşdirilmiş, ümumi istifadə üçün açıq, 
müasir kitabxanalara qədər uzun bir təkamül yolu keçmişdir. 
Bu tarixi yolu keçərkən onlar cəmiyyətdə baş verən iqtisadi, 
siyasi və sosial proseslərə, yeni dövrün tələblərinə uyğun olaraq 
böyük dəyişikliklərə məruz qalmış, fəaliyyət göstərdiyi məkan 
daxilində sosial vasitə kimi həmişə sosial mühitdən asılı olaraq 
formalaşmışdır. Kitabxanalar bütün dövrlərdə  öz hamisi olan 
cəmiyyətə xidmət etmiş, onun informasiya tələbatını ödəmiş, 
sosial sifarişini yerinə yetirmişdir. 

Sivilizasiyanın başlanğıcından zəmanəmizə qədər olan 
dövrdə kitabxana tarixinə nəzər saldıqda həm qədim dünya 
kitabxanalarının, həm də inkişaf etmiş müasir kitabxanaların 
fəaliyyətində üç mühüm amil diqqəti cəlb edir: 

1. Kitabxana elmi sərvətləri toplayıb, onları insanların 
istifadəsinə verməklə elmin, mədəniyyətin, iqtisadiyyatın, 
texniki biliklərin, elmi kəşflərin öyrənilməsi və tətbiqi üçün 
şərait yaradır, beləliklə də, elmi-texniki tərəqqiyə, elmi 
nəzəriyyələrin, kəşflərin istehsalata tətbiqi prosesinə kömək 
göstərir. Elmlə istehsalat, tədqiqlə tətbiq arasında vasitə kimi 
çıxış edir. 

2. Êèòàáõàíàëàð həm də áÿøÿðè ñÿðâÿòëÿðè  qoruyub, 
saxlayıb, íÿñèëäÿí-íÿñëÿ ÷àòäûðûrlar. Möáàëèüÿñèç äåìÿê 
ëàçûìäûð êè, êèòàáõàíàëàð îëìàñàéäû áÿøÿðèééÿòèí éàðàòäûüû 
åëìè, ìÿäÿíè, ôÿëñÿôè âÿ ÿäÿáè-áÿäèè ñÿðâÿòëÿðèí ÿí ýöúëö 
èíôîðìàñèéà äàøûéûúûëàðû ñàéûëàí êèòàáëàðû ãîðóìàã âÿ 
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çÿìàíÿìèçÿ ýÿòèðèá ÷ûõàðìàã ìöìêöí îëìàçäû. Êèòàáõàíàëàð 
îëìàñàéäû ìÿäÿíè èíêèøàô, òÿðÿããè áàø âåðìÿçäè, úÿìèééÿò 
éåðèíäÿ ñàéàðäû, þéðÿíèëìèø, öìóìèëÿøäèðèëìèø, 
ñèñòåìëÿøäèðèëìèø èíñàí ôÿàëèééÿòèíèí íÿòèúÿñè îëàí 
áèëèêëÿðè âÿ êÿøôëÿðè éåíèäÿí êÿøô åòìÿê ëàçûì ýÿëÿðäè. 

3. Kitabxana elm, mədəniyyət, ədəbiyyat, incəsənət və 
təhsil kimi mənəvi sərvətlərə dair çap əsərlərinin, məlumatın, 
biliyin yayılmasında fəal iştirak etməklə tərbiyə prosesinə, 
bəşəri, əxlaqi biliklərə yiyələnmə prosesinə, cəmiyyətin 
inkişafına yardımçı ola biləcək intellektual səviyyəli insan 
yetişdirilməsi prosesinə xidmət göstərir.  

 Beləliklə, dünya mədəniyyətinin ən qiymətli incilə-
rindən hesab edilən kitabxanalar cəmiyyətin yaratmış olduğu 
mədəni qurumlar arasında ən qədimlərindən biri olmaqla, 
bəşəriyyətin mədəni sərvətlərini toplayan, mühafizə edən, 
saxlayan, ictimai istifadə üçün nəsildən-nəslə çatdıran, 
cəmiyyətin tərəqqi və inkişafında yaxından iştirak edən, 
cəmiyyət üzvlərinin, bütün insanların mədəni və intellektual 
səviyyəsinin yüksəldilməsinə kömək edən, gənc nəslin təhsil və 
tərbiyəsində yaxından iştirak edən, öz ətrafında böyük oxucu 
dairəsi toplayıb onlara informasiya və kitabxana xidməti 
göstərən, oxucuların tələbatını ödəməklə mütaliə prosesinə 
kömək edən sosial institutlardır. Kitabxanalar öz 
fəaliyyətlərində bir-biri ilə bağlı aşağıdakı üç vəzifəni yerinə 
yetirirlər1: 

1. İnformasiya daşıyıcılarını əldə etmək; 
2. Kitabxana fondlarını yaratmaq və qaydaya salmaq; 

                                                           
1 Bu üç vəzifəni yerinə yetirmədən 
kitabxananı bəşəriyyətin inkişafına xidmət 
edən müəssisəyə çevirmək, elmi biliklərin 
toplandığı mərkəz və tərbiyə məktəbi 
səviyyəsinə yüksəltmək mümkün olmazdı. 
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3. Kitabxanada toplanmış informasiya daşıyıcılarından 
istifadəni təşkil etmək. 

Əhalinin müəyyən təbəqəsinə, müəyyən oxucu dairəsinə 
xidmət etməyi öz qarşısına məqsəd qoyan kitabxanalar, hər 
şeydən əvvəl elm, bilik, mədəniyyət, təhsil daşıyıcıları olan 
informasiya ehtiyatlarını - kitablarla, dövri nəşrlərlə və digər 
audiovizual materiallarla təchiz olmuş öz fondunu yaradırlar. 
Çünki kitabxananın fondu, onun əsas özəyi yaradılmadan 
kitabxana xidmətindən danışmaq mümkün deyildir. Kitabxana 
məfhumu o zaman meydana gəlib reallaşır ki, onun oxucuların 
tələbatını, sorğularını ödəmək imkanı və maddi-texniki bazası 
olsun. Əlbəttə, bu bazanın əsas hissəsini informasiya 
daşıyıcıları təşkil edir. Məhz buna görədir ki, tarixə nəzər 
saldıqda dünya kitabxanalarının qiymətinin, bəşər 
mədəniyyətinə xidmət prosesində iştirakının mühüm 
amillərindən, başlıca göstəricilərindən biri kimi onun fondu 
nəzərdə tutulmuş, fondun komplektləşdirilib tədricən 
təkmilləşdirilməsi kitabxana işinin əsası, bünövrəsi hesab 
edilmişdir. Odur ki, tarixən kitabxana fondları  mədəniyyətin, 
təhsilin, biliyin qızıl fondları kimi qiymətləndirilmiş, onların 
əsas daşıyıcıları hesab edilmiş, kitabxanalar isə bütün elmi kəş-
fləri, intellektual nailiyyətləri, cəmiyyətin yaratdığı bütün 
dünyəvi sərvətləri əsrlərdən-əsrlərə, nəsillərdən-nəsillərə 
çatdıran mühüm mədəniyyət mərkəzi, elmi bilikləri yayan 
institut kimi səciyyələndirilmişdir. Tarixin ilk çağlarından bu 
yana dünyanın ən görkəmli dühaları kitabxanaların topladığı 
elmi və mədəni sərvətləri bəşəriyyətin bilik və düşüncələrinin, 
insan yaradıcılığının daşıyıcıları kimi dəyərləndirmişdirr. Heç 
təsadüfi deyil ki, qədim dünya və orta əsrlər kitabxanalarının 
ilk kitabxana xadimləri görkəmli filosoflar, alimlər və 
mədəniyyət xadimləri olmuşlar.  

Kèòàáõàíà èíêèøàô åäÿí «îðãàíèçìäèð». Èíêèøàô åäÿí canlı 
îðãàíèçìäÿ ùöúåéðÿëÿð äÿéèøäèéè, òÿçÿëÿíäèéè êèìè 
êèòàáõàíàëàðûí èíêèøàôûíäà âÿ ñòðóêòóðóíäà çàìàí êå÷äèêúÿ 
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áþéöê äÿéèøèêëèêlər áàø âåðèð. Áó äÿéèøèêëèêëÿð àéðû-
àéðûëûãäà, áèð-áèðèíäÿí, òÿúðèä åäèëìèø øÿêèëäÿ éîõ, 
êèòàáõàíàíûí òÿáèÿòèíÿ óéüóí ñèñòåì øÿêëèíäÿ ôÿàëèééÿò 
ýþñòÿðÿí åëåìåíòëÿðèí ãàðøûëûãëû ÿëàãÿñè ïðîñåñèíäÿ áàø 
âåðèð1. 

ÕIÕ-ÕÕ ÿñðëÿðäÿ êèòàáõàíàëàð äàùà áþéöê èíêèøàô éîëó 
êå÷ìèø, ñèâèëèçàñèéàëû úÿìèééÿòèí ÿñàñ àòðèáóòëàðûíäàí 
áèðèíÿ ÷åâðèëìèøäèð. Ìèëëè, öìóìè, åëìè, åëìè-òåõíèêè, öìóìà÷ûã 
õàëã êèòàáõàíàëàðûíûí ìåéäàíà ýÿëìÿñè âÿ ýåíèø èíôîðìàñèéà 
ôÿàëèééÿòè ýþñòÿðìÿñè úÿìèééÿòèí ìÿíÿâè òÿìèíàòû èëÿ éàíàøû 
îëàðàã åëìèí, âÿ èãòèñàäèééàòûí èíêèøàôûíäà äà áþéöê ðîëà ìàëèê 
îëäóüóíó àøêàðà ÷ûõàðìûøäûð. Áó ÿñðëÿðäÿ áþéöê èíêèøàô éîëó 
êå÷ÿí òÿùñèë ñèñòåìè, cəmiyyətdə êöòëÿâè ìöòàëèÿíèí ýåíèø 
âöñÿò àëìàñû êèòàáõàíàëàðûí ôÿàëèééÿò äàèðÿñèni õåéëè 
ýåíèøëÿídirìèødir.  Êèòàáõàíàlarûí ÿòðàôûíäà áþéöê îõóúó 
äàèðÿñèíèí éàðàíìàñû, îíëàðûí ìàðàüûíûí âÿ èíôîðìàñèéà 
òÿëÿáàòûíûí àðòìàñû êèòàáõàíàëàðûí ãàðøûñûíäà éåíè 
âÿçèôÿëÿð - ùÿëÿ èíäèéÿ ãÿäÿð êèòàáõàíà òÿúðöáÿñèíäÿ 
èñòèôàäÿ åäèëìÿìèø ïðîáëåì âÿçèôÿëÿð ãîéóðäó. Êèòàáõàíàëàð 
áó âÿçèôÿëÿðèí þùäÿñèíäÿí ýÿëìÿê, äóðìàäàí àðòàí îõóúó 
òÿëÿáàòûíà úàâàá âåðìÿê ö÷öí éåíè èø ôîðìà âÿ öñóëëàðûíäàí, 
åëìè ìåòîäëàðäàí èñòèôàäÿ ådərək, ùóìàíèñò äÿéÿðëÿðèí ìÿíáÿéè 
êèìè ôÿàëèééÿò ýþñòÿðìəyə başladılar. 

ÕÕ ÿñð áÿøÿðèééÿòèí òàðèõèíÿ àòîì, åëìè-òåõíèêè 
òÿðÿããè, èíôîðìàñèéà ïàðòëàéûøû, ìÿäÿíèééÿòèí éöêñÿê 
òÿðÿããèñè ÿñðè êèìè äàõèë îëìóøäóð. Áó áþéöê 
ìöâÿôôÿãèééÿòëÿðäÿ úÿìèééÿòèí èíôîðìàñèéàëàøäûðûëìàñû 
áþéöê ðîë îéíàìûøäûð êè, áó èøäÿ êèòàáõàíàëàðûí õèäìÿòè 
ÿâÿçåäèëìÿçäèð. İnformasiyalaşdırma sahəsində əldə edilən 
uğurlara, informasiyalaşmanın inkişaf dinamikasına 
ÿñàñëàíàðàã äöíéàíıí ýþðêÿìëè àëèìëÿðè ÕÕI ÿñðè èíôîðìàñèéà 
və yaxud  informasiyalaşmış vətəndaş cəmiyyəti  quruculuğu 
                                                           
1 Bu fikirlər gþðêÿìëè ùèíä êèòàáõàíàøöíàñû 
Ø. Ð. Ðàíãàíàòàía məxsusdur.  
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əsri êèìè ãèéìÿòëÿíäèðèðëÿð. İnformasiyalaşmış vətandaş 
cəmiyyətində sosial sifariş olaraq êîìïöòåðëÿøäèðìÿíè 
úÿìèééÿòèí áöòöí ñàùÿëÿðèíÿ, î úöìëÿäÿí èíôîðìàñèéà 
ìöÿññèñÿñè îëàí êèòàáõàíà èøèíÿ âÿ úÿìèééÿòèí 
èíôîðìàñèéàëàøäûðûëìàñûíà òÿòáèã åòìÿê òÿëÿáàòû ãàðøûéà 
÷ûõûð. Áó ýöí èíñàí ôÿàëèééÿòèíèí áöòöí ñàùÿëÿðèíèí 
êîìïöòåðëÿøäèðèëìÿñè úÿìèééÿòèí ÿñàñ ñàùÿñè êèìè ôîðìàëàøûð, 
ñîñèàë èíêèøàôûí ìöùöì âÿ ãåéä-øÿðòñèç àìèëè ùåñàá åäèëèð. Áó 
âÿçèôÿëÿðè ìöñáÿò ùÿëë åòìÿäÿí úÿìèééÿòèí ùóìàíèñòúÿñèíÿ 
éåíèäÿí ãóðóëìàñû, èãòèñàäè èíêèøàôû, éöêñÿê ìàääè òÿìèíàòı, 
èíñàíëàðûí ìàääè ðèôàùûíûí éàõøûëàøäûðûëìàñû ìöìêöí äåéèëäèð. 

Kitabxanalar ən böyük informasiya mənbəyi olduğundan, 
informasiyalaşmış vətəndaş cəmiyyəti quruculuğunda onun 
rolu əvəzsizdir. Müasir kitabxanalar elm, informasiya, 
mədəniyyət, təhsil və tərbiyə müəssisəsi kimi çap əsərlərini və 
digər informasiya daşıyıcılarını toplayıb mühafizə edən, 
onların sistemli istifadəsini təşkil edən, cəmiyyətin intellektual 
və mənəvi potensialının inkişafına xidmət göstərən sosial 
institut olmaqla, informasiyalaşmış vətəndaş cəmiyyətinin əsas 
göstəricisi olan qlobal informasiya mühitinin yaradılmasında, 
informasiyanın əmtəəyə çevrilməsində, informasiya və bilik 
bazarının yaradılması və inkişafında, təhsil sisteminin və 
səviyyəsinin təkmilləşməsində, beynəlxalq, milli və regional 
səviyyədə informasiya mübadiləsi sistemlərinin imkanlarının 
genişlənməsi hesabına cəmiyyətin peşə və ümumi mədəniyyət 
səviyyəsinin artmasında aparıcı rol oynayırlar. Müasir kitabxa-
nalar ən yeni kompüter-telekommunikasiya texnikası ilə təchiz 
olunmuş, kitabxana-informasiya texnologiyasının son 
nailiyyətləri tətbiq olunan, yüksək ixtisaslı mütəxəssis 
potensialına malik, müasir oxuculara coğrafi uzaqlıqdan asılı 
olmayaraq, sutkanın 24 saatı müddətində on-line xidmət 
göstərən informasiya müəssisələridir1. Müasir kitabxanalar 
                                                           
1 Müxtəlif ölkələrdə informasiyalaşmış 
vətəndaş cəmiyyəti quruculuğu müxtəlif 
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İnternet kompüter şəbəkəsi vasitəsilə heç bir siyasi, dini, milli 
məhdudiyyətlər tanımayaraq,  ölkələrin coğrafi sərhədlərini 
aşaraq öz informasiya xidmətlərini oxuculara bilavasitə 
yaşadıqları və işlədikləri yerlərdə təqdim edərək, úÿìèééÿò 
öçâëÿðèíèí ìÿíÿâè àëÿìèíÿ, òÿôÿêêöð òÿðçèíÿ, ÿõëàãûíà, 
ïñèõîëîýèéàñûíà äàùà ÷îõ íöôóç åtmək imkanına malikdirlər.     

§1.2. Kitabxanaların kompüterləşdirilməsinin əhəmiyyəti və 
əsas prinsipləri 

Kompüter-telekommunikasiya texnologiyasının ya-
ranması və sürətli inkişafı cəmiyyət həyatında köklü dəyi-
şikliklərə səbəb olaraq cəmiyyətin sosial institutlarının in-
kişafını zəruri edən yeni sosial sifarişlər döğurur.  Bu sosial 
sifarişlərdən biri də kitabxanaların kompüterləşdirilməsidir.  

Kitabxanaların kompüterləşdirilməsi bəzi şəxslərin   
hesab etdiyi kimi kitabxanaların kompüter texnikası ilə təchiz 
olunması və bu qiymətli avadanlıqlardan yalnız  kargüzarlıq 
fəaliyyətində və İnternet xidmətindən istifadə  etmək üçün 
istifadə olunması deyil. Kitabxanaların kompüterləşdirilməsi 
kitabxanaların avtomatlaşdırılmasının tərkib hissəsi olub, 
kitabxanalarda yerinə yetirilən mürəkkəb, bir-birilə əlaqəli 
texnoloji proseslərin informasiya-telekommunikasiya 
texnologiyaları əsasında avtomatlaşdırılmasıdır. 

Kitabxana proseslərinin  kompüterləşdirilməsinə dair 
tədqiqat işlərinə XX əsrin 50-cı illərindən başlanılmışdır.  
Lakin bu işlərin kitabxanalarda tətbiq edilməsi, müvafiq texniki 
təminatsızlıq üzündən yalnız 70-ci illərdə mümkün olmuşdur. 
Belə ki, həmin müddətdə istifadə olunan kompüterlər böyük 
həcmli olub, istifadəsi mürəkkəb, çoxsaylı xidmət heyəti tələb 
                                                                                                                            
inkişaf səviyyəsinə malik olduğu kimi, 
kitabxanaların inkişaf səviyyəsi də 
müxtəlifdir. Cəmiyyət necədirsə, onun 
kitabxanaları da özünəməxsusdur. 
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edən, həddən artıq bahalı qurğular idi. Bu  keyfiyyətlər isə 
onların kitabxanalarda istifadəsini qeyri-rentabelli edirdi. 
Yalnız fərdi kompüterlərin istehsalı, şəbəkə texnologiyasının 
meydana gəlməsi kitabxanaların kompüterləşdirilməsini elmi 
və iqtisadi cəhətdən əlverişli etdi. Kitabxanaların 
kompüterləşdirilməsinə ilk dəfə ABŞ-ın Konqres 
kitabxanasında, sonradan isə qeyd olunan ölkənin akademik 
kitabxanalarında başlandı. Kompüterləşdirmənin əhəmiyyəti və 
perspektivliyi qısa müddətdə  özünü təsdiq etdi və bu gün o, 
muasir kitabxanaların yaradılması üçün əsas şərtlərdən biri 
hesab olunur. 

Kompüter informasiya texnologiyasının sürətli inkişafı 
kitabxanaların kompüterləşdirilməsinin kəmiyyət və keyfiyyət  
səviyyəsinin yüksəlməsini təmin edir. Məsələn, əvvəllər əsasən 
komputerləşmənin lokal məsələləri həll olunurdusa, İnternetin 
yaranması və inkişafı nəticəsində bu gün oxuculara uzaq 
məsafədən on-line xidmət, kitabxanalararası elektron sənəd 
göndərişi  və s.  xidmətlər yerinə yetirilir, korporativ kitabxana-
informasiya  şəbəkələri, virtual elektron kitabxanalar yaradılır. 
Bunların nəticəsində bir sıra kitabxanalar artıq öz sosial 
funksiyalarını genişləndirərək, həm də analitik-informasiya 
mərkəzlərinə çevrilmişdir.  

Kitabxananın kompüterləşdirilməsi yüksək ixtisaslı 
kitabxanaçıların, informasiya mütəxəsisslərinin birgə əməyi və 
düzgün təşkilati işlər nəticəsində yerinə yetirilən, müəyyən vaxt 
və maliyyə vəsaiti tələb edən  bir prosesdir. ABŞ, Kanada və 
Qərbi Avropa ölkələrində kitabxanaların kompüterləşdirilməsi 
təcrübəsinə əsaslanaraq kitabxanaların kompüterləşdirilməsi 
üçün aşağıdakı baza   prinsipləri qeyd etmək olar1: 
                                                           
1Bu prinsiplər  1971-ci ildə kitabxana-
informasiya sahəsində dünya-da aparıcı 
mütəxəssislərdən hesab olunan 
X.X.Bernşteyn tərəfindən irəli 
sürülmüşdür. 
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1. Kitabxananın kompüterləşdirilməsi ayrı-ayrı şəxslərin 
təşəbbüsü əsasında deyil, cəmiyyətin sosial sifarişi əsasında 
yerinə yetirilməlidir.  

2. Kompüterləşdirmə kompleks şəkildə və  informasiya-
nın, kompüter-telekommunikasiya avadanlıqlarının və proqram 
məhsullarının tez “köhnəlməsi” səbəbindən sürətlə 
aparılmalıdır. Bunun üçün müvafiq maddi və insan resursları 
cəlb edilməlidir. 

3. Kompüterləşdirməyə başlamazdan əvvəl geniş  ma-
ariflənmə işi aparılmalı, kompüterləşmənin zəruriliyi əsas-
landırılmalıdır. Bununla, kompüterləşmə əvvəl kitabxanada 
müşahidə olunan psixoloji baryer (işçilərin ixtisarı, lazımsız 
olması və s.) aradan götürülməlidir.  

4. Kitabxananın kompüterləşdirilməsinə kitabxananın 
Texniki sənədinin hazırlanmasından başlanılmalıdır. Texniki 
sənəd kitabxananın kompüterləşdirilməsinin pasportu olub, çox 
«savadlı» hazırlanmalıdır. Texniki sənəddə kitabxananın 
kompüterləşdirilməsinin hansı zərurətdən yarandığı 
əsaslandırılmalı və bu kompüterləşdirmədən nə gözlənildiyi öz 
əksini tapmalıdır. Texniki sənəd xüsusi komissiya tərəfindən 
hazırlanır. Həmin komissiyanın sədri müəssisənin rəhbəri və ya 
onun həvalə etdiyi məsul şəxsdir. Komissiyada informasiya 
mütəxəssisinin iştirakı vacibdir. Sənədə həmçinin kitabxananın 
struktur sxemi, vəzifə göstəriciləri və təlimatları əlavə 
olunmalıdır. Sənəd yuxarı təşkilatla (nazirlik), 
kompüterləşdirilməni maliyyələşdirən donor və ya sponsor 
təşkilatlarla razılaşdırılmalıdır. Bu sənəddə kitabxana haqqında 
tam məlumat: strukturu, idarə olunması, kadr potensialı, fondu, 
oxucu kontingenti, xidmət növləri, texniki və informasiya 
təchizatı, maliyyə mənbələri, kitabxanalararası və beynəlxalq 
kitabxana təşkilatları ilə əlaqələri, statistik göstəriciləri, 
avtomatlaşdırmanın məqsədi və əhəmiyyəti, kitabxananın 
texniki-informasiya tələbatı əksini tapmalıdır. Sənəd ha-
zırlanarkən, dərin təhlil aparılmalı, kitabxanaların avto-

 

 

16

matlaşdırma təcrübəsi, kitabxana-informasiya texnologiyası 
sahəsində qabaqcıl nəzəri və praktiki biliklər öyrənilməli, 
kitabxananın heç olmasa gələcək 10 illik inkişaf perspektivləri 
və s.  nəzərə alınmalıdır. 

5. Texniki sənəd əsasında Kitabxananın kompüter-
ləşdirilməsi layihəsi hazırlanmalıdır1. Kitabxananın  kompü-
terləşdirilməsi layihəsi kompüter-informasiya texnologiyası 
mütəxəssisləri tərəfindən hazırlanır. Layihənin priampula 
hissəsi layihə qabağı tədqiqatdan ibarətdir. Bu hissə texniki 
sənəd əsasında hazırlanır və kitabxanada tətbiq olunan 
texnologiyanın təhlilindən, kəmiyyət göstəricilərindən ibarətdir. 
Bundan sonra layihədə kitabxananı kompüterləşdirmək üçün 
tələb olunan işlərin siyahısının əsaslandırılması öz əksini tapır. 
Layihədə mütləq 2 vacib komponent-kompüterləşdirmənin  
Texniki və proqram təminatı xüsusi bölmələrdə öz əksini 
tapmalıdır. Layihənin Texniki təminat bölməsində  
kitabxananın kompüterləşdirilməsi üçün zəruri olan texniki 
qurğular və vasitələrə: kompüter, şəbəkə-kommunikasiya, 
elektrik, mühafizə və s. avadanlıqlarına, rabitə xətləri və 
kanallarına tələbat  şərh olunmalı və əsaslandırılmalıdır. Bu 
bölmədə həmçinin quraşdırılacaq avadanlıqların, rabitə 
vasitələrinin texniki göstəriciləri, onları satan ən azı üç 
firmanın qiymətlər siyahısı, yerləşmə və quraşdırma sxemləri 
öz əksini tapmalıdır. 

Layihənin Proqram təminatı bölməsində istifadə 
olunacaq proqram təminatı, onun funksiyaları şərh olunmalıdır.  
Proqram təminatının seçilməsi  üçün kompüter-informasiya 
texnologiyası bazarında mövcud proqram təminatı təhlil 
olunmalı və onun içərisindən ən optimalı seçilməlidir. Müasir 
dövrdə kompüterləşmənin kompüter-informasiya texnologiyası 
sürətlə inkişaf etdiyindən və tez «texniki baxımdan 
qocaldığından» proqram təminatının seçilməsi həddən artıq 
                                                           
1Layihənin rəhbəri və yerinə yetirilməsinə 
məsul şəxs kitabxana direktorudur.  
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məsuliyyətli bir işdir və o, yüksək ixtisaslı mütəxəssislər 
tərəfindən yerinə yetirilməlidir. 

6. Maliyyə-smeta sənədlərinin hazırlanması. Maliyyə-
smeta sənədləri konkret işə uyğun olaraq və layihədə təsdiq 
olunmuş iş qrafikinə əsasən hazırlanır. Bu sənədlər layihənin 
rəhbəri tərəfindən maliyyələşdirici təşkilata göndərilir və 
müvafiq maliyyənin vaxtında ayrılması üçün bütün vəsitələrdən 
istifadə olunur. 

7. Layihə qabağı işlərin görülməsi.  Bu maliyyə vəsaitinin 
ayrılmasını, avadanlıqların alınmasını və texniki quraşdırma 
işlərinin görülməsini, müvafiq kadrların hazırlanmasını nəzərdə 
tutur. Kadrların hazırlanması məsələsi ən önəmli bir məsələdir. 
Avtomatlaşdırma istər informatikanı, istərsə də müasir 
kitabxana işini yüksək səviyyədə bilməyi tələb edir. Bu 
məqsədlə yeni gənc kadrların,  artıq avtomatlaşmış 
kitabxanalarda təcrübə keçmiş kitabxanaçıların cəlb olunması, 
hazırlıq kurslarının yaradılması tələb olunur. Avtomatlaşdırma 
ilə bağlı kitabxanada struktur dəyişikliklərin aparılması 
zəruridir. Belə ki, avtomatlaşdırma yorucu və uzunmüddətli 
insan əməyindən imtina etməyə, bir neçə şöbənin işinin bir 
Avtomatlaşmış İşçi Yeri vasitəsilə görülməsinə şərait 
yaratdığından, kitabxana informasiya-kompüter şəbəkəsinə  
xidmət zərurəti struktur islahatlarının aparılmasını diktə edir. 

8. Layihənin yerinə yetirilməsi. Layihənin yerinə yetiril-
məsi böyük zəhmət, xərc və müəyyən vaxt tələb etdiyindən ilk 
öncə istiqamətlər seçilməlidir. Kompüterləşmənin əsas məqsədi 
oxucuların informasiya tələbatını coğrafi uzaqlıqdan asılı 
olmayaraq, operativ və tam ödəmək olduğundan prioritet 
istiqamət olaraq aşağıdakıları qəbul etmək olar: 

• Ənənəvi kitabxana texnoloji proseslərinin kompü-
terləşdirilməsi. Bu istiqamətdə işlər  ağır və yorucu kitabxanaçı 
əməyini yüngülləşdirmək, əmək məhsuldar-lığını və 
effektivliyini yüksəltmək, informasiya məhsullarını, xidmət 
növlərini keyfiyyət və kəmiyyət baxımından artır-maq, 
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kitabxana fondunun etibarlı sürətdə mühafizəsi və bu fonddan 
daha geniş oxucu kontingentinin səmərəli istifadəsini təmin 
edir.  Ənənəvi texnoloji prosesləri kompüterləşdirməklə 
kitabxanaçı əməyinin korporasiyasına nail olmaq, bununla da 
kitabxanada görülən bir sıra işlərin təkrar görülməsinin 
qarşısını almaq olar. Həmçinin görülən işlərin keyfiyyətinə 
mərkəzləşmiş və qarşılıqlı nəzarət təmin olunur, kollektiv əmək 
mədəniyyəti formalaşır. Bunun nəticəsində də iş vaxtından və 
kadr ehtiyatlarından səmərəli istifadə etmək, maliyyə 
vəsaitlərinə qənaət etmək mümkün olur. Kitabxana 
proseslərinin kompüterləşməsi həmçinin «ədəbiyyatın 
hərəkətinə» nəzarət etməyə, kitabların fonda vaxtında 
qaytarılmasına və bununla ondan səmərəli istifadəni təmin edir.  

• Elektron kataloqun yaradılması. Elektron kataloq 
kitabxana fondunun «güzgüsüdür». Elektron kataloq vasitəsilə 
oxuculara uzaq məsafədən operativ informasiya xidməti,  
fondun idarə olunması  həyata keçirilir. Kitabxananın 
İnternetdə yerləşdirilmiş Elektron kataloqu dünyanın istənilən 
nöqtəsindən oxucuya kitabxananın fondu ilə tanış olmağa, 
çoxaspektli axtarış vasitələri ilə ədəbiyyat axtarışını aparmağa 
və tapılmış ədəbiyyatı sifariş etməyə, ədəbiyyatın elektron 
nüsxəsi olduqda isə onu əldə etməyə imkan verir. Ənənəvi 
kataloqdan fərqli olaraq elektron kataloq oxucuya axtarılan 
ədəbiyyat haqqında geniş məlumat – ədəbiyyatın  nüsxələrinin 
sayı, istifadə üçün «azad» nüsxələrin sayı,  cari anda fondda 
olmayan nüsxələrin vəziyyəti, kimdə olması, nə vaxt 
qaytarılacağı və s.  informasiyalar verir. Elektron kataloq 
biblioqrafik informasiya bazasının daha etibarlı qorunmasını 
təmin edir və oxucunun onu xarab etməsi praktiki olaraq qeyri-
mümkündür. Lakin ənənəvi kataloqda təəssüf ki, biblioqrafik 
informasiya daşıyıcıları olan kartoçkaların itməsinə, istifadə 
nəticəsində «oxunmaz» vəziyyətə düşməsinə hələ də rast 
gəlmək olur. Digər tərəfdən çoxminli ənənəvi kataloqda 
kartoçkanın  itməsi faktının aşkar olması üçün müəyyən vaxt 
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lazım gəlir və bəzən də bu mümkün olmur. Elektron kataloq 
kitabxanalararası biblioqrafik informasiya mübadiləsini təmin 
edir. Bunun üçün biblioqrafik məlumatlar bazası beynəlxalq 
maşınla oxunan formatlar əsasında yaradılmalıdır. Elektron 
kataloq həmçinin hər bir kitabxananın «imicini» formalaşdırır. 
Kitabxananın yüksək nüfuza və reytinqə malik olması üçün 
elektron kataloq zəngin məlumat bazasına və mükəmməl ax-
tarış aparatına malik olmalıdır. Məhz bununla kitabxana coğrafi 
uzaqlıqdan asılı olmayaraq  özünə dünyanın istənilən ölkəsində 
oxucu cəlb edərək xidmət göstərə bilər.  

• Elektron sənəd mübadiləsi xidmətinin təşkili; Bu xidmət 
oxucu sifarişini uzaq məsafədən yerinə yetirmək, 
kitabxanalararası elektron sənəd mübadiləsini təmin edir. 
Elektron sənəd göndərişi «ödənişli» xidmətdir.  Kitabxanada 
düzgün menecment və marketinq siyasəti aparılarsa, bu xidmət 
nəticəsində kitabxana əlavə gəlir əldə edə bilər. Bundan başqa 
bu xidmət kitabxana fondunun komplektləşdirmə qıtlığının 
qarşısını qismən də olsa ala bilər.  

• Elektron kitabxanaların yaradılması. Elektron kitab-
xanalar  müasir dövrün əsas tələbi olub, cəmiyyətin 
informasiyalaşdırılmasında mühüm əhəmiyyət kəsb edir. Bu 
səbəbdən elektron kitabxanaların təşkili hər ölkənin 
informasiya siyasətinin tərkib hissəsinə çevrilmişdir. Elektron 
kitabxanalar informasiya mübadiləsi sistemlərinin, virtual 
informasiya mühitinin yaradılmasına, distan təhsilin inkişafına, 
cəmiyyətin peşə və ümumi mədəniyyət səviyyəsinin artmasına 
xidmət edir. Onun vasitəsilə oxucular dünyanın istənilən 
nöqtəsindən 24 saat müddətində kitabxananın informasiya 
ehtiyatından istifadə edə bilirlər. 

Qeyd edək ki, kitabxananın kompüterləşməsi zamanı 
inzibati-amiranə idarəetmə üsulu yolverilməzdir. 
Kompüterləşdirmə kitabxanada müasir idarəetmə üsullarının 
tətbiqini, işçilər üçün müvafiq iş şəraitinin təşkilini, 
stimullaşdırmanı, düzgün menecment və marketinq siyasətinin 
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həyata keçirilməsini tələb edir. Kompüterləşməyə cəlb  olunan 
bütün əməkdaşlar kompüterləşdirmənin əhəmiyyətini və 
məsuliyyətini dərk etməlidir. Kitabxananın 
kompüterləşdirilməsi kollektiv əmək tələb etdiyindən və 
informasiyanın dəqiqliyinin zəruri olduğundan işçilər arasında 
sağlam və qarşılıqlı hörmətə əsaslanan münasibətlər 
formalaşmalıdır. Bu tələbata cavab verməyən işçilər işdən, 
xüsusilə də informasiya təminatı işindən uzaqlaşdırılmalıdır. 
Layihə yerinə yetirilərkən hər bir şəxsin konkret vəzifələri 
müəyyən edilməli və bu vəzifələrin konkret vaxtda yerinə 
yetirilməsi təmin olunmalıdır. Bu işə xüsusi nəzarət olmalı, bu 
və ya digər səbəbdən vəzifələr yerinə yetirilmədikdə həmin 
vəzifələr başqalarına həvalə olunmalıdır (müvəqqəti və uzun 
müddətli). Buna görə işçilərin «daha geniş» ixtisaslaşmaya 
sahib olmasına xüsusi fikir verilməlidir. Kompüterləşdirmənin 
müsbət nəticələnməsi üçün nizam-intizama əməl olunmasına 
xüsusi fikir verilməlidir. 

§1.3. Kitabxanaların kompüterləşdirilməsinin proqram-
texniki təminatı 

Kitabxanaların kompüterləşməsi yüksək ixtisaslı 
kitabxanaçıların və kompüter texnologiyası mütəxəssislərinin 
birgə əməyini tələb edən mürəkkəb bir texnoloji prosesdir. Bu 
proses texniki-proqram təminatı əsasında həyata keçirilir. 
Texniki-proqram təminatı kitabxanaların 
kompüterləşdirilməsinin baza komponentidir. Kompüter-
ləşdirmə  layihəsinin uğurla nəticələnməsi məhz texniki-
proqram təminatının düzgün seçilməsindən və quraşdırıl-
masından asılıdır.  

Kitabxanada yerinə yetirilən əsas texnoloji proseslər 
kollektiv əmək tələb etdiyindən bu prosesləri kompü-
terləşdirmək üçün ilk öncə lokal kompüter şəbəkəsi yara-
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dılmalıdır1. Kompüterləşdirmə layihəsini yerinə yetirmək üçün 
kitabxanalarda lokal kompüter şəbəkəsinin yaradılması 
zəruridir. Lokal kompüter şəbəkəsi kitabxana daxilində şəbəkə 
ehtiyatlarından2 birgə istifadəni və kompüterlər arasında 
operativ informasiya mübadiləsini təmin edir. İnformasiya 
mübadiləsi standart şəbəkə protokolları əsasında həyata 
keçirilir3. Kitabxanada lokal kompüter şəbəkəsinin yaradılması 
üçün aşağıdakı minimal texniki təminat tələb olunur: 

-kompüterlər; 
-kabellər; 

      -şəbəkə kartı; 
      -kommunikasiya  qurğuları. 
Şəbəkədə istifadə olunan kompüterlər  işçi stansiya və   server 
funksiyasını yerinə yetirir. Server fasiləsiz işləməli olduğundan 
server funksiyasını yüksək texniki göstəricili kompüterlər 
yerinə yetirir. Server şəbəkənin işlənməsinə nəzarət, montorinq 
və informasiyanın qorunması funksiyalarını həyata keçirir.  
Şəbəkədə  bir və ya bir neçə  server ola bilər. Məsələn, 
şəbəkədə fayl serverlə yanaşı kommunikasiya, məlumatlar 
bazası, elektron poçt, Web, FTP serverlər və s. ola bilər. İşçi 
stansiyalar  bu və ya digər  xüsusiyyətlərinə görə işçi qruplarda 
birləşirlər. Hər bir işçi qrup serverdə qeydiyyatdan keçir. Bu isə 

                                                           
1 Lokal kompüter şəbəkəsi yalnız kitabxana 
daxilində fəaliyyət göstərir və rabitə 
vasitələrilə bir-birilə əlaqələndirilmiş 
kompüter və periferya  qurğular 
sistemindən ibarətdir.  
2 Şəbəkə ehtiyatları dedikdə  informasiya 
ehtiyatı, proqram və əlavələr, periferiya 
qurğuları nəzərdə tutulur. 
3 Protokol şəbəkədə informasiya 
mübadiləsinin necə aparılacağını  
müəyyənləşdirən qaydalar ardıcıllığıdır. 
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informasiya ehtiyatlarının axtarılmasını və qorunmasını asan-
laşdırır.  

Şəbəkədə kompüter və periferya avadanlıqları arasında 
informasiya əlaqəsi əsasən  kabel vasitəsilə həyata keçirilir. 
Şəbəkədə istifadə olunan kabelləri üç böyük qrupa bölmək olar:  

1. Koaksial (coaxial); 
2. İki cütlük (twisted pair); 
3. Optik lifli. 

Koaksial kabellərdə siqnal polivinilxlorid və ya teflon 
izolyasiyalı mis naqil boyu ötürülür. Siqnalın zəifləməsinə 
səbəb olan elektromaqnit dalğaların təsirini aradan qaldırmaq 
üçün ötürücü mis naqil torşəkilli qoruyucu ilə əhatə 
olunmuşdur. İki tip koaksial kabellər istehsal edilir (şək. 1).  

1. Nazik; 
2. Qalın. 

     

Şək. 1. 

Nazik koaksial kabellər 0,5 sm qalınlığa malik olub 
siqnalı 185 m məsafəyə sönmədən, maneəsiz ötürməyə 
qadirdir, elastik olduğu üçün montaj üçün rahatdır və praktiki 
olaraq bütün növ şəbəkələr üçün yararlıdır. BNC, BNC T 
konnektorları vasitəsilə şəbəkə kartına qoşulur (şək. 2).  

  
Şək. 2. 

BNC T 



 

 

23

 Qalın koaksial kabellər 1 sm diametrə malikdirlər və 
siqnalı daha uzaq məsafəyə - 500 m məsafəyə ötürə bilir. 
Ondan əsasən nazik koaksial kabellər əsasında yaradılmış bir 
neçə kiçik şəbəkələri birləşdirən əsas kabel - magistral kabel 
kimi istifadə olunur. Magistral kabelə qoşulmaq üçün xüsusi 
transiverdən istifadə olunur. Transiver iti «dişlərə» malik 
konnektorla təchiz olunmuşdur ki, məhz bu dişlər kabelin 
izolyasiyasına daxil olaraq ötürücü naqillə birbaşa əlaqəyə girir. 
Transiver şəbəkə kartının AUI  portuna transiver kabeli 
vasitəsilə qoşulur (şək. 3). 

 

Şək. 3. 

İki cütlük izolyasiyalı və bir-birinə dolaşmış  mis naqillər 
cütündən ibarətdir. İki tip: ekranlaşmış (SSTP) və ekransız 
(UTP) kabellər istehsal olunur  (şək. 4).  

 
Şək. 4. 

КоннекторКабел

Трансивер 
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Ekran qoruyucu rolu oynayır və siqnalı nisbətən uzaq məsafəyə 
ötürməyə zəmin yaradır. Kabel şəbəkə kartına, konsetratora  RJ 
- 45 tipli konnektorlar (şək. 5) vasitəsilə qoşulur. 

 

Şək. 5. 

Optik lifli kabellərdə informasiya optik lif boyunca 
modullaşmış işıq impulsu şəklində yayılır. Bu kabellər böyük 
həcmli informasiyanı çox böyük sürətlə və etibarlı surətdə ötürə 
bilir. Optik lif - nazik şüşə silindrdən ibarət olub, qoruyucu şüşə 
örtüklə əhatə olunmuşdur. Hər bir optik lif informasiyanı yalnız 
bir istiqamətdə ötürməyə qadirdir. Ona görə optik-lifli kabellər 
xüsusi konnektorlarla təchiz olunmuş iki optik lifdən ibarət 
olur. Kabel informasiyanı 100 Mbit/s sürətlə ötürür.  

Şəbəkə kartı kompüter və şəbəkə kabeli arasında interfeys 
rolu oynayır və aşağıdakı funksiyaları yerinə yetirir: 

1. İnformasiyanın ötürülməsinə hazırlıq; 
2. İnformasiyanın ötürülməsi; 
3. İnformasiya axınının idarə olunması. 
Məlumdur ki, informasiya kompüterdə ikilik say 

sistemində kodlaşmış - bitləşmiş formada saxlanılır və şin 
vasitəsilə paralel olaraq kompüterin daxili qurğularına, 
məsələn: mikroprosessora, operativ yaddaşa və s. ötürülür. 
Kabel informasiyanı yalnız ardıcıl ötürmə qabiliyyətinə malik 
olduğundan informasiyanın ötürülməsinə hazırlıq mərhələsində 
kart ilk növbədə ötürüləcək informasiyanı paralel formadan 
ardıcıl formaya çevirir. Sonrakı mərhələdə kart informasiya 
qəbul edəcək kompüterin şəbəkə kartı ilə "əlaqə" yaradaraq ona 
aşağıdakı məlumatları çatdırır: 

• Ötürüləcək informasiya bloklarının maksimal ölçüsünü; 
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• İnformasiyanın həcmini; 
• İnformasiya bloklarının ötürmə intervalını; 
• Təsdiqedici intervalı; 
• Ötürmə sürətini. 

Bundan sonra informasiya elektrik və ya optik siqnalına çevrilir 
və informasiya kabeli vasitəsilə şəbəkənin digər kompüterinə 
ötürülür. 

Hər bir şəbəkə kartı unikal ünvana və parametrlərə malik 
olur. Şəbəkədə hər bir kart bu haqda qarşılıqlı məlumata malik 
olur və öz parametrlərini digər şəbəkə kartının parametrinə 
müvafiq uyğunlaşdırma qabiliyyətinə malikdirlər. Məsələn, 
şəbəkədə yüksək sürətli kart informasiya mübadilə sürətini 
digər kartın sürətinə uyğunlaşdırır. 

İnformasiya mübadiləsində şəbəkə kartı mühüm rol 
oynadığından şəbəkənin fəaliyyəti, sürəti şəbəkə kartının 
seçilməsindən, düzgün quraşdırılmasından və ona uyğun 
proqram modullarından (məsələn, drayverindən) çox asılıdır. 
Kart ilk növbədə kompüterin arxitekturasına və ona qoşulacaq 
kabelə uyğun olmalıdır. Qeyd edək ki, «simsiz»  lokal 
şəbəkələrdə xüsusi növ şəbəkə kartından istifadə olunur. Bu 
şəbəkə kartları siqnal ötürücü və qəbuledici antenaya malik 
olurlar. 

Kommunikasiya avadanlığı olaraq əsasən konsen-
tratorlardan istifadə olunur. Konsentratorlar passiv və aktiv  
olur.  Aktiv konsentrator-xab (Hub) qurğusu siqnalı  qəbul edib 
gücləndirir (şək. 6).  

 

Şək. 6. 

Xabların əsas texniki xarakteristikaları portların sayı, siqnalı 
ötürmə sürəti və  kommutatsiya alqorimidir. Xablardan əsasən 
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ulduz topologiyalı şəbəkələrə yeni işçi stansiyaları qoşmaq,  
işçi stansiyalar və server arasında məsafə böyük olduqda kabel 
seqmentlərini «birləşdirmək» üçün istifadə olunur1. Xablardan 
əlavə daha yüksək texniki parametrli qurğulardan-
kommutatorlardan (switch) istifadə etmək olar. Kammutatorlar 
«intellektual» xablar olub, informasiyanı ən optimal marşrutla 
öturur.   

Passiv konsentratorlar (məsələn montaj panelləri, 
kommutatsiya blokları və s.)  yalnız siqnalı qəbul edib ötürmək 
funksiyasını yerinə yetirirlər və onları aktiv konsentratorlardan 
fərqli olaraq qidalanma mənbəyinə qoşmağa ehtiyac yoxdur. 

Şəbəkənin yaradılması zamanı ən mühüm şərt düzgün 
şəbəkə arxitekturasının seçilməsidir. Bu seçim kompüterləşmə 
layihəsinin təyinatından asılıdır. Kitabxanalarda bu gün geniş 
tətbiq olunan 100 BaseX Ethernet (Fast Ethernet), 100 
BaseVG-AnyLAN Ethernet, Gigabit Ethernet arxitekturalı 
şəbəkələrdən istifadə etmək olar. 100 BaseX Ethernet (Fast 
Ethernet), 100 Base VG-AnyLAN Ethernet şəbəkələri 
informasiya mübadiləsini 100 Mbit/s., Gigabit Ethernet 

                                                           
1 Topologiya termini ilə şəbəkənin 
strukturu - kompüter, server, periferiya 
qurğuları və digər şəbəkə komponentlərinin 
yerləşmə sxemi ifadə olunur. Ulduz 
topologiyalı şəbəkələrdə bütün kompüterlər 
kabel seqmentləri vasitəsilə mərkəzi 
konsentratora  qoşulur.  Bu  kabel  
sərfini  artırır və mərkəzi konsentrator 
sıradan çıxdıqda şəbəkə öz fəaliyyətini 
dayandırır.  Kompüterlərdən biri və ya 
kabel seqmenti sıradan çıxarsa, yalnız  
həmin kompüter informasiya mübadiləsi 
etməyəcək.  
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şəbəkəsi isə 1000 Mbit/s sürətlə təmin edir. Şəbəkə «ulduz» 
topologiyasına əsaslanır.  

Bunlardan başqa kitabxananın kompüterləşməsində 
aşağıdakı qurğulardan da istifadə olunur: 

Skanerlər; 
Printerlər; 
Modemlər; 

      Fasiləsiz qidalandırma qurğuları (UPS); 
Maqnit və lent informasiya toplayıcıları; 
Video müşahidə avadanlıqları və s.  

Kitabxanada əsasən planşet və əl skanerlərindən istifadə olunur 
(şək. 7). Planşet tipli skanerlər kitabxanada kağız üzərindəki 
maddiləşmiş informasiyanı elektron formaya çevirmək üçün və 
əl skanerləri kitabxanada ştrix-kod texnologiyası tətbiq 
olunduqda ştrix-kodun oxunması üçün istifadə edilir. 
Kitabxanada adətən A4, A3 formatlı  planşet skanerlərdən 
istifadə olunur. Onları xarakterizə edən əsas keyfiyyət, 
səhifənin obrazını hansı dəqiqliklə yaratmasıdır.  Əl skanerlər 
isə əsasən, informasiyanı hansı uzaqlıqdan oxumaq qabiliyyəti 
ilə xarakterizə olunur. 

  

Şək. 7. 

Printer çap qurğusudur. Kitabxanalarda şırnaqlı və lazer 
printerlərdən istifadə olunur (şək. 8). 
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Şək. 8. 

Printeri xarakterizə edən əsas göstəricilər aşağıdakılardır: 
Çapın rəngli və ya ağ-qara olması; 
Çapın keyfiyyəti; 
Sürəti; 
Şəbəkədə fəaliyyət göstərməsi; 
Səhifələrin formatı; 
İqtisadi cəhətdən səmərəli olması. 
Qeyd edək ki, şırnaqlı printerlər lazer printerlərdən 

çapın keyfiyyətinə, sürətinə görə geri qalır və istismar zamanı  
iqtisadi cəhətdən səmərəli deyil. 

 Modemlər əsasən telefon rabitəsilə uzaq məsafədən 
qoşulmanı təmin edir. Kitabxanalarda modemlərdən İnternetə 
qoşulmaq üçün, uzaq məsafədə yerləşən kompüterlə əlaqə 
yaratmaq üçün, kompüterlər vasitəsilə faksmil sənədlərin 
mübadiləsi  üçün   istifadə edilir. İnternetə adi telefon xətilə 
qoşulmaq üçün daxili1 və xarici modemlərdən (şək. 8), 
«ayrılmış xətlə» qoşulma üçün «ayrılmış» şəbəkə 
modemlərindən (şək. 9) istifadə olunur. 

                                                           
1 Daxili modemlər kompüterin «ana platasına» qoşulur.  
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      Şək. 8.             

 
Şək. 9.  

İnformasiyanın daxil olması və ya işlənməsi zamanı 
elektrik təminatında baş verən nasazlıqlar informasiyanın xarab 
olmasına, itməsinə, kompüterlərin sıradan çıxmasına səbəb ola 
bilər. Bunun üçün kitabxanalar mütləq fasiləsiz qidalandırma 
qurğularına malik olmalıdır. Bu qurğular elektrik cərəyanının 
verilməsi dayandıqda belə, müəyyən vaxt müddətində  
kompüter avadanlıqlarını elektrik enerjisi ilə təchiz edir. Onlar 
həmçinin elektrik xəttində baş verən «gərginlik sıçrayışlarını» 
stabilləşdirir, elektromaqnit dalğalarını «söndürür».   

Müasir dövrdə kitabxanaların mühafizəsi, böyük sahəyə 
malik oxu zallarında kitabdan istifadəyə nəzarət etmək üçün 
elektron video müşahidə sistemlərindən istifadə olunur (şək. 
10). Mühafizə məqsədilə istifadə olunan sistemlər sutka ərzində 
kitabxanada baş verən bütün hadisələri «izləyir», onların 
arxivini yaradır və təhlükəsizlik baxımından «şübhəli» hesab 
etdiyi video məlumatı telekommunikasiya vasitələri ilə 
mühafizə qurumuna çatdırır. 
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Şək. 10. 

Böyük elektron sənəd informasiyasına malik kitab-
xanalarda etibarlı informasiya arxivini yaratmaq üçün   lent və 
disk informasiya toplayıcılarından istifadə olunur. Bu qurğular 
insan iştirakı olmadan informasiyanın ehtiyat arxivini yaradır.  

Kitabxanaların kompüterləşdirilməsi üçün istifadə 
olunan proqram təminatını 3 qrupda təsnifləşdirmək olar: 

1. Sistem proqram təminatı; 
2. Tətbiqi proqram təminatı; 
3. Proqramlaşdırma  vasitələri. 

Sistem proqram təminatı kompüterin ayrı-ayrı 
qurğularının, proqramların birgə işini, şəbəkənin fəaliyyətini 
təmin edir. Bu qrupa bütün əməliyyat sistemləri, kompüterlərin 
qurğularının və kompüterə qoşulan avadanlıqların drayverləri, 
xidməti proqramlar aiddir. Əməliyyat sistemi hər bir 
kompüterin baza proqram kompleksidir. Onsuz kompüterin 
fəaliyyəti qeyri-mümkündür. Əməliyyat sistemi kompüterin 
əsas funksiyalarını - informasiyanın saxlanılması, işlənilməsi 
və mübadiləsini, kompüter şəbəkəsinin idarə olunmasını həyata 
keçirir. Onlar həmçinin proqram əlavələrinin icrasını idarə edir. 
Əməliyyat sistemləri aşağıdakı xüsusiyyətlərə malikdir: 

1. Paralellik və çoxməsələlik - bir neçə əlavə ilə eyni 
zamanda iş rejimi; 

2. Köçürülə bilən olması; 
3. Etibarlılıq; 
4. Texnoloji bütövlük; 
5. Rahat və sadə interfeys; 
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6. Çox istifadəçi rejimində fəaliyyət. 
 İstifadə  sahəsinə görə əməliyyat sistemləri şəbəkə və 

avtonom sistemlərə bölünür. Şəbəkə sistemləri  olaraq bu gün 
Windows NT,  Windows Server 2003, Unix və s. istifadə 
olunur. Şəbəkə sistemləri avtonom sistemlərdən fərqli olaraq 
həmçinin, şəbəkənin idarə olunmasını,  təhlükəsizliyini, 
informasiyanın paylanmış emalını təmin edir. 

Xidməti proqramlara diaqnostika, təhlükəsizlik 
proqramları aiddir. Onlar vasitəsilə kompüter sisteminin etibarlı 
fəaliyyəti təmin olunur. 

Kitabxanalarda əsasən aşağıdakı növ tətbiqi proqram 
təminatından istifadə olunur: 

a) Office proqramları. Office proqramları kitabxana 
fəaliyyətində istifadə olunan kargüzarlıq işləri üçün iş vaxtının 
planlaşdırılmasında istifadə olunur. Office proqramlarına mətn 
redaktorları, cədvəl redaktorları, tərcümə proqramları, 
obrazların  tanınması proqramları aiddir. Bundan əlavə qrafikə 
baxış, prezentasiya proqramları və s. istifadə olunur. 

b) Telekommunikasiya proqramları. Bu proqramlar 
əsasən İnternet xidmətlərindən istifadə etmək üçün klient 
proqramları, faksmil və uzaq məsafədən qoşulan proqramlara 
aiddir. Bu proqramlar rahat ünsiyyət və informasiya mübadiləsi 
vasitələridir. Məsələn, kitabın ikinci fəslində verilmiş Venta 
Fax, Windows Commander proqramları, proksi-server, Web və 
FTP server proqramları, brauzerlər bu tip proqramlardır. 
Proksi-server proqramları lokal şəbəkənin kompüterlərinin bir 
xarici İP ünvanla İnternet şəbəkəsinə qoşulmasını təmin edir. 
Onlar vasitəsilə həmçinin şəbəkənin trafikinə nəzarət təmin 
olunur. Web və FTP server proqramları Web və FTP serverin 
fəaliyyətini təmin edir. Onların vasitəsilə on-line informasiya 
xidməti həyata keçirilir. Windows əməliyyat sistemi ilə işləyən 
şəbəkələrdə adətən Web və FTP server proqramı olaraq İnernet 
İnformation Server proqramından istifadə olunur. 
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c) Avtomatlaşlmış Kitabxana-İnformasiya Sistemləri. 
Kitabxananın kompleks avtomatlaşdırılması üçün yaradılmış 
tətbiqi proqram paketlərini Avtomatlaşmış Kitabxana-
İnformasiya Sistemləri adlandırmaq qəbul edilmişdir. 
Avtomatlaşmış Kitabxana-İnformasiya Sisteminin seçilməsində 
aşağıdakı tələbləri prioritet kimi qəbul etmək lazımdır: 
  1. «Açıq» tipli olmalıdır.. Sistem beynəlxalq maşınla 
oxunan biblioqrafik, texniki-sistem standartlarına (USMARC, 
UNIMARC, ISO və s.) uyğun olmalıdır. Əks təqdirdə, sistemin 
ümumi şəbəkədə istifadəsi, uzaq məsafədən istifadə, digər 
sistemlərlə informasiya mübadiləsi qeyri-mümkün olacaq. 
  2.İnternet texnologiyasına inteqrasiya imkanının olma-
lıdır. Bu Web texnologiyanın tətbiqi ilə paylanmış informasiya 
bazalarından istifadəni, oxucu sorğusunun uzaq məsafədən 
operativ ödənilməsini, kitabxananın biblioqrafik və informasiya 
ehtiyatlarının ölkə və dünya informasiya məkanına 
inteqrasiyasının təmin edilməsini nəzərdə tutur. 
  3. «Genişlənə» bilən olmalıdır. Sistem qeyri-məhdud 
sayda məlumat bazaları ilə işləmək, qeyri-məhdud həcmli 
informasiyanı operativ idarə etmək və qeyri-məhdud sayda 
istifadəçiyə xidmət göstərmək xüsusiyyətinə malik olmalıdır.  

4. Adaptasiya və modernizasiya oluna bilən olmalıdır. 
Ümumi kitabxana proseslərindən əlavə, lokal xarakterli və 
əvvəllər nəzərdə tutulmayan funksiyaların yerinə yetirilməsi 
üçün modernizasiya oluna bilməlidir. 
  5. İnformasiyanın bütövlüyünü təmin etməli, qəzalara və 
viruslara qarşı davamlı olmalı, yüksək informasiya 
təhlükəsizliyi tədbirlərinə malik olmalıdır. 
  6. İnformasiyanın bütün növləri ilə işləmək imkanı 
olmalıdır.  Müasir kitabxana ənənəvi yazı materialları ilə 
yanaşı, digər video, audio materiallar, ən çox da elektron 
sənədlərlə işlədiyindən sistem OLE1 texnologiyasını 
dəstəkləməlidir. 
                                                           
1 OLE texnologiyası digər proqramlardan obyektlərin idxalını təmin edir. 
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7. Z 39.50  protokolu  əsasında işləyə  bilməlidir. 
Protokol gələcəkdə korporativ kitabxana-informasiya şəbə-
kələrində biblioqrafik informasiya  mübadiləsini təmin et-
məlidir. 

8. UNICODE  şriftlərinin dəstəkləməlidir. 
9. Sadə işçi interfeysi olmalıdır. 

10. Kitabxananın əsas  texnoloji proseslərinin kom-
püterləşdirilməsini təmin edən müvafiq Avtomatlaşmış İşçi 
Yerləri olmalıdır. 

11. Avtoritet faylların, predmet göstəricilərinin yara-
dılmasını və ondan istifadəni təmin edə bilməlidir. Bununla 
relevant  informasiya axtarışını təmin etmək olar. 
 Qeyd edək ki, keçmiş sovet kitabxana işi ABŞ və Qərbi 
Avropa kitabxana  işindən xeyli fərqlənir. Qərb ölkələrində 
hazırlanmış Avtomatlaşmış Kitabxana-İnformasiya Sistemləri 
çox baha olub, onların Azərbaycanda, o cümlədən MDB 
ölkələrində,  kitabxana işində mövcud fərqlərə görə tətbiqi, 
uyğunlaşdırılması böyük xərc və zəhmət tələb edir. Digər 
tərəfdən onların istismarı yüksək texniki göstəricili 
avadanlıqların və hazırlıqlı kadrların olmasını  tələb edir. MDB 
ölkələrində hazırlanmış proqramlar isə Qərb standartlarından 
bir qədər geri  qalsalar da, onların istismarı on dəfələrlə  ucuz 
başa gəlirlər.  Bu səbəbdən keçid dövründə  kitabxanalarımız 
MDB ölkələrində hazırlanmış proqram təminatından istifadə 
etməyə üstünlük verirlər. Oxucuda bu sistemlər haqqında 
təsəvvür yaratmaq üçün  cari paraqrafda bu gün MDB məka-
nında geniş istifadə olunan bir neçə  Avtomatlaşmış Kitabxana-
İnformasiya Sistemlərinin qısa xarakteristikaları verilmişdir. 

 Marc-Sql - 1.8 Avtomatlaşmış Kitabxana İnformasiya  
Sistemi  «Inform-Systema» (Rusiya Federasiyası)  firmasınının 
məhsulu olub, kitabxanaların kompleks avtomatlaşmasını təmin 
edir. Sistem kitabxananın elektron kataloqunun yaradılmasını, 
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kitabxana fondunun komplektləşdirilməsini və uçotunu, 
abonement, biblioqrafik-məlumat xidmətini kompüterləşdirir.  
 Marc-Sql – 1.8 müxtəlif məlumatlar bazasını idarəetmə 
sistemləri - MS Sql  Server, Oracle, MS Access, VfoxPro, 
Paradox  və s. ilə işləyə bilir və 5 ədəd Avtomatlaşmış İşçi 
Yerindən ibarətdir. Hər bir Avtomatlaşmış İşçi Yeri sistemin 
AİY(ARMı) menyusunun eyniadlı əmrini yerinə yetirməklə 
yüklənir.  Bundan əlavə, sistem Internet/Intranet şəbəkəsi 
vasitəsilə oxucuların uzaq məsafədən, on-line  ədəbiyyat 
axtarışını aparmasını və sifarişini təmin etmək üçün xüsusi 
Web moduluna malikdir. 

BİBLİOTEKA 5.0 Moskva Dövlət Universitetinin Elmi 
kitabxanasında tətbiq olunan və aşağıdakı imkanlara malik 
Avtomatlaşmış Kitabxana-İnformasiya Sistemidir: 
♦ Kitab, məqalə və ənənəvi olmayan sənədlərin (audio-video 

materiallar, kompüter faylları) elektron kataloqunun 
yaradılması; 

♦ İxtiyari biblioqrafik təsvir sahəsinə görə axtarışın təmin 
olunması; 

♦ Sistemin məlumatlar bazasını təşkil edən biblioqrafik 
yazıların USMARC və RUSMARC beynəlxalq 
formatlarına tam uyğun olması; 

♦ INTERNET beynəlxalq kompüter-informasiya şəbəkəsi 
vasitəsilə kitabxananın elektron kataloqundan uzaq 
məsafədə yerləşən oxucuların istifadəsinin təmin olunması; 

♦ Sadə işçi interfeysinin olması; 
♦ Word və Excel1 sənədləri şəklində çap sənədlərin ha-

zırlanması; 
OPAC-GLOBAL Avtomatlaşmış Kitabxana-İnformasiya 

Sistemi DİT-M (Rusiya Federasiyası)  kompaniyası tərəfindən 
yaradılmışdır. OPAC-GLOBAL Web-texnologiya əsasında 

                                                           
1 Word və Excel Microsoft firmasının proqramları olub, müvafiq olaraq 
mətn və  elektron cədvəl redaktorlarıdır. 
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hazırlanmışdır. Sistemin əsas funksiyaları Web klient əlavəsilə, 
standart brauzerlər1 vasitəsilə həyata keçirilir.  Sistem: 
- RUSMARC, UNİMARC, USMARC formatlarında 

kataloqlaşdırmanı; 
- On-Line ədəbiyyat axtarışını və sifarişini; 
- Kataloqlaşdırma və axtarış zamanı avtoritet fayllardan 

istifadəni; 
- Ədəbiyyatın uçotunun aparılmasının və hərəkətinin 

izlənməsini; 
- Biblioqrafik yazıya ədəbiyyatın elektron variantının 

ünvanının əlavə edilməsini və mətnə görə axtarışını; 
- Avtoritet və biblioqrafik yazıların idxalını və ixracını; 
- Oxucuların və uzaq məsafədən istifadəçilərin sifarişlərinin 

statistik uçotunun aparılmasını; 
- Müxtəlif maliyyə hesabatlarının hazırlanmasını və s. təmin 

edir. 
Sistem istifadəçinin tələbatına uyğun, asanlıqla adaptasiya 
oluna bilər. Bu isə sistemin nəinki MARC formatı ilə, digər 
daxili formatlarla, məsələn, QOST-la işləməsinə imkan verir. 
 OPAC-GLOBAL sadə və qrafiki işçi interfeysinə 
malikdir. Bundan əlavə sistemdə kataloqlaşdırmanı 
sürətləndirmək  və asanlaşdırmaq üçün aşağıdakı vasitələr 
nəzərdə tutulmuşdur: 

1. Digər kitabxanaların elektron kataloqlarından, 
nəşriyyatlardan biblioqrafik yazıların əldə olunması; 

2. Oxşar yazıların qrup şəklində redaktəsi; 
3. Korporativ  kataloqlaşdırma (birgə paylanmış);  
4. Siyahılardan sahələrə informasiyanın daxil edilməsi; 
5. Korlanmış informasiyaların soraq fayllarından istifadə 

etməklə bərpası; 
 Sistemdə informasiya axtarışı standart Web-brauzer 
vasitəsilə istifadəçinin hazırlıq dərəcəsindən asılı olaraq: baza, 
genişlənmiş və professional formada həyata keçirilir.  Axtarışın 
                                                           
1 Məs: Internet Explorer 

 

 

36

nəticəsi nizamlana bilər və istifadəçi arzusuna uyğun olaraq 
MARC formatında və ya kataloq  kartı formasında, hissə-hissə 
ekranda əks oluna bilər. Yeni axtarış zamanı əvvəlki axtarışın 
nəticələrindən də istifadə oluna bilər. Bu mürəkkəb axtarış 
üçün çox əlverişlidir. İstifadəçi həmçinin kitabxanada axtardığı  
ədəbiyyatın hal-hazırda «sərbəst» nüsxəsinin olmasını öyrə-
nərək  ədəbiyyatın  surətini və ya elektron variantını sifariş verə 
bilər. Sistem istifadəçilərə sərbəst surətdə öz elektron nəşrlərini 
«elektron kitabxana» bazasına əlavə etməyi və mətnə görə 
axtarışı təmin edir.   
 OPAC-GLOBAL Avtomatlaşmış Kitabxana İn-
formasiya İdarəetmə Sistemində oxucuların qeydiyyatı və 
istifadə hüquqları ədəbiyyatın tipinə və istifadə etdikləri 
kompüterlərin IP ünvanlarına görə, sistem administratoru 
siyasəti vasitəsilə həyata keçirilir. Həmçinin bu siyasət 
vasitəsilə informasiya bazalarının yenidən indeksləşməsi, 
arxivləşməsi, informasiyanın bərpası həyata keçirilir. Sistem 
lokal və həmçinin korporativ kitabxana-informasiya 
şəbəkələrində tətbiq edilə bilər. 

İRBİS Avtomatlaşmış Kitabxana İnformasiya İdarəetmə 
Sistemi elmi-texniki kitabxanaların kompüterləşdirilməsi üçün 
yaradılmış və  MDB məkanında, o cümlədən Azərbaycanda  ən 
geniş istifadə olunan sistemdir. Sistemin son «İRBİS 64 
Unicode» versiyası Avtomatlaşmış Kitabxana İnformasiya 
İdarəetmə Sistemləri üçün yuxarıda sadalanan bütün tələblərə 
cavab verir. Proqram klient-server arxitekturası əsasında işəlyir. 
Proqramın klient proqramları - Avtomatlaşmış İşçi Yerləri 
yalnız server proqramı cari anda yüklənmiş olduqda yüklənir. 
Qeyd edək ki, server proqramının yarlığı  «TCP-IP server 
İRBİS 64 unicode» proqram qrupunda, klient proqramlarının 
yarlıqları isə «Sistema İRBİS 64 unicode» proqram qrupunda 
yerləşir. Onlar, kursoru müvafiq proqram yarlığının üzərinə 
qoyub siçanın sol düyməsini sıxmaqla yüklənir. Avtomatlaşmış 
İşçi Yerlərini yükləyərkən açılan dialoq pəncərəsində 
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istifadəçinin identifikasiya parametrini  və parolu daxil etmək 
lazımdır. Bu proqramın özəlliklərindən biri hər bir texnologi 
əməliyyatın kim tərəfindən aparılmasının qeydiyyatıdır. Bu 
xüsusiyyət işçilərdə məsuliyyət hissini artırır və baş vermiş 
səhvin «səbəbkarını» müəyyən etməyə imkan verir. Qeyd edək 
ki, proqram vasitəsilə kitabxanada əsas texnoloji proseslərin 
kompüterləşdirilməsi sonrakı paraqraflarda geniş şərh 
olunmuşdur. 
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§1.4. Korporativ kitabxana-informasiya şəbəkələri 
 

Keçən əsrin 90-ci illərindən başlayaraq, yüksək 
texniki göstəricilərə malik kompüterlərin, böyük həcmli 
və sürətli informasiyanı ötürmə qabiliyyətli 
telekommunikasiya avadanlıqlarının istehsalı, kitabxana-
informasiya texnolo-giyalarının inkişafı sayəsində 
Korporativ Kitabxana-İnformasiya Şəbəkələrinin 
yaradılmasına başlanıldı. Korporativ Kitabxana-
İnformasiya Şəbəkəsi kataloqlaşdırma və elektron kataloq 
yaradılması işində paylanmış  və birgə kataloqlaşdırma 
tətbiq etməklə ədəbiyyatın çoxqat təkrar ka-
taloqlaşdırılmasının qarşısını alır, əmək sərfini minimuma 
endirir,  kataloqlaşdırma əməyindən, maliyyə  
vəsaitlərindən səmərəli istifadəni təmin edir. Belə ki, 
biblioqrafik yazı bir dəfə, ədəbiyyatın biblioqrafik 
yazısını ilk dəfə yaradan kitabxana, nəşriyyat və kitab-
ticarəti müəssisələri (məsələn, Kitab palatası və s.) 
tərəfindən hazırlanır. Digər kitabxanalar hazır yazıları 
idxal edir və tələb olduqda yeni əlavələr etməklə öz 
elektron kataloquna əlavə edir. Başqa sözlə hər bir 
kitabxananın və şəbəkənin yekun elektron kataloqu 
kitabxanaların qarşılıqlı yardımı əsasında yaradılır.  Bu  
isə hər bir kitabxana üçün iqtisadi çəhətdən çox 
sərfəlidir. Məsələn, OCLC Kitabxana Kompüter-
İnformasiya Şəbəkəsinin elektron kataloqu 63 ölkənin 20 
mindən artıq kitabxanası tərəfindən yaradılıb və 
eramızdan əvvəl IX əsrdən başlayaraq bəşər 
sivilizasiyasının yaratdığı 35 milyon ədəbiyyat haqqında 
biblioqrafik informasiya daşıyır. Korporativ kitabxana-
informasiya şəbəkəsi istifadəçilərə on-line olaraq, 
şəbəkənin ehtiyatlarından və şəbəkənin digər kitabxana 
informasiya mərkəzləri ilə əlaqəsi olduqda isə digər 
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kitabxana informasiya sistemlərinin informasiya eh-
tiyatlarından istifadəni təmin edir. Bu halda oxucunun 
informasiya tələbatının ödənilməsi ehtimalı  kəskin 
surətdə artır. Digər tərəfdən xarici ölkələrin kitabxana 
informasiya mərkəzlərinin elektron kataloqlarından istifadə 
dünyada elmi nəzəriyyələri, elmi yenilikləri izləməyə 
imkan verir, tədris və elmi axtarışlar üçün çox 
əhəmiyyətlidir. Bu səbəblərdən Korporativ Kitabxana-
İnformasiya Şəbəkəsi informasiyalaşmış cəmiyyətin 
yaradılmasında əvəzsiz vasitədir.  

Korporativ Kitabxana-İnformasiya Şəbəkəsi avto-
matlaşmış kitabxanaların könüllü konsorsiumu əsasında 
yaradılır.  Hər bir iştirakçı konsorsiuma daxil olarkən 
öz üzərinə aşağıdakı öhdəlikləri götürür: 

 Konsorsiumda uzun müddətli iştirakı; 
 Öz biblioqrafik,  sənəd və məlumat  ehtiyatlarının 

elektron formada hazırlanmasını və birgə istifadə 
üçün istifadəyə verilməsini;  

 Korporativ şəbəkənin iştirakçılarının ümümi işini 
təmin etmək üçün istifadə olunan texniki-proqram 
təminatının tərkibi və xarakteristikaları üçün 
tələblərə əməl olunmasını; 

 Korporativ şəbəkənin yaradılması, fəaliyyət 
göstərməsi və gələcək inkişafı üçün  texniki 
təminatın, maliyyə vəsaitlərinin ayrılmasını;  

 Korporativ şəbəkədə ümümi istifadə üçün təqdim ol-
unmuş informasiyanın keyfiyyətinə məsuliyyəti;  

 Şəbəkəyə yeni istifadəçiləri cəlb etmək üçün 
şəbəkənin ehtiyatlarının, xidmətlərinin reklamının 
təşkil edilməsini və s. 
Şəbəkənin işinə direktorluq nəzarət edir. Direktor-

luğun üzvləri 15-20 nəfərdən çox olmayıb, sədrdən, 
onun iki müavini - koordinatorlardan və üzvlərdən 
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ibarətdir. Direktorluq iştirakçı kitabxanaların rəhbərləri ilə 
razılaşdırılmaqla kitabxanaların avtomatlaşdırılması 
sahəsində hazırlıqlı kitabxanaçı və kompüter-informasiya 
texnologiyası sahəsində mütəxəssislərdən təşkil olunur. 
Əksər ölkələrdə  direktorluğa  iştirakçı kitabxanaların 
direktor müavinləri və kompüter-informasiya mərkəzlərinin 
müdirləri daxildir. Direktorluq kitabxananın inzibati-
təsərrüfat işlərinə müdaxilə edə bilməz və yalnız 
aşağıdakı  funksiyaları yerinə yetirə bilər: 

 Şəbəkənin fəaliyyət strategiyasının və inkişaf 
planının hazırlanması; 

 Bütövlükdə şəbəkədə və onun ayrı-ayrı qovşaqla-
rında işlərin təşkili və nəzarət; 

 Şəbəkənin fəaliyyəti üçün material-maliyyə 
vəsaitlərinin əldə olunması  və iştirakçılar arasında 
paylanması; 

 Görülən işlərin keyfiyyətinə və həcminə nəzarət; 
 Oxuculara xidmət reqlamentinə, texnoloji-maliyyə 

intizamına nəzarət; 
 Yeni üzvlərin qəbulu və s.  

Kitabxanaların inkişafının əsas istiqamətlərinə aid bir 
sıra metodik, təşkilati məsələlərin işlənməsi üçün direk-
torluq metodik qruplar da yarada bilər.  

Korporativ Kitabxana-İnformasiya Şəbəkəsi «pay-
lanmış» şəkildə, ərazi cəhətdən uzaq məsafədə yerləşən 
ayrı-ayrı kitabxana kompüter-informasiya şəbəkələrinin 
şəbəkəsidir.  Şəbəkələr arasında əlaqə müvafiq texniki-
proqram vasitələri, rabitə xətləri, İnternet vasitəsilə, 
telekommunikasiya kanalları ilə təmin edilir. Korporativ 
şəbəkənin   strukturu, topologiyası və proqram-aparat 
təminatı şəbəkənin  qarşıya qoyduğu məsələlərin 
mürəkkəbliyi, iştirakçıların çoğrafi yerləşmələri ilə 
müəyyən olunur. Böyuk şəbəkələrin strukturunda, onların 
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idarə olunmasını təmin edən Baza informasiya 
mərkəzinin-provayderin və Ərazi şəbəkə mərkəzlərinin 
olması zəruridir. Belə ki: 

 Baza informasiya mərkəzi-provayder şəbəkənin 
bütövlükdə texniki-informasiya, administrasiya xid-
mətinin yerinə yetirilməsini və şəbəkənin 
fəaliyyətinə nəzarəti təmin edir. 

 Ərazi şəbəkə mərkəzi müəyyən ərazidə fəaliyyət 
göstərən informasiya şəbəkələrinə xidməti və onların  
korporativ şəbəkədə birgə fəaliyyətini təmin edir. 
  Şəbəkə daxilində və digər sistemlərlə qarşılıqlı 

informasiya əlaqəsi З39.50, HTTP, FTP protokolları 
vasitəsilə həyata keçirilir. Qeyd olunan protokollardan 
istifadə şəbəkə daxilində informasiya şəffaflığını və 
müxtəlif aparat-proqram təminatına malik, müxtəlif 
uzaqlıqda yerləşən kitabxana-informasiya sistemləri 
arasında yüksək effektli informasiya mübadiləsini təmin 
edir.  

Korporativ Kitabxana-İnformasiya Şəbəkəsinin in-
formasiya təminatı əsasən, şəbəkənin iştirakçısı olan ki-
tabxanaların lokal kitabxana informasiya mərkəzlərində, 
qismən isə baza informasiya mərkəzində və ərazi  
şəbəkə mərkəzlərində korporativ şəkildə hazırlanır. Lokal 
kitabxana informasiya mərkəzləri həmçinin kitabxana 
filiallarının da informasiya ehtiyatlarının yarıdılmasını 
təmin edir və öz oxucularına kompüter sinifləri vasitəsilə 
İntrenet və İntranet şəbəkəsinin elektron xidmətlərini 
təşkil edir.   

Korporativ Kitabxana-İnformasiya Şəbəkəsinin  
proqram təminatı ilk növbədə, şəbəkənin məhsuldarlığını,  
etibarlı fəaliyyətini, kompüter, periferiya, 
telekommunikasiya qurğularının şəbəkədə işləməsini təmin 
etməli, beynəlxalq şəbəkə standartlarına cavab verməli,  
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şəbəkənin digər informasiya sistemlərinə inteqrasiyasını 
təmin etməlidir. Şəbəkədə texnoloji proseslərin yerinə 
yetirilməsi isə Korporativ  Kitabxana İnformasiya 
Sistemləri vasitəsi ilə yerinə yetirilir. Korporativ Kitabx-
ana-İnformasiya Sistemləri aşağıdakı tələblərə cavab 
verməlidir: 

 Müxtəlif maşınla oxunan formatda hazırlanmış 
qeyri-məhdud sayda və həcmdə paylanmış 
məlumatlar bazaları ilə işləyə bilməlidir; 

 Biblioqrafik və elektron mətn və multimedia tipli 
informasiyanın bazaya bir dəfə daxil edilməsini, 
müxtəlif əlamətlərinə görə məlumatların operativ və 
çoxaspektli axtarışını, ədəbiyyatın elektron formada 
sifarişini, axtarışın nəticəsinin sənəd formasında 
(məsələn, kataloq kartı) çapı, sorğunun nəticəsinin 
məsafədən asılı olmayaraq digər tələbatçılara (oxu-
culara, kitabxanalara, təşkilatlara) ötürülməsini, 
digər kitabxanaların kataloqlarında on-line  axtarışı, 
şəbəkə kataloqlarının bir neçə nüsxədə etibarlı 
qorunmasını təmin etməlidir; 

 Sistem özü və özünün bütün ehtiyatları, oxucular, 
elektron xidmətin statistikası haqqında informasiya 
verməlidir; 

 Sistem atributlu  istifadəni təmin etməlidir; 
 Digər informasiya sistemlərinin ehtiyatlarını öz 

ehtiyatlarına inteqrasiya etmək imkanına malik 
olmalıdır; 

 Sistemin interfeysi az hazırlıqlı istifadəçilər üçün 
anlaşıqlı və sadə olmalıdır və s. 
Korporativ Kitabxana-İnformasiya şəbəkəsində əsas  

texnoloji proseslər  şəbəkənin informasiya ehtiyatlarının 
birgə yaradılması, qorunması və istismarına xidmət edir 
və şəbəkənin proqram təminatı vasitəsilə avtomatik 
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olaraq, müvafiq  struktur bölmələri tərəfindən yerinə 
yetirilir. Məhz bu səbəbdən Korporativ Kitabxana-
İnformasiya Şəbəkəsinin proqram təminatı aşağıdakı  
funksiyaları yerinə yetirən proqram vasitələrindən  təşkil 
olunmalıdır: 

1. Daxil olan ədəbiyyatın uçotu və işlənməsi, 
kollektiv istifadə üçün elektron kataloqun 
yaradılması;  

2. Şəbəkənin informasiya ehtiyatına normativ formal-
məntiqi nəzarət və informasiya məhsulunun key-
fiyyətinin təmin olunması;  

3. Avtomatik lüğət və linqvistik təminatın yaradılması 
və leksioqrafik-linqvistik nəzarət;  

4. İnformasiyanın arxivləşməsi;  
5. Oxuculara elektron xidmət;  
6. Elektron nəşrlərin və  multimedia materiallarınin 

hazırlanması. 
Daxil olan ədəbiyyatın kataloqlaşdırılması lokal ki-

tabxana-informasiya mərkəzində, Avtomatlaşmış Kitab-
xana İnformasiya Sisteminin Kataloqlaşdırıcı Avtomatlaş-
mış İşçi Yeri vasitəsilə həyata keçirilir.  Avtomatlaşmış 
İşçi Yeri ədəbiyyatın hazır biblioqrafik yazılarıni maşınla 
oxunan formatda (USMARC, RUSMARC, UNIMARC 
və s.)  nəşriyyat və kitab ticarəti təşkilatlarından 
alınmasını, yazıların surətinin iştirakçı  və digər 
kitabxanalardan idxal olunmasını və kitabxananın daxili 
tələbatına uyğun informasiyaların: inventar nömrə, rəf 
şifrəsi, nüsxələrin sayı və s. əlavə edilməsini təmin 
edir. Bu zaman ehtiyac olarsa avtomatik olaraq  
biblioqrafik yazıların bir formatdan digərinə avtomatik 
konvertəsi baş verir. Kataloqlaşdırılan ədəbiyyatın hazır 
biblioqrafik yazısı olmadıqda müəyyən edilmiş qaydalarla 
biblioqrafik yazı hazırlanır. Ədəbiyyatın biblioqrafik 
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yazısının keyfiyyəti yoxlandıqdan sonra o, ümumi 
istifadə üçün elektron kataloqa daxil edilir. Qeyd edək 
ki, biblioqrafik yazının keyfiyyəti üçün bilavasitə 
kitabxana rəhbəri məsuliyyət daşıyır.  

Biblioqrafik yazının keyfiyyəti yoxlandıqda, xüsusi 
proqram vasitəsilə formal-məntiqi və normativ nəzarət 
yerinə yetirilir. Belə ki: 

 Yazının   kommunikativ formatın biblioqrafik  
təsvir qaydalarına tam uyğunluğu yoxlanılır;  

 Yazının tamlığı-korporativ kataloqlaşdırma üçün 
müəyyən edilmiş bütün sahələrin informasiya ilə 
doldurulması yoxlanılır;  

 Təkrar olunan yazılar aşkar edilir və redaktəsi təklif 
olunur;  

  Leksik səhvlərə malik yazılar aşkar edilir və 
orfoqrafik lüğət bazası əsasında düzgün yazılmış 
variantlar təklif edilir.  
Linqvistik-leksioqrafik və terminoloji  nəzarətə əsa-

sən  ədəbiyyatın axtarış terminləri, təsnifat indeksləri, 
predmet rubrikası, dövlət, təşkilat, nəşriyyat, dövri 
mətbuat adları məruz qalır. Leksioqrafik və terminoloji  
nəzarət  müvafiq lüğət bazası əsasında yerinə yetirilir. 
Bu zaman  müvafiq proqram modulları vasitəsilə: 

 Terminlərin transletasiyası; 
 Axtariş terminlərinin, predmet rubrika adlarının bir 

dildən digərinə avtomatik tərcüməsi; 
 Lüğət təminatının avtomatik yaradılması, redaktəsi 

və yeniləşməsi; 
 Digər kitabxana informasiya sistemlərilə lüğət-infor-

masiya mübadiləsi təmin edilir. 

Arxivləşmə  informasiyanın qorunmasını təmin et-
mək üçün istifadə olunan ən vacib  texnoloji 
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əməliyyatdır  və bütün kitabxana-informasiya sistemləri 
bu əməliyyatı yerinə yetirən vasitələrlə təmin edilir. 
Arxivləşmə işi müvafiq kitabxana-informasiya mərkəzinin 
sistem administratoru tərəfindən yerinə yetirilir və 
arxivləşmə prosesinin müntəzəmliyi və qaydalrı Korporativ 
Kitabxana-İnformasiya Şəbəkəsinin normativ sənədləri ilə 
müəyyən edilir. Adətən işçi arxiv hər iş gününün 
axırında maqnit informasiya daşıyıcılarında saxlanılır.  
İşçi arxivlə yanaşı, baza informasiya mərkəzində 
ümümsistem və korporativ şəbəkənin yekun elektron 
kataloqunun  ehtiyat surəti yaradılır. 

Şəbəkədə elektron xidmət əsasən on-line formada, 
Web-sayt vasitəsilə yerinə yetirilir. İstifadəçinin, biblio-
qrafik yazının bütün axtarış ünsürlərinə görə sadə və 
məntiqi operatorlardan istifadə etməklə mürəkkəb kom-
pleks sorğuları əsasında  konkret kitabxanada, korporativ 
şəbəkədə və digər kitabxana-informasiya  sistemlərində 
axtarış aparılır. Tapılmış biblioqrafik yazıların əsasında 
ədəbiyyatın elektron forması varsa, o, əldə olunur və 
ya sifariş edilir. Sifariş olunan ədəbiyyatın elektron 
obrazı yaradılır və elektron sənəd göndərişi vasitələri-
elektron poçt, FTP xidməti və faksla  sifarişçiyə 
çatdırılır. Qeyd edək ki, son illər elektron sənəd 
göndərişi xidməti kitabxana fəaliyyətində ən önəmli 
xidmətlərdən birinə çevrilmişdir1. Bu xidməti yerinə 
yetirdikdə müəllif hüququnun qorunmasına riayət 
edilməlidir. Yalnız müəlliflə razılaşdıqdan, müəllif 
hüquqları olmayan və ya müəllif hüququnun müddəti 
bitmiş ədəbiyyatın elektron obrazını sifarişçiyə göndərmək 
olar.  

                                                           
1 Elektron sənəd göndərişinin necə yerinə yetirilməsi kitabın II fəslində 
şərh olunub. 
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§1.5. Ədəbiyyat axtarışının və sifarişinin kom-
püterləşdirilməsi  

Kitabxanaların əsas vəzifəsi olan  oxuculara xidmət 
oxucu sorğusu əsasında yerinə yetirilir və bu xidmətin 
səviyyəsindən kitabxananın cəmiyyətdəki imici və oxucu 
kontingentinin əhatə dairəsi asılıdır. Kitabxanalarda 
oxuculara yüksək xidməti təşkil etmək üçün ilk öncə 
oxucuların ədəbiyyatı əldə etmək üçün sərf etdikləri vaxtı 
minimuma endirmək lazımdır. Ənənəvi kitabxanalarda, 
oxucu ədəbiyyatı sifariş vermək üçün kataloq qarşısında 
xeyli vaxt sərf etməlidir. Kataloq kitab fondunun cari 
vəziyyətini 100% dəqiqliklə əks etdirmədiyindən 
oxucunun sifariş verdiyi ədəbiyyatı əldə etmək ehtimalı o 
qədər də böyük olmur. Belə ki, kataloq ədəbiyyatın 
hərəkətini əks etdirmədiyindən, sifariş olunan ədəbiyyatın 
cari anda sərbəst nüsxəsi kitabxanada olmadıqda sərf 
olunan vaxtın hədər olduğu aşkar olur. Kitabxananın 
elektron kataloqu oxuculara tələb olunan ədəbiyyatın  
qısa müddətdə kitabxanada olması haqqında dəqiq 
məlumat əldə etməsini təmin edir. Elektron kataloq 
ədəbiyyat  fondu haqqında ənənəvi kataloqlardan daha 
dolğun biblioqrafik məlumata malik olduğundan, oxucuya 
çoxelementli və çoxsəviyyəli axtarış imkanları təklif edir. 
Bunun nəticəsində ədəbiyyatın oxucuya çatmaq ehtimalı 
xeyli artır. Digər tərəfdən, oxucu elektron kataloq 
vasitəsilə uzaq məsafədən ədəbiyyat axtarıb, sifariş verə 
bilir. Qeyri-məhdud sayda oxucunun, eyni vaxtda 
elektron kataloqda biblioqrafik təsvirin bütün əsas 
elementləri üzrə  axtarış aparmaq, kitabxanada olan 
ədəbiyyatı sifariş etmək üçün hər bir Avtomatlaşmış 
Kitabxana-İnformasiya Sistemində xüsusi  Avtomatlaşmış 
İşçi Yerləri nəzərdə tutulmuşdur. İRBİS Avtomatlaşmış 
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Kitabxana-İnformasiya Sistemində lokal şəbəkə vasitəsilə 
elektron kataloqda ədəbiyyat axtarmaq və kitabxanada 
sərbəst nüsxəsi olan ədəbiyyatı  sifariş vermək üçün 
«Oxucu» Avtomatlaşmış İşçi Yeri, İnternet  Beynəlxalq 
kompüter-informasiya şəbəkəsi vasitəsilə  uzaq məsafədən 
on-line ədəbiyyat axtarışı üçün Web-IRBIS modulu 
nəzərdə tutulmuşdur.   

«Oxucu» Avtomatlaşmış İşçi Yerindən istifadə edən 
hər bir oxucu işə başlamazdan əvvəl sistemdə qeydiyyat-
dan keçməlidir. Oxucu qeydiyyatdan keçmək üçün Av-
tomatlaşmış İşçi Yeri yükləndikdə ekranda əks olunan 
Oxucunun qeydiyyatı (Регистрация читателя) forma-
sında  oxucu biletinin nömrəsini və ya adını, soyadını 
və atasının adını daxil edib, İşə başlamaq (Начать ра-
боту)  düyməsini sıxmalıdır (şək. 1). Qeydiyyatdan 
keçməyən oxucu «Oxucu» Avtomatlaşmış İşçi Yerindən 
istifadə edə bilməz. 

 

Şək. 1. 

Oxucunun kitabxanaya borcu  olduqda Avtomatlaşmış İşçi 
Yeri oxucunun kitabxanaya borcu olduğu və bu səbəbdən 
ədəbiyyat sifarişi hüququndan borcunu qaytarana qədər 
müvəqqəti olaraq məhrum olduğu  haqqında məlumat 
pəncərəsi açılır və oxucunun qeydiyyatından imtina 
olunur. Belə olduqda oxucu, Oxucunun qeydiyyatı (Ре-
гистрация читателя) formasının Ədəbiyyatın veril-
məsi/qaytarılması haqqında məlumat (Сведения  о выда-
чах/возвратах) düyməsini sıxaraq, açılan eyniadlı dialoq 
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pəncərəsində hansı ədəbiyyatın kitabxanaya qaytarmalı 
olduğunu öyrənə bilər. Belə ki, dialoq pəncərəsinin 
Ədəbiyyatın verilməsi/qaytarılması haqqında məlumat 
cədvəlinin Qaytarılma tarixi (Дата возврата) sütununda 
oxucunun qaytarmalı olduğu kitabın qaytarma tarixi əvə-
zinə qırmızı hərflə «Borc» (Долг) sözü yazılmış olur. 
Qeydiyyatdan müvəffəqiyyətlə keçdikdən sonra Avtomat-
laşmış İşçi Yerinin əsas interfeys  pəncərəsi açılır (şək. 
2).  

 

Şək. 2. 

İnterfeys pəncərəsi menyu sətrindən, alətlər panelindən, 
açılan siyahılardan, Lüğət, Sorğu, Qısa və Tam təsvir 
sahələrindən və cari vəziyyət sətrindən təşkil 
olunmuşdur.  

Menyu sətrində yerləşən menyular  məlumat baza-
sının seçilməsini, oxucunun qeydiyyatını, axtarış rejim-
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lərinin,  tapılmış ədəbiyyatın biblioqrafik təsvirinə baxış 
rejiminin müəyyən edilməsini, ədəbiyyatın sifarişini, 
sorğunun nəticəsinin çap edilməsini, ədəbiyyatın 
biblioqrafik yazısının yeni fayla ixrac edilməsini və s. 
əməliyyatların yerinə yetirilməsini təmin edir. Qeyd edək 
ki, menyuların əksər əmrlərini alternativ olaraq alətlər 
panelinin müvafiq alətləri vasitəsilə də yerinə yetirmək 
olar. Bu əmrlərin adının sağında  ona müvafiq alətin 
“nişanı”-piktoqramı əks olunur.  

Avtomatlaşmış İşçi Yerində Lüğətlər, Məlumatlar 
bazası, Görünüş formatı, Yerinə yetirilmiş sorğular, 
Dəqiqləşən sorğular, Biblioqrafik element siyahıları 
nəzərdə tutulmuşdur. Lüğətlər, Məlumatlar bazası, 
Görünüş formatı siyahıları müvafiq olaraq axtarış 
lüğətlərinin, məlumat bazasının və yazılara baxış 
formatının seçilməsini təmin edir. Yerinə yetirilmiş 
sorğular siyahısı vasitəsilə oxucu yerinə yetirilmiş 
sorğunu təkrar yerinə yetirə bilir1.  Dəqiqləşən sorğular 
siyahısı isə bütün baza üzrə deyil, yalnız əvvəl yerinə 
yetirilmiş sorğunun nəticəsində tapılmış sənədlər üzrə 
yeni sorğuya uyğun axtarış aparılması üçün istifadə 
olunur. Əvvəl yerinə yetirilmiş sorğunun nəticəsində 
tapılmış sənədlər üzrə yeni axtarış aparmaq  tələb 
olunduqda ilk öncə  Dəqiqləşən sorğular siyahısından 
yerinə yetirilmiş sorğu seçilir, bundan sonra isə yeni 
sorğu formalaşdırılır. Qeyd edək ki, cari iş müddətində 
müsbət nəticələnən bütün sorğular avtomatik olaraq 
Yerinə yetirilmiş sorğular və Dəqiqləşən sorğular 
siyahılarına əlavə olunur.  
                                                           
1 Yerinə yetirilmiş konkret sorğunu təkrar yerinə yetirmək üçün Yerinə 
yetirilmiş sorğular siyahısından sorğunu seçib, siçan qurğusunun sol 
düyməsini sıxmaq lazımdır. 
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Lüğət sahəsində Lüğətlər siyahısından seçilən axtarış 
elementinə uyğun terminlər siyahısı əks olunur. Qısa 
təsvir sahəsi cədvəl formasında olub, tapılmış 
ədəbiyyatın qısa biblioqrafik təsvir siyahısını əks etdirir. 
Qısa biblioqrafik təsvir sahəsində yazıların yerləşmə 
ardıcıllığını   açılan siyahısı vasitəsilə 
nəşr ilinə, bazaya daxilolma tarixinə, sərlövhəyə və s. 
parametrlərə görə nizamlamaq olar. Qısa biblioqrafik 
təsvir sahəsində konkret ədəbiyyatın tam biblioqrafik 
təsvirinə baxmaq üçün kursoru onun yerləşdiyi sətrin 
üzərinə qoyub siçanın sol düyməsini  sıxmaq lazımdır. 
Bu zaman ədəbiyyatın tam biblioqrafik təsviri Görünüş 
formatı siyahısı vasitəsilə seçilən görünüş formatı 
əsasında Tam təsvir sahəsində əks olunur. Tam təsvir 
səhəsində yerləşən  düymələr müvafiq olaraq cari 
sənədin seçilmiş biblioqrafik ünsürü ilə eyni olan bütün 
sənədlərin axtarşını, cari sənədə uyğun ədəbiyyatın 
elektron versiyası ilə tanış olmağı,  cari sənədin sifariş 
olunmasını təmin edir. 

Sorğular sahəsi axtarış üçün sorğunun formalaşdırıl-
masını təmin edən Sorğu terminləri (Термины запроса) 
cədvəlindən, Məntiqi (Логика)  və Qısaldılmış (Усече-
ние) düymələr qrupundan, Əlavə məhdudiyyət (Допол-
нительные ограничения) seçim elementindən, Yerinə ye-
tirmək (Выполнить) düyməsindən və Biblioqrafik təsvir 
sahəsi açılan siyahısından ibarətdir. 

 Cari vəziyyət sətrində isə konkret əməliyyata 
uyğun informasiya xarakterli məlumatlar əks olunur. 

Avtomatlaşmış İşçi Yeri  oxucuların hazırlıq sə-
viyyəsinə uyğun olaraq müxətlif axtarış rejimləri təklif 
edir: 

 az təcrübəli oxucular üçün; 
 əsas;  
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 kompleks; 
 ardıcıl 
 əlaqələr üzrə. 

Ən sadə axtarış rejimi az təcrübəli oxucular üçün 
nəzərdə tutulmuşdur və Axtarış (Поиск) menyusunun 
Yeni başlayanlar üçün («Для чайников») əmrini 
yükləməklə aktiv olur. Əmri yerinə yetirdəikdə açılan 
pəncərədə oxucu axtarış terminini-açar sözləri daxil 
edib, Yerinə yetirmək (Выполнить) düyməsini sıxmalıdır 
(şək. 3). Axtarış müvəffəqiyyətlə yerinə yetirildikdə, 
tapılmış ədəbiyyatın sayı Yerinə yetirmək (Выполнить) 
düyməsinin sağında yazılır. Oxucu Baxış (Просмотр) 
düyməsini sıxmaqla tapılmış ədəbiyyatın qısa və tam 
təsvirinə interfeys pəncərəsinin qısa və tam təsviri 
sahələrində baxa bilər.  

 

Şək. 3. 

Əsas axtarış interfeys pəncərəsinin  elementləri va-
sitəsilə reallaşır. Belə ki, oxucu   axtarış aparmaq 
uçün ilk növbədə Məlumatlar bazası və Lüğətlər  
siyahılarından müvafiq olaraq axtarış aparacağı  
məlumatlar bazasını və axtarış elementini - 
məqsədəuyğun biblioqrafik təsvir elementini (açar sözlər, 
müəllif, sərlövhə və s.) seçməlidir. Seçilmiş axtarış 
elementinə uyğun cari sorğu üçün axtarış terminlərinin 
siyahısı Lüğət (Словарь) sahəsində əks olunacaqdır. 



 

 

56

Lüğət (Словарь)  sahəsində terminlərin siyahısı əlifba 
ardıcıllığı ilə təqdim olunur. Lüğət (Словарь) sahəsindən 
lazımi termini seçib, Sorğu terminləri (Термины запро-
са) sahəsinə ötürmək üçün kursoru seçilmiş terminin 
üzərinə qoyub,   düyməsini və ya siçanın sol 
düyməsini iki dəfə sıxmaq lazımdır. Bu əməliyyatı  
Lüğət (Словарь) sahəsində kursoru lazımi terminin 
üzərinə qoyub buraxmayaraq Sorğu terminləri (Термины 
запроса) sahəsinə “ötürməklə” də yerinə yetirmək olar. 
Lüğət (Словарь) sahəsində lazımi termini tez tapmaq 
üçün Açar (Ключь) sətrindən istifadə olunur. Əgər 
oxucu Açar (Ключь) sətrinə  ''ma'' ifadəsini daxil 
etsə, Lüğət (Словарь) sahəsindəki terminlərə baxış 
verilən ifadəyə uyğun başlayacaq. Məsələn, maşın, 
marafon və s.  Yerinə yetirmək (Выполнить) 
düyməsini sıxdıqdan sonra sorğunun  nəticəsi - sorğuya 
görə tapılan ədəbiyyatların  qısa biblioqrafik təsviri 
cədvəl şəklində  qısa təsvir sahəsində əks olunacaqdır. 
Tam təsvir sahəsində isə qısa təsvir sahəsində əks olunan 
sənədlər siyahısının birinci  sənədinə uyğun ədəbiyyatın 
tam təsviri seçilmiş görünüş formatı əsasında əks 
olunacaqdır. Qısa təsvir sahəsində əks olunan digər 
sənədlərə uyğun ədəbiyyatın tam  biblioqrafik təsvirinə 
baxmaq üçün isə kursoru konkret sənədin təsvirinin 
üzərinə qoyub siçanın sol düyməsini sıxmaq lazımdır. 
Sorğu terminləri (Термины запроса) cədvəlinin  
düymələri müvafiq olaraq cədvələ ötürülmüş axtarış ter-
minlərini ləğv edir və yeni sorğuların yaradılması üçün 
yeni sahə təqdim edir. 

 Lüğətlər siyahısından axtarış elementi olaraq  
tematik rubrika seçdikdə, Lüğət (Словарь) sahəsində 
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mövzu rubrikaları ağacvari formada əks olunacaq1. 
Sahənin hər bir elementi bir mövzu rubrikasını göstərir. 
Mövzu rubrikası Universal Onluq Təsnifat cədvəlinə 
uyğun sistemləşmişdir. Digər axtarış elementlərindən 
fərqli olaraq tematik rubrika əsasında axtarış zamanı  
Naviqasiya (Навигация) qrupunda birləşən üç düymədən 
istifadə olunur. Əgər tematik rubrika ağacvari formada 
təsvir olunubsa, müvafiq düymələrin vasitəsilə ağacvari 
rubrikanın altrubrikalarına baxışı təmin etmək və əvvəlki 
vəziyyətinə qayıtmaq, tematik rubrikada cari rubrika ilə 
əlaqəli istinad oluna biləcək rubrikalara cədvəl formasında 
baxmaq və sorğu vermək mümkündür. Məsələn, 
''Arxiv işi, Arxivşünaslıq'' rubrikasını qeyd edib,  
düyməsini sıxdıqda bu rubrika ilə əlaqəli istinad oluna 
biləcək ''Arxiv, Tərcümə xidmətləri və s. informasiya 
orqanları'', ''İnformasiya təşkilatları'' rubrikalarından 
ibarət cədvəl təqdim olunacaq. Əgər cari rubrika istinada 
malik deyilsə, bu düymədən istifadənin əhəmiyyəti 
yoxdur. İstinadlı rubrikaların ağacvari formalı görünüşü 

 düyməsini, cədvəl formalı görünüşü isə 
 düyməsini sıxmaqla tənzimlənir. 

Axtarışın relevantlığını  artırmaq məqsədilə 
"Oxucu" Avtomatlaşmış İşçi Yeri  Məntiqi (Логика) 
və Qısaltma (Усечение) düymələr qrupu ilə təchiz 
olunmuşdur2. Məntiqi (Логика) düymələr qrupu 
kompleks axtarışı3 təmin edən məntiqi operatorların 
müəyyən edilməsi üçün nəzərdə tutulmuşdur və Sorğu 

                                                           
1Fraqment və istinadların göstərişi rejimindən başqa, çünki bu hallarda 
tematik rubrika cədvəl şəklində olur. 
2Bu düymələr qrupu Sorğular sahəsində yerləşir. 
3 Kompleks axtarış bir neçə axtarış elementləri əsasında axtarışın 
aparılmasını təmin edir.  
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terminləri (Термины запроса) sahəsində əks olunan 
axtarış terminlərinin axtarılan sənəddə1 iştirak formasını 
təyin edir. Aşağıdakı üç məntiqi operatorlardan istifadə 
olunur ki, bunlar: 

♦ Və ya (или) tapılmalı olan sənəddə axtarış 
terminlərinin heç olmasa birinin iştirak etməsini; 

♦ Və (и) tapılmalı olan sənəddə bütün axtarış 
terminlərinin iştirak etməsini ; 

♦ Yox (нет) birinci terminin iştirakı və bütün qalan 
axtarış elementlərinin yoxluğu tələbini təyin edir. 
Qısaltma (Усечение) düymələr qrupunun Yox 

(Нет) düyməsi seçildikdə, axtarış sənədin uyğun 
elementi ilə axtarış termini tam üst-üstə düşdüyü zaman 
müsbət nəticə verir. Hə (Да) düyməsi seçildikdə isə 
axtarış sənədin uyğun elementinin başlanğıcı ilə axtarış 
termini üst-üstə düşdüyü halda müsbət nəticə verir.  

Açar sözlərə görə axtarış zamanı   
açılan siyahısından istifadə olunur. Bunun vasitəsilə açar 
sözün sənədin hansı təsvir sahəsində (sərlövhədə, 
istənilən sahədə və s.) iştirak etməsini müəyyən etmək 
olar. 

Qeyd edək ki, «Oxucu» Avtomatlaşmış İşçi Yer-
ində kompleks axtarış aparmaq üçün alternativ olaraq 
kompleks axtarış rejimi nəzərdə tutulub. Kompleks 
axtarış rejimi Axtarış (Поиск) menyusunun Kompleks 
axtarış (Комплексный поиск) əmrini yerinə yetirməklə 
açılan eyniadlı interfeys pəncərəsində yerinə yetirilir. 
Açılan pəncərə iki işçi sahədən ibarətdir (şək. 4): 
Axtarışın ssenarisi (Сценари поиска) və Lüğət (Сло-
варь). 

                                                           
1 Sənəd dedikdə ədəbiyyatın biblioqrafik təsviri nəzərdə tutulur.  
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Şək. 4. 

Axtarışın ssenarisi sahəsi kompleks sorğunun tərtib olun-
masına xidmət edir və Axtarışın növü (Вид поиска), 
Termin (Термин),  Qısaltma (Усечение), Kontekst 
(Контекст), Məntiq (Логика) sütunlarından ibarətdir. 
Bu rejim vasitəsilə axtarış aparılmasını konkret misal 
üzərində izah edək. Məsələn, fərz edək ki, oxucuya 
A.İ.Qurbanovun informatikaya aid rus dilində kitabı la-
zımdır. Bunun üçün oxucu axtarışın kompleks rejimini 
seçdikdə açılan pəncərədə Axtarışın ssenarisi (Сценари 
поиска) sahəsində axtarış elementlərini- müəllif (ав-
тор), açar söz (ключевое слово), dil (язык), 
qısaltma parametri olaraq Yox (Нет), məntiqi operator 
olaraq isə Hə (Да) seçməli, axtarış elementinə uyğun 
lüğətlərdən axtarış terminlərini – A.İ.Qurbanov, 
informatika, rus (русский) terminlərini seçib siçan  
qurğusunun sol düyməsini iki dəfə sıxmalıdır. Bundan 
sonra oxucu Yerinə yetir (Выполнить) düyməsini 
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sıxmaqla axtarış apara bilər.  Əgər sorğuya uyğun sənəd  
tapılarsa,  Baxış (Просмотр) düyməsini sıxmaqla, 
sənədin biblioqrafik təsvirinə baxmaq olar.  

Ardıcıl axtarış xüsusi axtarış rejimi olub, kitabxana 
işçisi və hazırlıqlı oxucuların istifadəsi üçün nəzərdə 
tutulub. Bu rejim sənədin spesifik tələbə cavab verən 
axtarışını təmin edir. Bu axtarış rejimini seçmək üçün 
Axtarış (Поиск) menyusunun Ardıcıl axtarış (После-
довательный поиск) əmrini yerinə yetirmək lazımdır. 
Bu zaman açılan pəncərədə axtarış yerinə yetirilmiş 
sorğu əsasında aparıldıqda Dəqiqləşən sorğu (Уточняе-
мый запрос) açılan siyahısından sorğunu seçmək, məlu-
mat bazasında aparıldıqda isə dialoq pəncərəsinin Diapa-
zon MFN1 (Диапазон MFN) sahəsində axtarışda iştirak 
edən sənədlərin başlanğıc və son MFN nömrələrini daxil 
etmək lazımdır (şək. 5). Növbəti addımda Axtarış ele-
menti (Элемент поиска) sahəsində axtarış elementi kimi 
təyin olunan sahə və alt sahələri siyahıdan seçmək 
lazımdır. Daha sonra axtarış şərtini müəyyən etmək və 
Yerinə yetir (Выполнить) düyməsini sıxmaq lazımdır. 
Sorğuya uyğun sənəd  tapıldıqda  Baxış (Просмотр) 
düyməsini sıxmaqla, sənədin biblioqrafik təsvirinə 
baxmaq olar. Qeyd edək ki, axtarış şərti cari 
pəncərənin Şablon axtarış (Шаблон-поиск) sahəsinin 
müvafiq bölmələrində yerləşmiş interfeys elementləri 
vasitəsilə təyin edilir. Bu interfeys elementləri vasitəsilə 
axtarış elementinin sənəddə olmasına görə, konkret 
terminin və müəyyən ədədi intervalın axtarış parametrində 
iştirakına görə sorğu müəyyən etmək olar. 

                                                           
1 Sənədlərin bazada sıra nömrələri. 
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Şək. 5. 

Əlaqələr üzrə axtarış  rejimi cari sənədlə əlaqəli 
digər sənədlərin axtarışının aparılması üçün nəzərdə tutu-
lub. Bu rejim Axtarış (Поиск) menyusunun Əlaqələr 
üzrə axtarış (Поиск по связи) əmrini yerinə yetirməklə 
müəyyən olunur. Bu zaman açılan pəncərədən əlaqəyə 
görə axtarış üçün lazımi axtarış elementini seçmək və 
Yerinə yetirmək (Выполнить) düyməsini sıxmaq 
lazımdır. Qeyd edək ki. ələqələr üzrə axtarış alternativ 
olaraq Tam təsvir sahəsinin  düyməsini sıxmaqla da 
həyata keçirilə bilər.  
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Tapılmış sənədə uyğun ədəbiyyatı sifariş vermək 
üçün onun biblioqrafik təsvirinin Tam təsvir sahəsində  
əks olunmasına nail olduqdan sonra, Servis (Сервис) 
menyusunun Sifariş (Заказ) əmrini yerinə yetirmək və 
ya  düyməsini sıxmaq lazımdır. Bu zaman açılan  
pəncərədə oxucunun soyadı, adı və atasının adını və ya 
oxucu biletinin nömrəsini, ehtiyac olarsa, sifariş üçün 
əlavə şərhi daxil etmək, kitabxanada bir neçə abonement 
xidməti həyata keçirildikdə konkret xidmətin adını 
müəyyən etmək və İşi davam etmək (Продолжить ра-
боту) düyməsini sıxmaq lazımdır1 (şək. 6).  Bundan 
sonra sifariş qəbul olunur. Sifarişin yerinə yetirilməsi 
«Kitab verilişi» Avtomatlaşmış İşçi Yeri vasitəsi ilə 
təmin olunur. Tapılmış sənədləri çap etmək və yeni 
fayla ixrac etmək olar. Tapılmış sənədləri çap etmək 
üçün Servis (Сервис) menyusunun Çap (Печать) 
əmrini yerinə yetirmək və ya Servis (Сервис) alətlər 
panelinin  düyməsini sıxmaq lazımdır. 

                                                           
1 Dövri nəşri sifariş verdikdə açılan pəncərədə əlavə olaraq sifariş olunan 
dövri nəşrin nəşr ilini, cildini və sıra nömrəsini daxil etmək və İşi davam 
etmək (Prodoljitğ rabotu)  düyməsini sıxmaq lazımdır. 
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Şək. 6. 

Bu zaman  açılan dialoq pəncərəsində çap olunacaq 
yazıları (tapılmış bütün yazıları, qeyd olunmuş yazılar 
istisna olmaqla bütün yazıları, qeyd olunmuş yazıları, 
konkret sıra nömrəli yazıları), sənədin formatını, 
sənədin fayl şəklində yaradılmasını və ya birbaşa  
kağızda çap olunması rejimini  müəyyən etmək və 
Yerinə yetirmək (Выполнить) düyməsini sıxmaq lazımdır 
(şək. 7). Birbaşa  kağızda çap olunması rejimi 
müəyyən edildikdə sənəd kağızda çap olunacaqdır1. 
Sənədin  fayl şəklində yaradılması rejimini seçdikdə isə 
açılan növbəti dialoq pəncərəsində faylın ünvanını 
müəyyən etmək lazımdır.  

Tapılmış sənədləri ixrac etmək üçün Servis (Сер-
вис) menyusunun İxrac (Экспорт) əmrini yerinə 
yetirmək  açılan pəncərədə ixrac olunacaq yazıları 
(tapılmış bütün yazıları, qeyd olunmuş yazılar istisna 

                                                           
1 Ehtiyac olarsa, Çap parametrləri (Parametrı peçati) düyməsini sıxmaqla 
çap parametrlərini – səhifənin kənarlarından buraxılan boş məsafələri, 
səhifənin ölçülərini və şrifti dəyişmək olar. 
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olmaqla bütün yazıları, qeyd olunmuş yazıları, konkret 
sıra nömrəli yazıları), yazının formatını (UNİMARC, 
USMARC, RUSMARC), ixrac olunan yazılıardan ibarət 
yaradılan faylın tipini (İSO, mətn) və mətn kodlaşdır-
masını (DOS, Windows, UTF8) müəyyən etmək və Ye-
rinə yetirmək (Выполнить) düyməsini sıxmaq lazımdır. 
Növbəti açılan dialoq pəncərəsində ixrac olunacaq yazı-
lardan ibarət faylın ünvanını müəyyən etmək lazımdır.  

 

Şək. 7. 
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§1.6. Kitabxana fondunun kataloqlaşdırılma-sının 
kompüterləşdirilməsi 

Ədəbiyyatın kataloqlaşdırılması ədəbiyyat haqqında 
biblioqrafik yazıların hazırlanmasını nəzərdə tutan texnoloji 
prosesdir. Bu prosesin nəticəsində oxuculara xidmətin əsasını 
təşkil edən elektron kataloqun biblioqrafik məlumat bazası 
yaradılır. Kataloqlaşdırma işini kompüterləşdirmək məqsədilə 
İRBİS Avtomatlaşmış  Kitabxana-İnformasiya Sistemində 
«Kataloqlaşdırıcı» Avtomatlaşmış  İşçi Yeri nəzərdə 
tutulmuşdur.  

Kataloqlaşdırma əməliyyatı «Kataloqlaşdırıcı» 
Avtomatlaşmış  İşçi Yerinin əsas interfeys elementləri 
vasitəsilə yerinə yetirilir. Bu məqsədlə Avtomatlaşmış  İşçi 
Yerində aşağıdakı interfeys elementləri nəzərdə tutulmuşdur: 

1. Menyu sətri (şək. 1). Menyu sətrində yerləşən 
menyular  məlumat bazasının seçilməsini, yeni yazının 
yaradılmasını, yazılara baxış rejiminin müəyyən edilməsini, 
müxtəlif məlumat bazasından yazının axtarılmasını, yazının 
redaktəsini, seçilmiş yazıların ixracını, yazıların cari məlumat 
bazasına idxalını, statistik hesabatların, kataloq kartlarının 
hazırlanmasını və çapını və s. əməliyyatların yerinə 
yetirlməsini təmin edir.  

 
Şək. 1. 

2. Alətlər paneli (şək. 2). Avtomatlaşmış işçi yerində 
Düzəliş (Корректировка), Axtarış (Поиск) və Servis (Сервис) 
alətlər panelləri nəzərdə tutulmuşdur. Onların vasitəsilə 
müvafiq olararaq Düzəliş (Корректировка), Axtarış (Поиск) 
və Servis (Сервис)  menyularının əmrlərini yerinə yetirmək 
olar.  
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   Şək. 2. 

3. Lügət, Məlumatlar bazası, İşçi vərəqələr, Baxış formatı 
siyahıları (şək. 3). Bu interfeys elementləri müvafiq olaraq 
axtarış üçün lüğətlərin, məlumat bazasının və yazılara baxış 
formatının seçilməsini təmin edir.  

 

 
Şək. 3. 

4 . Axtarış, Qısa təsvir cədvəlləri və yazıya baxış sahəsi 
(şək. 4-6).  

 

Şək. 4.                  

Şək. 5. 

 
Şək. 6. 
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Axtarış cədvəlində (şək. 4) lüğət siyahısından müəyyən edilən 
axtarış elementinə (açar sözlər, müəllif, mövzu rubrikası, 
sərlöhvə, sənədin xarakteri, tipi\növü) uyğun axtarış 
parametrləri əks olunur. Kursoru axtarış parametrinin üzərinə 
qoyub, siçanın sol düyməsini sıxdıqda, axtarış nəticəsində 
tapılmış yazıların qısa təsvirləri Qısa təsvir sahəsində (şək. 5) 
əks olunacaqdır. Konkret yazının tam təsvirinə baxmaq tələb 
olduqda kursoru onun qısa təsvirinin üzərinə qoyub, siçanın sol 
düyməsini sıxmaq lazımdır. Bu zaman yazının tam təsviri baxış 
formatı siyahısından seçilən formata uyğun olaraq tam təsvir 
sahəsində (şək. 6) əks olunacaqdır. 

7 . İşçi vərəqlər (şək. 7).  

 
Şək. 7. 

İşçi vərəqlər UNİMARC formatının təsvir sahələrini əks 
etdirən element sahələrindən təşkil olunmuşdur. Yazının 
biblioqrafik təsvir ünsürləri İşçi vərəqlərin müvafiq element 
sahələrinə daxil edilir. Qeyd edək ki, ehtiyac olduqda işçi 
vərəqə yeni element sahəsi daxil etmək olar. Bunun üçün 
Düzəliş (Корректировка) alətlər panelinin alətini sıxmaq, 
açılan pəncərədə (şək. 8) UNİMARC formatının biblioqrafik 
təsvir sahələri siyahısından konkret sahəni seçmək və siçanın 
sol düyməsini iki dəfə sıxmaq lazımdır.   
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Şək. 8. 

Kataloqlaşdırılan ədəbiyyatın maşınlaoxunan biblioqrafik 
təsviri-biblioqrafik yazısı UNIMARC formatı əsasında 
hazırlanır. Yazının elementlərini daxil etməzdən əvvəl 
Məlumatlar bazası siyahısından elektron kataloqun məlumat 
bazasını, işçi vərəq siyahısından isə ədəbiyyatın tipindən asılı 
olaraq müvafiq işçi vərəqi seçmək lazımdır. Belə ki, 
kataloqlaşdırılan nəşr fərdi və ya kollektiv müəlliflərə malik 
monoqrafik nəşrdirsə, işçi vərəq olaraq RAZK42, müəyyən 
tədbirin nəşridirsə PVK, dövri mətbuat nəşridirsə OJ, hüquqi və 
ya normativ-texniki sənəddirsə AUNTD işçi vərəqlərini, 
məqalələrin analitik təsviri üçün isə ASP işçi vərəqini müəyyən 
etmək lazımdır. Sonra Servis (Сервис) menyusunun 
Parametrlərin tənzimlənməsi (Настройка параметров) 
əmrini yerinə yetirməklə və ya Servis (Сервис) alətlər panelinin 

 alətini sıxmaqla açılan pəncərənin İşin mərhələsi (Этап 
работы) sahəsinə açılan siyahıdan –ПК, С.А.А. (ФИО) 
sahəsinə kataloqlaşdırıcı öz soyadını, adını, atasının adını daxil 
etməlidir (şək. 9). Qeyd edək ki, kataloqlaşdırıcı bu əməliyyatı 
yerinə yetirmədikdə hər yeni yazı üçün bu məlumatları 
Texnologiya (Технология) işçi vərəqinin Kataloqlaşdırıcı, tarix 
(Kаталигизатор, дата) sahəsinə mütləq daxil etməlidir. Əks 
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halda, yeni hazırlanmış yazını yaddaşda saxlamaq mümkün 
olmayacaq. 

 
Şək. 9. 

Daha sonra biblioqrafik yazının elementlərini işçi vərəqlərin 
müvafiq element sahələrinə daxil etmək lazımdır1. Bir sıra 
sahələr çoxsaylı altsahələrə malik olduğundan  düyməsinə 
malikdir. Bu düyməni sıxdıqda açılan növbəti pəncərənin 
müvafiq sahələrinə məlumatlar  daxil edilir. Məlumatın daxil 
olmasını avtomatlaşdırmaq üçün siyahılardan istifadə etmək 
mümkündür. Bu siyahıların bir qismi, məsələn, müəllif, 
sərlöhvə və s. yeni informasiya daxil edildikcə avtomatik 
olaraq formalaşır. Həmçinin  klaviaturada olmayan simvolların  
daxil olması üçün F5,  latın/kiril qrafikasına keçid üçün F6, 
reqistiri dəyişdirmək üçün isə F7 funksional  düymələrini 
sıxmaq lazımdır. Yazıda bir sıra biblioqrafik ünsürlər, məsələn 
müəllif, İSBN və s. təkrar oluna bildiyindən,  onlara uyğun 
sahələr də təkrarlanır. Təkrarlanmanın sayı işçi vərəqin № 
sütununda göstərilir. Təkrarlanan yeni məlumat daxil etmək 
                                                 
1 Bir vərəqdən digərinə keçid onun adı ilə həyata keçirilir. 
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tələb olduqda kursoru təkrarlanma nömrəsinin üzərinə qoyub 
siçanın sol düyməsini sıxmaq lazımdır. Bu zaman məlumatı 
daxil etmək üçün təkrarlanan sahə yaranır.  
 Qeyd edək ki, dövri mətbuatın kataloqlaşdırılması 
istisna olmaqla, digər ədəbiyyatların kataloqlaşdırılması zamanı 
təkrar kataloqlaşdırmaya yol verməmək üçün, ilk öncə Dublet 
(Дублетность) işçi vərəqinin müvafiq sahələrində kitab 
haqqında əsas məlumatlar: fərdi və ya kollektiv müəllif, 
sərlövhə, buraxılış, nəşr, İSBN, həcm haqqında və s. 
məlumatları daxil etmək lazımdır. Növbəti vərəqə keçdikdə 
Avtomatlaşmış İşçi Yeri avtomatik olaraq bazada axtarış aparır 
və əgər bu məlumatlı ədəbiyyat kataloqa əvvəllər daxil edilibsə, 
bu haqda məlumat verir. Bu halda istifadəçi Düzəliş (Коррек-
тировка) alətlər panelinin  düyməsini sıxmaqla növbəti 
ədəbiyyatın əsas məlumatlarını daxil etməlidir. Əks halda, 
növbəti vərəqlərə daxil olub sahələrə müvafiq məlumatları 
daxil etmək lazımdır. Dövri mətbuatın kataloqlaşdırılması 
zamanı əsas məlumatlar Əsas BT1 (Основное БО, коды) işçi 
vərəqinin müvafiq sahələrinə daxil edilir. Daxil olunan yazının 
şifrəsi bazadakı yazıların heç birinin şifrəsilə eyni olmadıqda 
yazı yeni hesab olunur və kataloqlaşdırıcı növbəti işçi vərəqlərə 
digər məlumatları daxil etməlidir.  

Yeni yaradılmış yazını yaddaşda saxlamaq üçün Düzəliş 
(Корректировка) menyusunun Yaddaşda saxlamaq (Со-
хранить) əmrini yerinə yetirmək və ya Düzəliş (Корректи-
ровка) alətlər panelinin  alətini sıxmaq lazımdır.  

Konkret yazını redaktə etmək üçün ilk öncə kursoru 
yazının qısa təsvirinin üzərinə qoyüb siçan qurğusunun sol 
düyməsini sıxmaq  lazımdır. Bu zaman yazının biblioqrafik 
ünsürləri işçi vərəqlərin element sahələrində əks olunur ki, 
kataloqlaşdırıcı bu sahələrdəki məlumatları redaktə edə bilər. 
Redaktə olunacaq yazını tez müəyyən etmək üçün Axtarış 

                                                 
1 BT-biblioqrafik təsvir sözünün abbreviaturasıdır. 
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(Поиск) menyusunun əmrləri və  ya Axtarış (Поиск) alətlər 
panelinin alətləri vasitəsilə biblioqrafik məlumat bazasında 
axtarış aparmaq olar. Qeyd edək ki, axtarış «Oxucu» 
Avtomatlaşmış  İşçi Yerində olduğu kimi lüğət əsasında, 
kompleks və ardıcıl axtarış elementləri vasitəsilə eyni qaydada 
aparılır. Avtomatlaşmış İşçi Yeri hazırlanmış yazıların ixracını 
və biblioqrafik məlumat bazasına idxal olunmasını təmin edir. 
İdxal və ixrac əməliyyatları kitabxanalara hazır biblioqrafik 
yazıları mübadilə etməyə imkan verir. Yazıları ixrac etmək 
üçün Servis (Сервис) alətlər panelinin  alətini sıxmaq, açılan 
pəncərədə (şək. 10) ixrac olunacaq yazıları (bazadakı bütün 
yazıları, qeyd olunmuş yazılar istisna olmaqla bütün yazılar, 
qeyd olunmuş yazıları, konkret sıra nömrəli yazıları), yazının 
formatını (UNİMARC, USMARC, RUSMARC), ixrac olunan 
yazılardan ibarət yaradılan faylın tipini (İSO, mətn) və mətn 
kodlaşdırmasını (DOS, Windows, UTF8) müəyyən etmək və 
Yerinə yetirmək (Выполнить) düyməsini sıxmaq lazımdır. 
Növbəti açılan dialoq pəncərəsində ixrac olunacaq yazılardan 
ibarət faylın ünvanını müəyyən etmək lazımdır.  

 
Şək. 10. 
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Hazır yazıları biblioqrafik məlumat bazasına idxal etmək üçün 
ilk öncə kataloqlaşdırıcı idxal olunacaq yazılardan ibarət fayla 
malik olmalıdır. Bundan sonra Servis (Сервис) alətlər panelinin 

 alətini sıxmaq, açılan pəncərədə (şək.11) idxal olunan 
yazılardan ibarət faylın tipini (İSO, mətn), idxal olunacaq 
yazının formatını (UNİMARC, USMARC, RUSMARC), mətn 
kodlaşdırmasını (DOS, Windows, UTF8) müəyyən etmək və 
Yerinə yetirmək (Выполнить) düyməsini sıxmaq lazımdır. 
Növbəti açılan dialoq pəncərəsində idxal olunacaq yazılardan 
ibarət faylın ünvanını müəyyən etmək lazımdır.  

 
Şək. 11. 

«Kataloqlaşdırıcı» Avtomatlaşmış  İşçi Yeri bir sıra standart 
sənədlərin-ənənəvi kataloq kartlarının, kitab formulyarlarının, 
bilioqrafik göstəricilərin, statistik hesabatların hazırlanmasını 
və çapını təmin edir. Standart sənəd formalarını hazırlamaq 
üçün Servis (Сервис) alətlər panelinin  alətini sıxmaq və 
açılan dialoq pəncərəsində sənədin hazırlanması üçün istifadə 
olunan yazıları (bazadakı bütün yazıları, qeyd olunmuş yazıları, 
qeyd olunmuş yazılar istisna olmaqla bütün yazıları, konkret 
sıra nömrəli yazıları), sənədin tipini, sənədin fayl şəklində 
yaradılmasını və ya birbaşa  kağızda çap olunması rejimini 
müəyyən etmək və Yerinə yetirmək (Выполнить) düyməsini 
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sıxmaq lazımdır. Birbaşa  kağızda çap olunması rejimi 
müəyyən edildikdə sənəd kağızda çap olunacaqdır. Sənədin  
fayl şəklində yaradılması rejimini seçdikdə isə açılan növbəti 
dialoq pəncərəsində faylın ünvanını müəyyən etmək lazımdır. 
Bundan sonra yaradılan sənəd  MS Word proqramının sənəd 
pəncərəsində əks olunacaqdır.  

 
Şək. 12. 

§1.7. Komplektləşdirmə prosesinin kompüterləşdirilməsi 

Kitabxana fondunun komplektləşdirilməsi özündə 
kitabların sifarişini, dövri mətbuata abunəni, kitabxanaya daxil 
olmuş ədəbiyyatın qeydiyyatını, fond üzrə paylanmasını, 
ədəbiyyatın silinməsini və s. əhatə edən bir texnoloji prosesdir. 
Bu prosesin kompüterləşdirilməsi kitabxana fondunun optimal 
komplektləşdirilməsini, kitabxanaya daxil olunan ədəbiyyatın 
oxucuya daha tez çatmasını təmin edir.  

İRBİS Avtomatlaşmış Kitabxana İnformasiya İdarəetmə 
Sistemində komplektləşdirilmə texnoloji prosesini 
kompüterləşdirmək üçün «Komplektləşdirici» Avtomatlaşmış 
İşçi Yeri nəzərdə tutulmuşdur. Komplektləşdirmə əməliyyatları  
Avtomatlaşmış İşçi Yeri yükləndikdə açılan əsas interfeys 
pəncərəsində həyata keçirilir. İnterfeys pəncərəsi menyu 
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sətrindən, alətlər panelindən, Məlumatlar bazası və Lüğət açılan 
siyahılarından, Lüğət və Əlaqəli yazılar sahələrindən, cari 
vəziyyət sətrindən təşkil olunmuşdur (şək. 1).  

 
Şək. 1. 

Məlumatlar bazası siyahısı komplektləşdiriciyə lazım olan 
məlumat bazasının seçilməsini təmin edir. Lüğət açılan 
siyahısı, Lüğət və Əlaqəli yazılar siyahısı bazada axtarış 
aparılmasını təmin edir. İlk öncə Lüğət siyahısı vasitəsilə 
axtarış elementi seçilir və buna müvafiq olaraq Lüğət sahəsində 
əks olunan terminlər siyahısından kursoru konkret terminin 
üzərinə qoyub siçan qurğusunun sol düyməsi sıxılır1. Bu zaman 
axtarılan sənəd qısa formada Əlaqəli yazılar siyahısında əks 
olunur.  Tapılan sənədin tam yazılışına baxmaq tələb 
olunduqda Əlaqəli yazılar sahəsinin  düyməsini sıxmaq 
lazımdır. Menyu sətrində Məlumatlar bazası (База данных), 
Məsələlər (Задача), Rejim (Режим), Servis (Сервис), 
Kömək (Помощь) menyuları yerləşir. Axtarış əməliyyatından 
başqa bütün əməliyyatlar bu menyular vasitəsilə yerinə yetirilir. 
Məsələlər (Задача), Rejim (Режим), Servis (Сервис) 

                                                 
1 Lüğət  sahəsində lazımi termini tez tapmaq üçün Açar (Klöçğ) sətrindən də 
istifadə olunur. 



 

 

76 

menyusunun əmrlərini alternativ olaraq eyni adlı alətlər 
panelinin müvafiq alətləri vasitəsilə yerinə yetirmək olur.  

«Komplektləşdirici» Avtomatlaşmış İşçi Yeri dörd 
müxtəlif texnoloji əməliyyatın - ədəbiyyatın sifarişinin, 
kitabxanaya daxil olan və kitabxana fondundan silinən 
ədəbiyyat partiyalarının qeydiyyatının, dövri mətbuata abunə 
yazılışının yerinə yetirilməsini təmin edir. Avtomatlaşmış İşçi 
Yeri hər bir texnoloji əməliyyata uyğun fərdi interfeys 
elementləri təqdim edir. Konkret texnoloji əməliyyatı yerinə 
yetirmək üçün Məsələlər (Задача) menyusunun əməliyyata 
uyğun əmrini yerinə yetirmək lazımdır. Hər bir əmrə uyğun  
Rejim (Режим) menyusunun əmrləri, Rejim  alətlər panelinin 
alətləri müxtəlif olacaq, lüğət və məlumatlar bazası açılan 
siyahıları isə seçim üçün müxtəlif informasiyalar təqdim 
edəcəklər.  
Kitabı sifariş vermək üçün ilk öncə Məsələlər (Задача) 
menyusunun Sifariş (Заказ) əmrini yerinə yetirmək və ya 
Məsələlər panelinin ilk alətini sıxmaq lazımdır. Bundan sonra 
kitab satışı və yayımı müəssisələrinin məlumat bazası 
yaradılmalıdır. Bu bazaya müəssisələrin rekvizitləri daxil 
olunur və sonrakı əməliyyatlar zamanı açılan siyahı vasitəsilə 
bu yazılardan təkrar istifadə olunur. Bu mexanizm «satıcı» 
müəssisələrin rekvizitlərini hər dəfə daxil etmək zərurətini və 
səhv daxil etmək ehtimalını aradan qaldırır. Bazanı yaratmaq 
üçün Komplektləşdirici Rejim (Режим) menyusunun Yeni 
yazı-Təşkilat (Новая запись-Организация) əmrini yerinə 
yetirmək və bu zaman avtomatik yüklənən «Kataloqlaşdırıcı» 
Avtomatlaşmış İşçi Yerinin Təşkilat haqqında məlumatlar 
(Данные об организации) işçi vərəqində müəssisənin tam 
adını, yerləşdiyi şəhəri, kodunu, müəssisə rəhbərinin vəzifəsini, 
soyadını, faks və telefon1 nömrələrini, e-mail ünvanını, 
yerləşdiyi şəhəri, küçəni, evin nömrəsini, maliyyə rekvizitlərini 
                                                 
1Müəssisənin əlaqə üçün bir neçə faks və telefon nömrələri təkrarlanan 
sahələrdə yazılır. 
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- hesablaşma və müxbir hesablarının nömrəsini və onların 
yerləşdiyi bankın adını daxil etmək lazımdır (şək. 2). Qeyd 
edək ki, müəssisənin adı  28 simvoldan çox olarsa, o zaman 
adın qısa yazılşını və ya abbreviaturasını Kod, abbreviatura, 
şəhər (Код, Аббревиатура, город) sahəsinə daxil etmək 
lazımdır. Baza formalaşdıqdan sonra kitab sifarişinin 
qeydiyyatına və sifariş sənədləri hazırlamaq əməliyyatlarına 
başlamaq olar. 

 
Şək. 2. 

Bunun üçün Servis (Сервис) menyusunun Tənzimləmə (На-
стройка) əmrini yerinə yetirmək və açılan Şəxsi parametrlərin 
müəyyən edilməsi (Установка личных параметров) 
pəncərəsinin İşin mərhələsi (Этап работы) sahəsinə siyahıdan 
yazının hazırlanmasına uyğun ПК parametrini1, İcraçının 
S.A.A. (ФИО исполнителя) sahəsinə isə sifariş verən şəxsin 
soyadını, adını və atasının adını daxil etmək və Tətbiq etmək 
(Применить) düyməsini sıxmaq  lazımdır (şək. 3).   

                                                 
1 PK parametri yeni yazının yaradıldığını müəyyən edir. 
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Şək. 3. 

Bundan sonra Rejim (Режим) menyusunun Yeni yazı- 
sifarişinin BT (Новая запись-БО заказа) əmrini yerinə 
yetirmək lazımdır. Bu zaman yüklənən «Kataloqlaşdırıcı» 
Avtomatlaşmış İşçi Yerinin Dublet (Дублетность) işçi 
vərəqində ədəbiyyatın  əsas biblioqrafik elementləri: İSBN, 
müəllif, kollektiv müəllif, sərlövhə, sərlövhəyə dair məlumat, 
ilkin və sonrakı məsuliyyət məlumatları, çoxcildli ədəbiyyat 
üçün sifariş olunan cildin nömrəsi, nəşr ili və yeri, ədəbiyyatın 
səhifələrinin sayı, tirajı haqqında məlumatlar daxil edilir. 
Növbəti işçi vərəqə keçdikdə proqram daxil edilmiş yeni yazını 
bazadakı yazılarla müqayisə edir. Müqayisə nəticəsində 
ədəbiyyatın əvvəllər sifariş olunduğu aşkar olduqda, bu barədə 
məlumat pəncərəsi açılır.    Bu halda komplektləşdirici Düzəliş 
alətlər panelinin  alətini  sıxmaqla növbəti ədəbiyyatın 
sifarişi üçün onun biblioqrafik təsvirini daxil etməlidir. Daxil 
edilmiş yazı yeni olduqda isə Kodları (Коды) və KO işçi 
vərəqlərinə digər əlavə biblioqrafik məlumatları (məsələn, 
ədəbiyyatın dilini, UOT kodunu və s.), Sifariş haqqında 
məlumatlar (Сведения о заказах) işçi vərəqinin 1-ci ədəbiyyat 
sifarişi (yerləşmə/icra) (1-й Заказ на книги (размеще-
ние/исполнение)) sahəsinə siyahıdan satıcı təşkilatın adını, 
kodunu, sifarişin nömrəsini, sifariş tarixini, sifarişin miqdarını 
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daxil etmək1, Sifariş haqqında məlumatlar/nüsxələrin daxil 
olması (Сведение о заказе / поступление экземпляров) 
sahəsində isə status olaraq siyahıdan “2” parametrini seçmək 
lazımdır.  

Konkret təşkilatdan bir neçə kitab aldıqda qrup şəklində 
sifariş həyata keçirilir. Bunun üçün Servis (Сервис) 
menyusunun Tənzimləmə (Настройка) əmrini yerinə 
yetirmək və açılan Şəxsi parametrlərin müəyyən edilməsi (Ус-
тановка личных параметров) pəncərəsinin siyahıdan Qrup 
şəklində sifariş üçün təşkilatın kodu (Код организации группо-
вого заказа), Qrup şəklində sifarişin nömrəsi-YENİ (Номер гр. 
заказа-НОВЫЙ), Kitab sifarişinin tarixi (Дата заказа книг) 
sahələrinə müvafiq olaraq təşkilatın kodunu, sifarişin nömrəsini 
və sifariş tarixini daxil etmək lazımdır. Bundan sonra seans 
müddətində yeni sifariş olunan bütün ədəbiyyatlar üçün yalnız 
biblioqrafik təsviri və sifariş olunan ədəbiyyatın sayını daxil 
etmək kifayətdir. Digər məlumatlar yazı yaddaşda saxlananda 
avtomatik proqram tərəfindən daxil olunacaq.  

Qeyd edək ki, əvvəllər sifariş verilmiş ədəbiyyatı 
yenidən sifariş vermək üçün ilk öncə ədəbiyyatı lüğət sahəsi 
vasitəsilə axtarıb, qeyd etmək və Servis  alətlər panelinin  
alətini sıxmaq lazımdır. Bu  zaman yüklənən «Kataloqlaşdırıcı» 
Avtomatlaşmış İşçi Yerinin Sifariş haqqında məlumatlar (Све-
дение о заказе) işçi vərəqində sifariş haqqında yeni 
məlumatları daxil etmək lazımdır.  

Lüğət sahəsi vasitəsilə həmçinin sifarişlərin yerinə 
yetirilməsinə nəzarət etmək mümkündür. Belə ki, Lüğət açılan 
siyahısından Yerinə yetirilmiş sifarişlər (Выполнение заказа), 
Yerinə yetirilməmiş sifarişlər (Не выполненные заказы) 
parametrlərini seçməklə müvafiq olaraq Lüğət sahəsində əks 

                                                 
1 Eyni zamanda bir neçə təşkilat sifariş olunarsa, bu məlumatlar təkrar 
olunan sahələrdə yazılır. 
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olunan yerinə yetirilmiş və hələ tam yerinə yetirilməmiş 
sifarişlərin siyahısına baxmaq olar. 

Kitabxanaya daxil olmuş ədəbiyyat partiyasının 
qeydiyyatı üçün Məsələlər (Задача) menyusunun Daxil olma 
(Поступление) əmrini yerinə yetirmək və ya Məsələlər 
panelinin ikinci alətini sıxmaq lazımdır.  Bundan sonra ilk öncə 
Rejim (Режим) menyusunun Yeni yazı-YUK (Новая за-
пись-КСУ) əmrini yerinə yetirmək və ya  Rejim alətlər 
panelinin  düyməsini sıxmaq lazımdır. Bu zaman 
avtomatik olaraq «Kataloqlaşdırıcı» Avtomatlaşmış İşçi Yeri 
yüklənir. Avtomatlaşmış İşçi Yerinin Daxilolma üçün YUK 
yazılarının daxil edilməsi (Ввод записи в КСУ поступление) 
işçi vərəqinin Kitabxanaya daxil olmuş ədəbiyyat haqqında 
məlumat (Сведения о поступлении книг в библиотеку) 
element sahəsinə YUK-da yazının nömrəsini1, fərdi qeydiyyat 
aktının nömrəsini, tarixi2, qoşma sənədin nömrəsini, 
komplektləşmə mənbəyini, ədəbiyyatın ada görə sayını, 
ədəbiyyatın nüsxələrinin sayını və məbləği,  Mərhələ, tarix, 
S.A.A (Этап работы, дата, ФИО) element sahəsinə isə  
mərhələ olaraq ПК, tarixi və kitabı qəbul edən şəxsin soyadını 
daxil etmək lazımdır. Qeyd edək, bu element sahələrinə 
məlumat birbaşa deyil,  element sahələrinin  düyməsini 
sıxmaqla açılan  müvafiq pəncərələrin eyniadlı altsahələrinə 
Daxil etmək (Ввод) düyməsini sıxmaqla daxil olunur (şək. 4). 

 
                                                 
1 Adətən YUK-da yazı nömrəsi <il/ nömrə>formatı əsasında daxil edilir. 
Məsələn, 2005/4,  
2 Cari tarix Alt+D düyməsini sıxmaqla daxil edilə bilər. 
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Şək. 4. 

Əgər ədəbiyyat bir neçə fərdi qeydiyyat aktı əsasında 
kitabxanaya daxil olunarsa, ilk öncə Kitabxanaya daxil olmuş 
ədəbiyyat haqqında məlumat (Сведения о поступлении книг в 
библиотеку) element sahəsinə  daxil olunan ədəbiyyat 
partiyası haqqında ümumi məlumatları: YUK-da yazının 
nömrəsini,  tarixi, komplektləşmə mənbəyini, qoşma sənədin 
nömrəsini, ədəbiyyatın ada görə sayını, ədəbiyyatın 
nüsxələrinin sayını və məbləği daxil etmək lazımdır. Sonrakı 
addımda  hər bir akt üçün təkrarlanan sahə yaradıb, aktın 
nömrəsini, cari akt əsasında daxil olan ədəbiyyatın ada görə 
sayını, nüsxələrinin sayını və məbləği  daxil etmək lazımdır.  

Yeni YUK yazısı yaratdıqdan sonra  Servis menyusunun  
Tənzimləmə (Настройка)  əmrini yerinə yetirməklə açılan 
Şəxsi parametrlərin müəyyən olunması (Установка личных 
параметров) pəncərəsinin müvafiq sahələrinə YUK-da 
yazının və fərdi uçot aktının nömrələrini müəyyən etmək 
lazımdır1 (şək. 5). 

 
Şək. 5. 

                                                 
1 Şəxsi parametrlərin müəyyən olunması (Ustanovka liçnıx parametrov) 
pəncərəsi  Servis alətlər panelinin düyməsini sıxmaqla da açılır.  
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Bundan sonra ədəbiyyatın qeydiyyatına başlamaq olar. 
Ədəbiyyat sifariş əsasında daxil olduqda bazadan ədəbiyyatı 
müəllifə, sərlövhəyə, açar sözlərə, sifariş olunmuş təşkilata 
görə axtarıb, qeyd etmək və Servis  alətlər panelinin  alətini 
sıxmaq lazımdır. Bu zaman  açılan və daxil olmanın 
qeydiyyatının müəyyən olunmuş YUK yazısı əsasında 
aparılacağı haqqında xəbərdarlıq pəncərəsinin Bəli (Да) 
düyməsini sıxdıqdan sonra avtomatik olaraq «Kataloqlaşdırıcı» 
Avtomatlaşmış İşçi Yeri yüklənir. Avtomatlaşmış İşçi Yerinin 
Sifariş haqqında məlumatlar, nüsxələr (Сведения о заказах, 
экземпляры) işçi vərəqinin sifariş olunmuş təşkilatdan asılı 
olaraq 1-ci ədəbiyyat sifarişi (yerləşmə/icra) (1-й заказ на кни-
ги (размещение и исполнение), 2-ci ədəbiyyat sifarişi 
(yerləşmə/icra) (2-й заказ на книги (размещение и исполне-
ние)), 3-cü ədəbiyyat sifarişi (yerləşmə/icra) (3-й заказ на кни-
ги (размещение и исполнение)) element sahələrinin birinə 
daxil olmuş ədəbiyyatın sayını və ehtiyac olarsa, əlavə 
məlumatı, Sifariş haqqında məlumatlar/nüsxələrin daxil olması 
(Сведение о заказе, поступление  экз-ров) element sahəsinə 
isə ədəbiyyatın yerləşəcəyi fond, inventar nömrə, kitabxanada 
ştrix-kod texnologiyasından istifadə olunarsa, ştrix-kodu  daxil 
etmək lazımdır. 

Əgər ədəbiyyat  sifariş əsasında deyil, digər kanalla 
daxil olarsa, ədəbiyyatın qeydiyyatını aparmaq Rejim (Режим) 
menyusunun Sifarişsiz təsvirin daxil edilməsi (Ввод описа-
ния без заказа) əmrini yerinə yetirmək və avtomatik yüklənən 
«Kataloqlaşdırıcı» Avtomatlaşmış İşçi Yerinin ədəbiyyat 
sifarişində olduğu kimi  ədəbiyyatın Dublet (Дублетность), 
Biblioqrafiya (Библиография), Kodlar (Коды) işçi 
vərəqlərində  biblioqrafik təsviri daxil etmək, Sifariş haqqında 
məlumatlar, nüsxələr (Сведения о заказах, экземпляры) işçi 
vərəqinin sifariş olunmuş təşkilatdan asılı olaraq 1–ci ədəbiyyat 
sifarişi (yerləşmə/icra) (1-й заказ на книги (размещение и ис-
полнение), 2–ci ədəbiyyat sifarişi (yerləşmə/icra) (2-й заказ на 
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книги (размещение и исполнение)), 3-cü ədəbiyyat sifarişi 
(yerləşmə/icra) (3-й заказ на книги (размещение и исполне-
ние)) element sahələrinin birinə daxil olmuş ədəbiyyatın sayını 
və ehtiyac olarsa əlavə məlumatı, Sifariş haqqında 
məlumatlar/nüsxələrin daxil olması (Сведение о заказе, по-
ступление  экз-ров) element sahəsinə isə ədəbiyyatın 
yerləşəcəyi fond, inventar nömrə, kitabxanada ştrix-kod 
texnologiyasından istifadə olunarsa, ştrix-kodu  daxil etmək 
lazımdır. Hər iki halda ədəbiyyatın qeydiyatı Rejim (Режим) 
menyusunun YUK yazılarının doldurulması  (Пополнение 
записи КСУ) əmrini yerinə yetirməklə davam etdirilir. Bu 
zaman kitabxanaya daxil olmuş ədəbiyyatların tipinə və 
formasına,  mətnin dilinə, elm sahələrinə görə, kitabxanaya ilk 
dəfə daxil olmuş ədəbiyyatların, eyni təşkilatdan təkrar daxil 
olmuş ədəbiyyatların statistik təhlili aparılır, ada, nüsxəyə görə  
sayı və yekun məbləğ hesablanır. Bundan sonra daxil olmuş 
ədəbiyyatın hər bir akt üzrə yekun qiymətini hesablamaq üçün 
Servis (Сервис) menyusunun Qlobal düzəliş (Глобальная 
корректировка) əmrini yerinə yetirmək lazımdır. Bu zaman 
açılan pəncərədə (şək. 6) Açmaq (Открыть) düyməsini 
sıxmaq və açılan pəncərədə kursoru CENA-kitabın qiymətinin 
daxil olması  sətrinin üzərinə qoyub siçanın sol düyməsini iki 
dəfə sıxmaqla  pəncərəsində CENA.WSS sətrinin əks 
olunmasına nail olmaq lazımdır. Bundan sonra kursoru 
CENA.WSS sətrinin üzərinə qoyub açılan siyahı  vasitəsilə 
aktın nömrəsini müəyyən etmək və yerinə yetirmək lazımdır. 
Ədəbiyyat partiyası  bir neçə akt əsasında daxil olduqda bu 
əməliyyatı hər bir akt üçün təkrar yerinə yetirmək lazımdır.   
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Şək. 6. 

Ədəbiyyat daxil olduqdan sonra onun biblioqrafik 
təsvirini elektron kataloqun biblioqrafik məlumat bazasına 
daxil etmək lazımdır. Bunun üçün Lüğət sahəsindən  YUK 
nömrəsini müəyyən etmək və  Servis (Сервис) menyusunun 
EK-a köçürmək (Перенос в ЭК) əmrini yerinə yetirmək və 
açılan eyniadlı pəncərədə elektron kataloq bazasının adını 
müəyyən edib OK düyməsini sıxmaq lazımdır 

Kitabxana fondundan ədəbiyyatın silinməsinin 
qeydiyyatı üçün ilk öncə Məsələlər (Задача) menyusunun 
Xaric olma (Выбитие) əmrini yerinə yetirmək və ya 
Məsələlər panelinin üçüncü alətini sıxmaq lazımdır. Bundan 
sonra Rejim (Режим) menyusunun Yeni yazı-YUK (Новая 
запись-КСУ) əmrini yerinə yetirmək və bu zaman yüklənən 
«Kataloqlaşdırıcı» Avtomatlaşmış  İşçi Yerinin YUK-na 
yazıların daxil edilməsi (Ввод записи в КСУ выбитие) işçi 
vərəqinin Kitab partiyasının silinməsi haqqında məlumatlar 
(Сведения о выбитии партии  книг) element sahəsinə YUK-
da silinmə yazısının nömrəsini, tarixi, qoşma sənədin 
nömrəsini, silinmənin səbəbini, ədəbiyyatın saxlandığı fondu 
müəyyən etmək lazımdır. Ədəbiyyat fonddan silinərək digər 
kitabxanaya və ya təşkilata verildikdə əlavə olaraq Verilmə 
aktının nömrəsi (Номер акт передачи) element sahəsinə  
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verilmə aktının nömrəsini və cari tarixi, verilmənin formasını, 
verilən nüsxələrin sayını, verilən ədəbiyyatın saxlanacağı yeri  
daxil etmək lazımdır. Sonra Servis (Сервис) menyusunun 
Tənzimləmə (Настройка) əmrini yerinə yetirmək və açılan 
Şəxsi parametrlərin müəyyən edilməsi (Установка личных па-
раметров)  pəncərəsinin YUK-da silinmə yazısının nömrəsini,  
ədəbiyyat fonddan silinərək digər kitabxanaya və ya təşkilata 
verildikdə həmçinin  verilmə aktının nömrəsini müəyyən etmək 
lazımdır. Bundan sonra ədəbiyyatın silinməsinin qeydiyyatına 
başlamaq olar. Bunun üçün elektron kataloqun bazasını 
müəyyən edib,  Lüğət açılan siyahısının təklif etdiyi axtarış 
elementlərinə (müəllifə, sərlövhəyə, inventar nömrəsinə, ştrix-
koda və s.) silinəcək ədəbiyyatlara görə axtarıb qeyd etmək   və 
Servis  alətlər panelinin  alətini sıxmaq lazımdır. Bu zaman  
açılan və silinmənin qeydiyyatının müəyyən olunmuş YUK 
yazısı əsasında aparılacağı haqqında xəbərdarlıq pəncərəsinin 
Bəli (Да) düyməsini sıxdıqdan sonra avtomatik olaraq 
«Kataloqlaşdırıcı» Avtomatlaşmış İşçi Yeri yüklənir. 
Avtomatlaşmış İşçi Yerinin-Nüsxələr (Экз.-ры) işçi vərəqinin 
Nüsxələr haqqında məlumat (Сведение о экземплярах) 
sahəsində açılan siyahıdan nüsxənin statusu üçün  6 (silinmə) 
və ya 4 (itirilmiş) müəyyən etmək lazımdır, əlavə olaraq, başqa 
təşkilata veriləcək,  itirilmiş və ya məhv olunmuş nüsxələrin 
sayını daxil etmək, verilən ədəbiyyatın saxlanacağı yeri 
müəyyən etmək lazımdır. 
 Ədəbiyyat fonddan digər təşkilata verilmədən silinirsə, 
ədəbiyyat partiyasını qrup şəklində silmək mümkündür. Bunun 
üçün  silinəcək ədəbiyyatın yazılarını  elektron kataloqun 
məlumat bazasından tapmaq, qeyd etmək və Rejim (Режим) 
menyusunun Qrup şəklində silmək (Групповое списание) 
əmrini yerinə yetirmək lazımdır. Bu zaman açılan silinmənin 
qeydiyyatının müəyyən olunmuş YUK yazısı əsasında 
aparılacağı haqqında xəbərdarlıq pəncərəsinin Bəli (Да) 
düyməsinin sıxmaq lazımdır. Avtomatlaşmış İşçi Yeri 
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avtomatik olaraq qeyd olunan yazıların statusunda  silinməyə 
uyğun düzəliş aparır və bu haqda  məlumat açılan pəncərədə 
əks olunur. Silinmə əməliyyatını sona çatdırmaq üçün Servis 
menyusunun Silinməni tamamlamaq (Завершение выби-
тия) düyməsini sıxmaq və açılan dialoq pəncərəsində Bəli (Да) 
düyməsini sıxmaq lazımdır. Avtomatlaşmış İşçi Yeri bu zaman 
bazada dəyişiklik aparır. Sonda YUK kitabına yekun 
məlumatların daxil olunması üçün Servis menyusunun YUK 
yazılarının doldurulması  (Пополнение запись КСУ ) 
əmrini yerinə yetirmək lazımdır. Bu zaman avtomatik  olaraq, 
digər təşkilata və ya fonda verilən, fonddan silinən, itirilmiş və 
ya məhv olmuş nüsxələrin sayı, silinən ədəbiyyatların tipinə və 
formasına, mətnin dilinə, elm sahələrinə görə, ada, nüsxəyə 
görə  sayı və yekun məbləğ hesablanır.  

Ədəbiyyatın nüsxələri fonddan silindikdə, onun 
biblioqrafik yazısını elektron kataloqdan ləğv etmək lazımdır. 
Bunun üçün Rejim alətlər panelinin  düyməsini sıxmaq və 
açılan pəncərədə bazanın adını müəyyən etmək və OK 
düyməsini sıxmaq lazımdır.  

Kitabxana dövri mətbuata abunə xidmətinin 
kompüterləşdirilməsi üçün ilk öncə Məsələlər (Задача) 
menyusunun Abunə (Подписка) əmrini yerinə yetirmək və ya 
Məsələlər panelinin sonuncu alətini sıxmaq lazımdır. 

Abunə mətbuat yayımı müəssisələri vasitəsilə 
aparıldığından, ilk öncə  onların ünvanları məlumatlar bazasına 
daxil edilməlidir. Bunun üçün  Rejim (Режим)  menyusunun 
Yeni yazı-Ünvanlar (Новая запись-Адресат) əmrini yerinə 
yetirmək və bu zaman avtomatik yüklənən «Kataloqlaşdırıcı» 
Avtomatlaşmış  İşçi Yerinin Abunənin ünvan məlumatları  
(Данные об адресатах подписки)  işçi vərəqinin müvafiq 
sahələrində abunənin ünvanını1, abonement kartının və 

                                                 
1 Abunənin ünvanı olaraq müvafiq alt sahələrdə mətbuat yayımı 
müəssisəsinin kodu, telefon nömrəsi, adının qısa yazılışı daxil edilir. 
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göndəriş kartının hazırlanması üçün müəssisənin ünvanı 
haqqında tam və qısa məlumatları daxil etmək lazımdır.   

Mətbuat yayımı müəssisələrinin ünvan siyahılarından 
ibarət məlumatlar bazası formalaşdıqdan sonra, 
komplektləşdirici dövri mətbuata abunə əməliyyatına başlaya 
bilər. Qeyd edək ki, Avtomatlaşmış İşçi Yeri dövri mətbuata 
fərdi formada və qrup şəklində abunə əməliyyatını yerinə 
yetirməyi təmin edir. Abunə əməliyyatı komplektləşdiricinin 
müəyyən olunması ilə başlanılır. Bunun üçün komplektləşdirici 
kitab sifarişində olduğu kimi, Servis (Сервис) menyusunun 
Tənzimləmə (Настройка) əmrini yerinə yetirib, açılan Şəxsi 
parametrlərin müəyyən edilməsi (Установка личных пара-
метров) pəncərəsinin  İşin mərhələsi (Этап работы) sahəsinə 
siyahıdan yazının hazırlanmasına uyğun ПК parametrini1, 
İcraçının S.A.A. (ФИО исполнителя) sahəsinə isə özünün 
soyadını, adını və atasının adını daxil etməlidir. Bundan sonra   
fərdi formada abunə əməliyyatı aparmaq üçün  sifariş olunan 
dövri mətbuat nəşrinin biblioqrafik məlumatları daxil 
edilməlidir. Bunun üçün Rejim (Режим)  menyusunun Yeni 
yazı - Nəşrin BT2 (Новая запись - БО издания) əmrini 
yerinə yetirmək və açılan «Kataloqlaşdırıcı» Avtomatlaşmış 
İşçi Yerinin  Biblioqrafiya və kodlar (Библиография и коды) 
işçi vərəqinin müvafiq sahələrinə nəşrin biblioqrafik təsvirini-
nəşrin sərlövhəsini, sərlövhəyə aid məlumatları, ilkin və 
sonrakı məsuliyyət haqqında məlumatları, nəşriyyatı, nəşr 
yerini, nəşr müddətini (başlanğıc və son nəşr tarixi), çap yerini, 
İSSN-nömrəsini, şifrəni, UOT indeksini,  Sİ kodunu: nəşrin 
növünü, dövrilik kodunu, dövrilük (ildə sayını) və müntəzəmlik 
parametrlərini, xarakter haqqında məlumatları, göstərici 
parametrini, konfrans indikatorunu,3 seriyalı nəşr üçün 

                                                 
1 PK parametri yeni yazının yaradıldığını müəyyən edir. 
2 BT-biblioqrafik təsvir sözünün abberveturasıdır. 
3 Konfrans nəşri olduqda o, konfrans parametri olduqda isə 1 parametrini 
daxil etmək lazımdır 
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məlumatları daxil etmək lazımdır. Növbəti müddət üçün sifariş 
(Заказ на очередной период) işçi vərəqinin müvafiq 
sahələrinə isə abunə  müddəti, abunənin indeksini, komplektin 
kataloq üzrə qiymətini, göndərmə haqqını, sifariş olunan 
müəssisənin kodunu, sifariş olunan komplektin sayını daxil 
etmək lazımdır (şək. 7). Xarici təşkilatlardan abunə olduqda, 
əlavə olaraq valyutanın adını, əgər kitabxananın ayrı-ayrı 
şöbələrinə daxil olarsa, şöbənin adını və hər bir şöbəyə çatacaq 
komplektin sayını müəyyən etmək lazımdır. 

 
Şək. 7. 

Nəşrə abunə müddətini uzatmaq və ya dəyişmək üçün ilk 
öncə axtarış vasitələrinin köməyilə nəşri bazadan axtarıb, qeyd 
etmək və Servis (Сервис) menyusunun Düzəliş (Корректи-
ровка) əmrini yerinə yetirmək lazımdır və açılan 
Avtomatlaşmış İşçi Yerinin Növbəti müddət üçün sifariş (Заказ 
на очередной период) işçi vərəqinin Abunə müddəti (Период 
подписки) sahəsində açılan siyahıdan yeni abunə müddətini 
müəyyən etmək lazımdır. Abunəni dayandırmaq üçün isə nəşri 
qeyd etmək və Rejim alətlər panelinin  alətini sıxmaq 
kifayətdir. 

Avtomatlaşmış İşçi Yeri bir neçə dövri nəşrə qrup 
şəklində abunə yazılışını uzatmağı təmin edir. Bunun üçün 
nəşrləri axtarış aparatı vasitəsilə tapmaq və qeyd etmək 
lazımdır. Bundan sonra Rejim (Rejim) menyusunun Qrup 
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şəklində abunə (Групповая подписка) əmrini yerinə 
yetirmək və açılan Qrup şəklində abunə (Групповая подписка) 
işçi vərəqində abunə müddətini müəyyən etmək lazımdır. 

«Komplektləşdirici» Avtomatlaşmış İşçi Yeri çoxsaylı 
statistik hesabatların, standart sənəd formalarının yaradılmasını 
və çapını təmin edir. Statistik hesabatlar ədəbiyyat satışı, 
ədəbiyyat və dövri mətbuat yayımı müəssisələrinə, əsas mətnin 
dilinə, dövri və qeyri-dövri nəşrlərin tipinə, bazaya daxil 
olunma tarixinə,  komplektləşdiricinin və  kataloqlaşdırıcının 
soyadına, adına və atasının adına görə təhlil əsasında yaradılır. 
Statistik hesabatları hazırlamaq üçün Servis (Сервис) 
menyusunun Statistika (Статистика) əmrini yerinə yetirmək 
və açılan Statistika dialoq pəncərəsində yazılar diapazonunu 
müəyyən etmək,  Fayl (Файл) və ya Kağız (Бумага) 
variantlarından birini seçmək və Yerinə yetirmək (Выполнить) 
düyməsini sıxmaq lazımdır (şək. 8). Kağız (Бумага) variantını 
seçdikdə hesabat kağız üzərində çap olunacaq, Fayl (Файл) 
variantını seçdikdə isə açılan dialoq pəncərəsində faylın adını 
müəyyən etmək və Save (Сохранить) düyməsini sıxmaq 
lazımdır. Bundan sonra hesabat RTF faylı şəklində MS Word 
proqramının sənəd pəncərəsində əks olunacaq. 

 
Şək. 8. 
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Standart sənəd formaları ədəbiyyatın sifarişi, daxil 
olması, silinməsi və abunə texnoloji əməliyyatlarına uyğun 
hazırlandığından ilk öncə Məsələlər alətlər panelinin texnoloji 

əməliyyata uyğun alətini sıxmaq və Servis alətlər panelinin  
düyməsini sıxmaq lazımdır1. Bu zaman açılan pəncərədə (şək. 
9) yazılar diapazonunu müəyyən etmək,  Fayl (Файл) və ya 
Kağız (Бумага) variantlarından birini seçmək və Yerinə 
yetirmək (Выполнить) düyməsini sıxmaq lazımdır. Daha sonra 
açılan növbəti pəncərədə çap parametrini müəyyən etmək 
lazımdır2. 

 
Şək. 9. 

                                                 
1 Avtomatlaşmış İşçi Yerinin hazırladığı 
sənəd formalarının adı kitaba əlavədə 
cədvəl 1-də  verilmişdir.  
2 Əgər Fayl (Fayl) variantı seçilibsə, əlavə 
olaraq açılan dialoq pəncərəsində faylın 
adını müəyyən etmək və Save (Soxranitğ) 
düyməsini sıxmaq lazımdır. 
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§1.8.  Abonement xidmətinin kompüterləş-dirilməsi 

Abonement xidməti kitabxanada yerinə yetirilən əsas 
texnoloji əməliyyatlardan hesab edilir. Bu xidməti 
avtomatlaşdırmadan oxuculara yüksək keyfiyyətli   xidmətdən 
danışmaq olmaz.  Belə ki, abonement xidmətini 
avtomatlaşdırmadan ədəbiyyat fondunun real uçotuna nail 
olmaq, ədəbiyyatın «hərəkətini izləmək» mümkün olmur. 
Bunun nəticəsində, Elektron kataloq sifariş olunmuş 
ədəbiyyatın kitabxanada sərbəst nüsxəsinin olması haqqında 
dəqiq məlumatı əks etdirmir. Bu səbəbdən oxucunun sifariş 
verdiyi ədəbiyyatı əldə etmək ehtimalı xeyli azalmış olur. 
Oxucu sifariş etdiyi ədəbiyyatı əldə edə bilmədikdə onun 
kitabxananın və kitabxanaçıların peşə səviyyələrinə olan inamı 
azalır və bu proses tez-tez davam etdikdə son nəticədə, 
kitabxana   öz oxucusunu itirir.  

Abonement xidmətini avtomatlaşdırmaq üçün demək olar 
ki, bütün Avtomatlaşmış Kitabxana İnformasiya Sistemlərində 
müvafiq Avtomatlaşmış İşçi Yeri nəzərdə tutulmuşdur. 
Avtomatlaşmış İşçi Yeri aşağıdakı əməliyyatların yerinə 
yetirilməsini təmin edir: 

 oxucuların qeydiyyatını; 
 ədəbiyyatın verilməsi üçün sifarişlərin növbələşməsini və 
sifarişlərin yerinə yetirilməsinin qeydiyyatını; sifariş 
olunmuş ədəbiyyatın sərbəst nüsxələri haqqında daim 
yeniləşən operativ informasiyanın əldə olunmasını; 

 oxucularda olan ədəbiyyat, əlində ədəbiyyat olan oxucular 
haqqında daim yeniləşən operativ informasiyanın 
verilməsini; 

 ədəbiyyatın qaytarılması faktının və müvafiq nüsxənin 
azad olunmasının  qeydə alınmasını; 

 oxucunun fərdi kartoçkasında ədəbiyyatın 
verilməsi/qaytarılması haqqında bütün informasiyanın 
uçotu; 
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 kitab verilişi haqqında statistik məlumatın alınmasını 
(xüsusilə, borclular, borc verilən ədəbiyyat və verilişin 
sayı statistik sorğu haqqında) təmin edir. 
İRBİS Avtomatlaşmış Kitabxana-İnformasiya Sistemində 

abonement xidmətini avtomatlaşdırmaq üçün «Kitab verilişi» 
Avtomatlaşmış İşçi Yeri nəzərdə tutulmuşdur. Avtomatlaşmış 
İşçi Yerinin interfeys pəncərəsi aşağıdakı elementlərdən 
ibarətdir (şək. 1): 

 Menyu və Cari vəziyyət sətirləri; 
 Servis, Oxucu, Sifarişlər alətlər panelləri; 
 Lüğət, Baxış üçün format siyahıları;  
 Lüğət, Oxucu, Yerinə yetirilməmiş sifarişlər işçi sahələri.  
Menyu sətrində Oxucu (Читатели), Sifarişlər (Зака-

зы), Servis (Сервис), Kömək (Помощь) menyuları yerləşir. 
Avtomatlaşmış İşçi Yerinin yerinə yetirdiyi əsas əməliyyatlar 
Oxucu (Читатели), Sifarişlər (Заказы), Servis (Сервис) 
menyularının  müvafiq əmrləri vasitəsilə yerinə yetirilir. Bu 
əməliyyatların necə yerinə yetirilməsi haqqında məlumat əldə 
etmək lazım olduqda Kömək (Помощь) menyusuna müraciət 
etmək lazımdır. Servis, Oxucu, Sifarişlər alətlər panelləri  
müvafiq menyuların  əmrlərinə uyğun alətlər toplusundan 
ibarətdir. 

 
Şək. 1. 
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Lüğət açılan siyahısından Oxucular (Читатели), Kitab 
saxlayanlar (Держатели), Verilmiş ədəbiyyat / Şifrə (Выдан-
ная литература / Шифр), Verilmiş ədəbiyyat/Ad (Выданная 
литература/ Название), Nüsxənin ştrix kodu (Штрих код 
экземпеляра)  axtarış elementlərindən biri seçilir. Seçilmiş 
axtarış elementinə uyğun olaraq Lüğət sahəsində müvafiq 
terminlər siyahısı  əks olunur.  Qeyd edilmiş1 hər bir terminə 
uyğun oxucuların ümumi rekvizitləri, verilmə/qaytarılma 
haqqında bütün məlumatlar (məsələn, ədəbiyyatın kitabxanaya 
qaytarılma və oxucuya verilmə tarixləri, istifadə müddəti, 
şifrəsi, ədəbiyyatın qısa təsviri,  nüsxəsi və ştrix kod, elektron 
kataloqun məlumatlar bazası və s.) Oxucu işçi sahəsində əks 
olunur. Oxucu işçi sahəsində əks olunan informasiyanın 
görünüşü Baxış formatı açılan siyahısının müvafiq elementləri 
ilə tənzimlənir.  

Yerinə yetirilməmiş sifarişlər sahəsi Sifarişlər 
cədvəlindən və Tam təsvir sahəsindən ibarətdir. Sifarişlər 
cədvəlinin Sərbəst nüsxə (Своб. экз), Oxucu (Читатель), 
Sifariş olunan nəşr (Заказанное издание) sütunlarında 
müvafiq olaraq sifariş olunan ədəbiyyatın kitabxanada sərbəst 
nüsxəsinin olması haqqında, sifarişçinin öxucu biletinin 
nömrəsi, ədəbiyyatın müəllifi, sərlövhəsi, şifrəsi və sifariş tarixi 
haqqında qısa məlumatlar əks olunur. Sərbəst nüsxənin Hə (Да) 
qiyməti sərbəst nüsxənin mövcudluğunu, Yox (Нет) qiyməti 
sərbəst nüsxənin yoxluğu haqqında, ??? qiyməti isə nüsxə 
haqqında məlumat olmadığını göstərir. Kursoru sifarişin 
üzərinə qoyduqda sifariş  haqqında ətraflı məlumat Tam təsvir 
sahəsində əks olunur. Tam təsvir sahəsinin  düyməsini 
sıxmaqla sifarişçinin fotoşəklinə baxmaq olar2. Sifarişlər 

                                                 
1 Termini qeyd etmək üçün kursoru onun üzərinə qoyub siçanın sol 
düyməsini iki dəfə sıxmaq lazımdır. 
2 Sifarişlər (Zakazı) menyusunun Foto (Foto) əmrini yerinə yetirməklə də 
sifarişçinin fotoşəklinə baxmaq olar. 
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siyahısını yeniləşdirmək Sifarişlər (Заказы) menyusunun 
Yeniləşdirmək (Обновить) əmrini yerinə yetirmək lazımdır. 

Qeyd edək ki, Avtomatlaşmış İşçi Yerinin interfeys 
pəncərəsinin ümumi görünüşü istifadəçi tərəfindən tənzimlənə 
bilər. Belə ki, kursoru alətlər panelinin üzərinə qoyub, siçanın 
sağ düyməsini sıxmaqla açılan kontekst menyunun Əsas 
menyu (Главное меню), Oxucu (Читатели), Sifarişlər (За-
казы), Servis (Сервис), Siyahılar (Списки) əmrləri 
vasitəsilə müvafiq olaraq, menyu sətrinin oxucu, sifarişlər, 
servis alətlər panellərinin, siyahıların, alətlər panelinin əks 
olunması tənzimlənir. Həmçinin, kursoru sahənin sərhəddinin 
üzərinə qoyub, siçan qurğusunu müvafiq istiqamətdə hərəkət 
etdirməklə  işçi sahənin ölçülərini dəyişdirmək olar. 

Oxucu kitabxanaya sifariş etdiyi ədəbiyyatı əldə etmək 
üçün abonement xidmətini göstərən kitabxanaçıya müraciət 
etdikdə, kitabxanaçı sifariş olunan ədəbiyyatın sərbəst nüsxəsi 
olduqda, onu qeyd etməli, Sifarişlər (Заказы) menysunun 
Yerinə yetirmək (Выполнить) əmrini yerinə yetirməli və ya 
Tam təsvir sahəsində yerləşən  düyməsini sıxmalıdır. Bu 
zaman açılan Cari sifarişi yerinə yetirmək (Выполнение теку-
шего заказа) dialoq pəncərəsində ehtiyac olarsa, Qaytarılma 
tarixi (Дата возврата) sahəsində kitabdan istifadə müddətini 
və ehtiyac olarsa, nəzarət talonunu çap etmək parametrini  
müəyyən edib, Yerinə yetirmək (Выполнить) düyməsini 
sıxmaq lazımdır (şək. 2).  

 
Şək. 2. 

 

 

95 

Sifariş yerinə yetirildikdə verilmiş ədəbiyyatın adı, Sifarişlər 
cədvəlindən avtomatik ləğv olunaraq,  sifarişçidə olan 
ədəbiyyat siyahısına əlavə olunur. 

Yerinə yetirilmiş sifarişlərə baxış Sifarişlər (Заказы) 
menyusunun Yerinə yetirilmiş sifarişlər (Выполненные за-
казы) əmrini yerinə yetirməklə təmin olunur. Bu zaman açılan 
eyni adlı pəncərədə yerinə yetirilmiş sifarişlərin siyahısı cədvəl 
şəklində əks olunacaqdır1. Pəncərənin sağ aşağı küncündə  
yerləşən Çap etmək (Печать) və Ləğv etmək (Удалить) 
düymələrini sıxıb, açılan müvafiq dialoq pəncərələrində 
Hamısını (Все), Qeyd olunmuşlar (Отмеченные), Qeyd 
olunmuşlardan başqa (Кроме отмеченных), Cari (Текуший) 
variantlarından birini seçməklə müvafiq olaraq bütün siyahını, 
qeyd olunmuş sifarişləri, qeyd olunmuşlar istisna olmaqla 
bütün sifarişləri, yalnız cari sifarişi ləğv etmək və ya çap etmək 
olar (şək. 3).  

   
Şək. 3. 

 
                                                 
1 Cədvəlin müvafiq sütunlarında cari sifarişi verən oxucunun ad-
identifikatoru, oxucuya verilmiş ədəbiyyatın qısa biblioqrafik təsviri, 
inventar nömrəsi və ya ştrix-kod, sifarişin verilmə və yerinə yetirilmə tarixi 
və vaxtı, nəşrin təsvir olunduğu elektron kataloqun məlumatlar bazasının adı 
və ədəbiyyatın rəf nömrəsi əks olunur. 
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Kitabxanaçı cari anda  sərbəst nüsxəsi kitabxanada 
olmayan sifarişi  Sifariş  menyusunun Ləğv etmək (Удалить) 
əmrini yerinə yetirməklə və ya Tam təsvir sahəsində yerləşən 

 düyməsini sıxmaqla sifariş siyahısından silə bilər, Sifariş  
menyusunun Çap etmək (Печать) əmrini yerinə yetirməklə və   
Tam təsvir sahəsində yerləşən  düyməsini sıxmaqla sifariş 
siyahısını çap edə bilər. Bu zaman açılan müvafiq dialoq 
pəncərəsində də Hamısını (Все), Qeyd olunmuşlar (Отмечен-
ные), Qeyd olunmuşlardan başqa (Кроме отмеченных), Cari 
(Текуший) çap parametrlərindən birini seçmək lazımdır.  

Kitabxanada sərbəst istifadə üçün nəzərdə tutulmuş 
ədəbiyyatın verilməsinin qeydiyyatı sifarişsiz elektron kataloq 
əsasında və ya kitabxananın texniki təminatı imkan verdikdə  
ştrix-kod texnologiyası vasitəsilə həyata keçirilir. Sifarişsiz 
ədəbiyyat verilişinin uçotunu aparmaq üçün oxucunu müəyyən 
etdikdən sonra Oxucu (Читатели) menyusunun Sifarişsiz 
veriliş (Выдача без заказа) əmrini yerinə yetirmək  lazımdır. 
Bu zaman açılan Sifarişsiz veriliş (Выдача без заказа) 
pəncərəsinin Lüğət (Словарь) cədvəlindən  oxucuya veriləcək 
ədəbiyyatı təyin etmək lazımdır (şək. 4). Bunun üçün 
kitabxanaçı ilk öncə Məlumatlar bazası (База данных) açılan 
siyahısından verilənlər bazasını, Lüğət açılan siyahısından isə 
axtarış parametrini müəyyən etməlidir1.  Sonra axtarış 
parametrinə müvafiq olaraq ədəbiyyatın şifrəsini, ştrix-kodunu 
və ya inventar nömrəsini, müəllifi və ya ədəbiyyatın 
sərlövhəsini Lügət (Словарь) cədvəlindən seçmək və Seçim 
(Отбор) düyməsini sıxmaq lazımdır. Bu zaman açılan Cari 
sifarişi yerinə yetirmək (Выполнение текушего заказа) dialoq 
pəncərəsində ehtiyac olarsa, Qaytarılma tarixi (Дата возвра-
та) sahəsində kitabdan istifadə müddətini və ehtiyac olarsa, 

                                                 
1 Axtarış parametri olaraq şifrə, ştrix-kod/inventar nömrə, müəllif, sərlövhə 
qəbul edilməlidir. 
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nəzarət talonunu çap etmək parametrini  müəyyən edib, Yerinə 
yetirmək (Выполнить) düyməsini sıxmaq lazımdır (şək. 2).  

 

 
Şək. 4. 

Ədəbiyyat verilişinin və qaytarılmasının ştrix-kod 
texnologiyası vasitəsilə qeydiyyatını aparmaq üçün Servis 
menyusunun Ştrix kod əsasında vermə/qaytarma (Выда-
ча/Возврат по штрих кодам) əmrini yerinə yetirmək və ya 
Servis alətlər panelinin  alətini sıxmaq lazımdır. Bu zaman 
eyniadlı pəncərə açılır (şək. 5). Kitab verilişinin qeydiyyatı 
üçün pəncərənin  Veriliş (Выдача) sahəsinin Qaytarma tarixi 
(Дата возврата) sətrinə ədəbiyyatdan istifadə müddətini1 

                                                 
1 Avtomatlaşmış İşçi Yeri ədəbiyyatdan 
istifadə üçün avtomatik olaraq 20 gün 
müəyyən edir. 
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klaviaturadan1, Oxucu (ştrix-kod) (Читатели (штрих-код)) və 
Nüsxə (ştrix-kod) (Экземпляр (штрих-код)) sətirlərinə ştrix-
kodu oxuyan skaner vasitəsilə müvafiq olaraq oxucu biletinin 
və ədəbiyyatın ştrix-kodunu daxil etdikdən sonra avtomatik 
olaraq kitab verilişinin qeydiyyatı yerinə yetirilir və bu haqda 
məlumat əks olunur.  

 
Şək. 5. 

Kitabın qaytarılmasının qeydiyyatı üçün isə pəncərənin 
Qaytarma (Возврат) sahəsinin Nüsxə (ştrix-kod) sətrinə ştrix-
kodu oxuyan skaner vasitəsilə kitabın ştrix-kodunu daxil etmək 
lazımdır. Kitabın qaytarılması haqqında məlumat  pəncərədə 
əks olunacaqdır. 

Ştrix-kod texnologiyası tətbiq olmayan  kitabxanalarda 
kitab qaytarılmasının qeydiyyatı üçün  kitabxanaçı oxucunu 
Lüğət sahəsindən təyin etdikdən sonra  Oxucu sahəsinin 
verilmə/qaytarılma cədvəlindən qaytarılan ədəbiyyatı qeyd 
etmək və Oxucu (Читатели)  menyusunun Qaytarma (Воз-
врат) əmrini yerinə yetirmək lazımdır. Əməliyyat 
müvəffəqiyyətlə yerinə yetirildikdə bu haqda məlumat 
                                                 
1 Qaytarılma tarixi təqvim aləti vasitəsilə 
də daxil oluna bilər. 
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pəncərəsi açılır  və  qaytarılan kitaba sərbəst nüsxə statusu 
mənimsədilir,   verilmə/qaytarılma cədvəlində isə «Borc 
(Долг)» sözünün əvəzinə ədəbiyyatın  qaytarılma tarixi əks 
olunur.   

«Kitab verilişi» Avtomatlaşmış İşçi Yeri həmçinin 
müəyyən səbəbə görə biblioqrafik təsviri elektron kataloqda 
olmayan ədəbiyyatın oxucuya verilişinin qeydiyyatını da təmin 
edir. Bunun üçün oxucunu məlumatlar bazasından təyin 
etdikdən sonra, Oxucu (Читатели) menyusunun Elektron 
kataloqsuz veriliş (Выдача без ЭК) əmrini yerinə yetirmək 
lazımdır. Bu zaman açılan Elektron kataloqsuz veriliş (Выдача 
без ЭК) pəncərəsində verilən ədəbiyyatın biblioqrafik 
məlumatları - məlumatı daxil edən məsul şəxs,  verilənlər 
bazası, ədəbiyyatın tipinin kodunu, sərlövhəni, müəllifləri, 
çoxcildli ədəbiyyatın nömrəsini və ya sərlövhəsini, nəşr ilini, 
həcmini, rəf şifrini, saxlanma yerini, inventar  nömrəsini, ştrix-
kodu,  nüsxənin fonda daxilolma, verilmə və qaytarılma 
tarixlərini daxil etmək  Daxil etmək (Ввод) düyməsini sıxmaq 
lazımdır (şək. 6).  

 
Şək. 6. 

Bu texnologiya vasitəsilə eyni zamanda iki texnoloji əməliyyat: 
ədəbiyyatın biblioqrafik təsvirinin hazırlanaraq  elektron 
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kataloqa daxil edilməsi və ədəbiyyat verilişinin qeydiyyatı 
yerinə yetirilir. 

Oxucuya ədəbiyyat müəyyən olunan müddətdən artıq 
tələb olunduqda, o, bu müddəti artırmaq haqqında 
kitabxanaçıya müraciət etməlidir. Kitabxanaçı isə oxucunu 
məlumatlar bazasından təyin etdikdən sonra Oxucu (Читате-
ли) menyusunun Artırmaq (Продлить) əmrini yerinə 
yetirməlidir. Bu zaman açılan eyniadlı dialoq pəncərəsinin 
Qaytarma tarixi (Дата возврата) sahəsində yeni tarixi 
müəyyən etmək və Yerinə yetirmək (Выполнить) düyməsini 
sıxmaq lazımdır. 

Avtomatlaşmış İşçi Yeri kitabxanaçıya vaxtında 
qaytarılmayan və oxucuların əlində olan ədəbiyyat haqqında 
məlumatları əldə etmək imkanı verir. Bunun nəticəsində 
kitabxanaçı intizamsız oxuculara qarşı vaxtında inzibati 
tədbirlər görmək, oxucuya sifarişin nə üçün yerinə yetirilmədiyi 
və nə vaxt yerinə yetirilə biləcəyi haqqında dəqiq məlumat 
vermək imkanı qazanır.   Qaytarılmayan və oxucuların əlində 
olan ədəbiyyat haqqında məlumat əldə etmək üçün Servis 
(Сервис) menyusunun Borclular/qaytarılmalı ədəbiyyatın 
siyahısı (Список должников/задолженной литературы) 
əmrini yerinə yetirmək lazımdır. Bu zaman açılan pəncərədə 
borclu olan oxucunun ad identifikatoru, qaytarılmamış kitabın 
verilənlər bazasında şifrəsi, qaytarılmamış kitabın qısa 
biblioqrafik təsviri, verilmə tarixi, qaytarılması nəzərdə tutulan 
tarix və s. sütunlarda cədvəldə  vaxtında qaytarılmayan və 
oxucuların əlində olan ədəbiyyat haqqında məlumatların 
siyahısı əks olunur (şək. 7). 
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Şək. 7. 

Pəncərənin  Ədəbiyyatın qaytarılmasının nəzarət tarixi 
(Контрольная дата возврата) sətri ədəbiyyatın qaytarılma 
tarixini bildirir. Yeniləşmə (Обновить)  düyməsi qaytarışın 
yerinə yetirilməsi və ya qaytarmanın nəzarət tarixinin 
dəyişdirilməsi ilə əlaqədar olaraq qaytarılmalı ədəbiyyat 
siyahısının yeniləşməsinə xidmət edir. Çap (Печать) düyməsi 
isə borclular və qaytarılacaq ədəbiyyat haqqında məlumatları 
çap etmək üçündür. 

Oxuculara xidmətin və oxucu sorğularının statistikası 
kitabxananın fəaliyyətində əsas texnoloji əməliyyatlardan 
biridir. Belə ki, kitabxananın fəaliyyətinə qiymət vermək üçün, 
kitabxana fondunun oxucuların tələbatına uyğun 
komplektləşməsi üçün bu əməliyyatların yerinə yetirilməsi  
vacib şərtdir. Bu məqsədlə Avtomatlaşmış İşçi Yerində Servis 
(Сервис) menyusunun Statistika (Статистика) əmri nəzərdə 
tutulmuşdur.  Əmri yerinə yetirdikdə açılan pəncərədə tələb 
olunan hesabat formasını seçməklə və Yerinə yetirmək (Выпол-
нить) düyməsini sıxmaqla  verilmiş kitabların tam siyahısını, 
müəyyən müddət ərzində tələb olunan kitabların siyahısını, 
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soruşulan ədəbiyyatın statistik təhlili əsasında sənədləri 
hazırlamaq və çap etmək olar.  
 



 

 

 
 

Fəsil 2 
  
 
 
 
 
 

Kitabxanalarda elektron in-
formasiya xidmətinin təşkili 
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§2.1. Elektron sənəd göndərişi 
 

Elektron sənəd göndərişi kitabxanalararası abonement 
xidmətinə alternativ xidmət kimi yaradılmışdır. Bu xidmət 
növü kağız üzərində maddiləşmiş informasiyaların elektron 
obrazının sifarişçiyə - kitabxanalara və oxuculara çatdırılmasını 
təmin edir. Onun vasitəsilə kitabxanalar operativ tammətnli in-
formasiya mübadiləsi edir, oxucular isə öz informasiya 
tələbatını uzaq məsafədən ödəyə bilirlər. Elektron sənəd 
göndərişi  ödənişli xidmət növüdür və kitabxanaya   əlavə 
maliyyə vəsaitlərinin daxil olmasını təmin edir.  Ödənişin 
miqdarı bazar münasibətləri ilə tənzimlənir və sifarişin 
xarakterindən, göndəriş növündən asılıdır. Məsələn, ABŞ-ın 
Konqres kitabxanasında 50 səhifə üçün 20 sent tələb olunur. 
Qeyd edək ki, bu xidmətin ödənişli olması kitabxana fondunun 
daha yeni və aktual informasiya ehtiyatları ilə 
komplektləşdirilməsi üçün stimul yaradır.    

Elektron sənəd göndərişi xidməti kitabxanalarda elektron 
xidmətin ilk forması olmaqla, müasir dövrdə ən yeni informa-
siya xidməti olan elektron kitabxanaların yaradılması üçün baza 
rolu oynamışdır. Bu xidmət ilk dəfə ədəbiyyat yayımı və kitab 
ticarəti təşkilatlarında tətbiq edilmişdir. Belə ki, keçən əsrin 70-
ci illərindən başlayaraq dövri nəşrlərin qiymətlərinin kəskin 
artması üzündən bir sıra kitabxanalar dövri mətbuata abunəni 
xeyli məhdudlaşdırmaq məcburiyyətində oldular. Kitabxanalar 
artıq nəşrə tamamilə abunə olmaqdan çox oxucu sorğusuna uy-
ğun konkret məqaləni sifariş etməyə üstünlük verməyə başladı-
lar. Bu sifarişlər sayca çox olduğundan onun elektron formada 
həyata keçirilməsinə qərar verildi və bu qərarın düzgünlüyü 
qısa müddətdə özünü təsdiq etdi.   

Kitabxanalarda elektron sənəd göndərişi ilk dəfə Kali-
forniya Universitetinin kitabxanasında, Avropada isə İsveçin 
Höteburq şəhərində yerləşən  Çelmers Texniki Universitetində, 
daha sonra, 1982-ci ildə  Britaniya Milli Kitabxanasında faksla 
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həyata keçirilmişdir. CCIT standartı  ilə işləyən faks aparatı 
vasitəsilə sənəd göndərişi uğurla həyata keçirildi. Sonrakı illər 
faksmil rabitənin təkmilləşməsi ilə əlaqədar olaraq bir sıra 
ölkələrdə bu xidmət tətbiq edilməyə başladı.  Belə ki, artıq 10 
ildən sonra  Skandinav ölkələrinin 120 kitabxanasında, Qərbi 
Avropanın 5 milli kitabxanasında bu xidmət uğurla tətbiq 
edilirdi.   

Elektron sənəd göndərişi sürətli təkamül yolu keçərək, bu 
gün demək olar ki, bütün ölkələrdə uzaq məsafədən informa-
siya mübadiləsi vasitəsi kimi istifadə olunur və müasir kitabx-
analarda tətbiq edilən əsas və sərfəli xidmət növüdür. Bu gün 
elektron sənəd göndərişi müasir informasiya texnologiyaları 
böyük və sürətli  informasiya ötürmə qabiliyyətli telekommu-
nikasiya vasitələri əsasında fəaliyyət göstərən xidmət növüdür. 
Elektron sənəd göndərişi böyük texniki təminat tələb etmir. Bu 
xidməti kitabxanalarda təşkil etmək üçün  İnternetə qoşulmuş 
kompüter, faks-modem, telefon rabitəsi, skaner, printerin ol-
ması kifayətdir. 

Elektron sənəd göndərişi xidməti ardıcıl yerinə yetirilən 
aşağıdakı texnoloji proseslər sistemindən ibarətdir: 

1. Sənədin axtarışı və sifarişi. 
2. Ödənişin həyata keçirilməsi. 
3. Sənədin elektron obrazının hazırlanması.  
4. Sifarişin  göndərilməsi. 

Bu texnoloji proseslər xüsusi proqram vasitələrilə yerinə 
yetirilir. Əksər ölkələrdə, elektron sənəd mübadiləsi Ariel 
proqramı əsasında yerinə yetirilir. Ariel proqramı kağız 
üzərindəki sənədin elektron obrazının digər Ariel stansiyasına 
və «patrona» çatdırılmasını təmin edir. Qeyd edək ki, Ariel 
stansiyası dünyanın müxtəlif nöqtələrində yerləşmiş  Ariel 
proqramı yüklənmiş kompüterlər, «patron» isə digər 
informasiya sifarişçiləridir. Tələb olunan sənəd elektron poçtla  
sifariş olunur. Sifarişçi ödənişi həyata keçirdikdən sonra 
sənədin elektron obrazı Ariel stansiyasına İnternetin FTP 
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xidməti vasitəsilə, «patrona» isə elektron poçt vasitəsilə 
çatdırılır. Proqram göndərilən və digər Ariel stansiyalarından 
göndərilmiş sənədləri gələcəkdə  təkrar istifadə  etmək üçün 
arxivdə və lokal şəbəkə vasitəsilə  istifadəsini təmin etmək 
üçün verilənlər bazasında saxlamaq imkanına malikdir.  

Son illərdə elektron sifariş xidməti müasir Web 
texnologiya, İnternet və telekommunikasiya proqramları 
vasitəsilə yerinə yetirilir. Ədəbiyyatın axtarışı, sifarişi dinamik 
Web sayt əsasında yerinə yetirilir. Dinamik saytlar «klient-
server» arxitekturası əsasında fəaliyyət göstərir.  Belə ki, klient 
kimi Web brauzer (məsələn, İnternet Explorer, Opera və s.), 
server kimi Web server və verilənlər bazası serveri çıxış edir. 
Brauzer vasitəsilə istifadəçinin göndərdiyi məlumatı (məsələn, 
axtarış parametrlərini, istifadəçinin qeydiyyat məlumatlarını və 
s.) Web server təhlil edərək, server əlavəsinə ötürür. Server 
əlavəsi göndərilmiş məlumat əsasında verilənlər bazası 
serverində axtarış və verilənlər üzərində nəzərdə tutulmuş  
əməliyyatları yerinə yetirir. Sonrakı addımda server əlavəsi 
aparılmış əməliyyatların nəticəsini brauzerin qəbul etdiyi 
formata çevirib Web serverə, o isə öz növbəsində Web brauzerə 
göndərir. Bu səbəbdən dinamik saytlar mütləq, istifadəçinin 
informasiyasını Web serverə çatdıracaq forma ilə təchiz edilmiş 
Web səhifəyə və  bu informasiya  əsasında verilənlər bazasında 
əməliyyat aparan və  nəticəni istifadəçiyə çatdıran server 
əlavəsinə malik olmalıdır. Bu gün server əlavəsi əsasən, CGI, 
ASP, PHP texnologiyaları tətbiq edilməklə yaradılır. CGİ 
texnologiyasının əsas üstünlüyü onun klient proqram 
təminatından asılı olmamasıdır. Bu texnologiyanı praktiki 
olaraq, istənilən  versiyalı brauzerlər qəbul edir. Lakin, CGI 
texnologiyası kompüterin sistem resurslarına cox tələbkardır. 
Proqram təminatı bazarında təklif olunan CGI tipli server 
əlavələrinin əksəriyyəti kompilyasiya olunmuş proqram 
modullarından- exe genişlənməsinə malik fayllardan  ibarətdir. 
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CGİ texnologiyası əsasında yaradılan dinamik sayt aşağıdakı 
prinsip əsasında fəaliyyət göstərir: 

• Web səhifə istifadəçinin informasiyası ilə yanaşı, veri-
lənlər bazasında əməliyyat aparmaq üçün müvafiq CGI 
əlavəsinin adını Web serverə göndərir.  

• Web server öz növbəsində həmin adda CGI əlavəsinin 
icra olunmasını təmin edir.  

• CGI əlavəsi verilənlər bazası serverində müəyyən 
əməliyyatlar apararaq yekun Web səhifəni Web  serverə  
qaytarır.  
ASP (Active Server Pages; serverin aktiv səhifələri) tex-

nologiyası «MicroSoft» firması tərəfindən yaradılmışdır. Web 
səhifəni ASP texnologiyasının tətbiqi ilə interaktiv etmək üçün 
Web səhifədən  makrodildə yazılmış skriptə1 müraciət etmək  
lazımdır. Skript bilavasitə serverdə yerləşir və interpretasiya 
olunur. Məhz bundan sonra istifadəçi brauzerinə ASP skriptinin 
işinin nəticələri ilə birlikdə artıq hazır HTML-sənədi göndərilir. 
Ona görə də haqlı olaraq qeyd edilir ki, ASP texnologiyasını 
tətbiq etmək üçün istifadəçi kompüterində hansı proqram 
təminatının olmasının heç bir mənası yoxdur. Ancaq ASP-nin 
istifadə olunacağı Web serverin tipinin müəyyənləşdirilməsinin 
böyük əhəmiyyəti vardır. Belə ki, onların heç də hamısı bu tex-
nologiyanı qəbul etmir. 

PHP  texnologiyası da Web səhifədə yerləşdirilmiş skriptə 
müraciət əsasında fəaliyyət göstərir. Skript PHP (Personal 
Home Page tools)2 dilində hazırlanmış xüsusi proqram kodudur 
və   serverdə yerləşən Web  əlavəyə-HTML sənədinə alt pro-
qram kimi daxil edilir. Brauzer vasitəsilə skriptə müraciət 
olduqda, kod interpretasiya olunur. Məhz bundan sonra 
istifadəçi brauzerinə PHP ssenarisinin işinin nəticələri ilə 
birlikdə artıq hazır HTML-sənədi göndərilir. Qeyd edək ki, bu 

                                                 
1 Java Script və Vbasic Script dilində yazılır. 
2 PHP PERL-i xatırladan  interpretasiya dilidir. 
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texnologiya, əsasən MySQL bazasından informasiyanın 
istifadəçiyə çatdırılması üçün geniş tətbiq olunur. 

Ödənişi həyata keçirmək üçün istifadəçi bank vasitəsilə 
kitabxananın hesabına tələb olunan məbləği  keçirməli və ya 
depozit açmalıdır. Bir sıra kitabxanalarda bu «elektron pul» 
formasında Visa Master kartları vasitəsilə həyata keçirilir.  

Sənədin elektron formasının hazırlanması skanerləş-
dirilmə vasitəsilə həyata keçirilir. Skanerləşdirmə minimum 
300 dpi keyfiyyətlə həyata keçirilir. Skanerləşdirmə üçün 
qrafiki redaktorlardan istifadə etmək olar. İnformasiya JPEC, 
TIF formatında saxlanılır. Son vaxtlar daha çox PDF formatın-
dan istifadə olunur. Bu formatlı sənədi İnternet vasitəsilə dün-
yanın istənilən nöqtəsində açmaq mümkündür. PDF formatı 
Adobe Acrobat proqramı vasitəsilə yaradılır. Proqram həmçinin 
sənədin təhlükəsizliyini, avtomatik mündəricat yaradılmasını 
təmin edir. Sənədi sifarişçiyə elektron poçt, FTP xidməti 
vasitəsilə göndərmək və ya ümumi istifadə üçün Web serverdə 
yerləşdirməklə çatdırmaq olar. 

Bakı Dövlət Universitetinin Elmi kitabxanasında elek-
tron sənəd göndərişi xidməti Web texnologiya əsasında yerinə 
yetirilir. Elektron kataloq CGI texnologiyası əsasında hazır-
lanmışdır və  kitabxananın elektron biblioqrafik məlumat ba-
zasında on-line axtarışı təmin edir1.  Kataloqun ana səhifəsində 
istifadəçi  öz sorğusunu formalaşdırır, yəni axtarış üçün zəruri 
məlumatları daxil edir. Axtar düyməsini sıxdıqda bu 
məlumatlar və CGI əlavəsinin ünvanı Web serverə göndərilir. 
Nəticədə, OPAC Servlet.exe əlavəsi yerinə yetirilərək, oxucu 
sorğusuna uyğun ədəbiyyatların biblioqrafik məlumatlar siya-
hısı OPAC ResultSimp.html səhifəsi vasitəsilə oxucuya çat-
dırılır. Oxucu ədəbiyyatı sifariş vermək üçün OPAC Re-
sultSimp.html səhifəsində onun biblioqrafik məlumatlarını si-
yahıdan seçməli, özünün qeydiyyat nömrəsini daxil etməli və 
                                                 
1http://www.bsu.az/lib/cgi1/marc/opacform.html unvanlı sayta müraciət 
etməklə oxucular  elektron kataloqdan istifadə edə bilərlər.  
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Sifariş düyməsini sıxmalıdır. Bu zaman Zakaz.asp server 
əlavəsi avtomatik cari sifarişi kitabxananın verilənlər bazasına 
əlavə edir. Kitabxanada «Elektron sənəd göndərişi» Avtomat-
laşmış İşçi Yeri vasitəsilə sifarişlər təhlil olunur və yerinə 
yetirilməsi mümkün olan sifarişlər istifadəçiyə elektron poçt 
vasitəsilə çatdırılır.   

İndi isə xaricdə tətbiq olunan bir sıra elektron sənəd 
göndərişi sistemləri ilə tanış olaq: 

1) The Un Cover Document Delivery Service ameri-
kan sistemi olub, 18 min adda müxtəlif ingilis dilli dövri 
mətbuatda nəşr olunmuş, 9 milyondan artıq məqalələrdən ibarət 
elektron məlumat bazası əsasında  sənəd axtarışını və  
göndərişini təmin edir. Sənəd göndərişi 24-48 saat müddətində 
Ariel proqramı, faksla həyata keçirilir və ödənişin orta qiyməti 
10$-15$-dır. Sistem açar sözlərə, müəllif və ya sərlövhəyə, 
predmet rubrikasına, mövzuya, nəşr tarixinə, serial indekslərə 
görə (məsələn, İSNN) sənəd axtarışını təmin edir. Tapılmış 
sənəd əsasında oxucuya sifariş forması və qiymət təklif olunur. 

2) British Library Document Supply Center (DSC) 
sistemi Britaniya  kitabxanasının sənəd göndəriş mərkəzində 
tətbiq olunur və insan fəaliyyətinin bütün sahələrinə aid 
müxtəlif ölkələrdə və müxtəlif dillərdə nəşr olunmuş informa-
siya ehtiyatları əsasında sənəd göndərişini təmin edir. Elektron 
ehtiyatların axtarışı xüsüsi Web əlavə – OPAC modulu 
vasitəsilə həyata keçirilir. Sistem sifariş olunmuş elektron 
sənədi 2 saat müddətində sifarişçiyə çatdırır. 

 3) «ИНИОН» elektron sənəd göndəriş sistemi Rusiya 
EA kitabxanasında 1996-cı ildən tətbiq olunur1. Sənəd 

                                                 
1 Rusiya Federasiyasında elektron sənəd 
göndərişi xidməti 90-cı illərin ortaların-
dan başlayaraq həyata keçirilir. Bu xidmət 
ilk dəfə Moskva Maşınqayırma İnstitutunda, 
tələbələrin Nyu-York Universitetində dis-

 

 

115 

göndərişi ilk vaxtlar elektron poçt, hal-hazırda isə FTP xidməti 
vasitəsilə həyata keçirilir. Oxuculara göndərilən sənədlərin 
surəti həmçinin Web serverlərdə toplanılır və təkrar sifariş 
olduqda oxucular onu Web brauzer vasitəsilə əldə edə bilər. 
Elektron sənədlər əsasən PDF formatı və istifadəçinin 
istəyindən asılı olaraq RTF və TİF formatında çatdırıla bilər. 
Sifariş xüsusi qeydiyyat forması vasitəsilə verilir. Ödəniş 
abonement ödənişi,  köçürmə və elektron «pul» vasitəsilə 
yerinə yetirilir. 

4) Русский курьерь elektron sənəd göndəriş sistemi 
1998-ci ildə yaradılmış və 100 ölkənin 2500 kitabxanasının 
elektron kataloqu vasitəsilə sənəd axtarışını, kitab, məqalə av-
toreferatların elektron surətinin oxuculara və Rusiya və xarici 
ölkə kitabxanalarına göndərişini həyata keçirir. Sistem sənədin 
müəllifə, sərlövhəyə, nəşr yerinə və tarixinə, mövzuya görə ax-
tarışını təmin edir. Sifariş olunan sənəd «səbətə» daxil olunur. 
«Səbətdəki» məlumatlar avtomatik olaraq sifariş formasına 
əlavə olunur. Sifarişçi bu formada əlavə olaraq elektron sənədin 
tipini, göndəriş və ödəniş formasını müəyyən etməlidir. Sənəd 
göndərişi elektron poçt, FTP, faks, adi poçt, kuryer xidmətləri 
və Ariel proqramı vasitəsilə həyata keçirilir. Ödəniş, elektron 
ödəmə sistemi, kredit kart, bank hesabı və s. vasitəsilə həyata 
keçirilir. 

§2.2. Faksla elektron sənəd göndərişinin təşkili  

Bir sıra kitabxanalarda elektron sənəd göndərişi xidməti 
əsasən faksmil rabitəsi əsasında həyata keçirilir.  Faksmil 
rabitəsi rahat və ucuz rabitə növüdür. Xüsusilə şəhər və ölkə 
daxilində elektron sənəd göndərişi üçün səmərəlidir. Əvvəllər 
faksmil rabitəsi yalnız faks aparatı vasitəsilə yerinə yetirilirdi. 
                                                                                                        
tan təhsil alması üçün Ariel proqramından 
istifadə etməklə tətbiq  edilmişdir. 
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Lakin sonradan mükəmməl faks - modemlərin istehsalı və 
xüsusi faks mübadiləsi proqramlarının hazırlanması faks aparatı 
olmadan faksmil sənədlərin kompüter vasitəsilə göndərişini və 
qəbulunu təmin etdi. Bununla istifadəçilər bir sıra «yardımçı» 
əməliyyatların yerinə yetirilməsindən və məhdudiyyətdən azad 
oldular. Məsələn, əvvəllər hazır elektron sənədi sifarişçiyə 
göndərmək üçün onu faks aparatının qəbul etdiyi standart 
ölçülü vərəqlərdə çap etmək və hər bir vərəqi faks aparatı 
vasitəsilə göndərmək lazım gəlirdi. Hal-hazırda bu işlərin 
görülməsinə ehtiyac qalmır, istifadəçi sənədi istənilən ölçüdə 
sifarişçiyə göndərə bilər. 

Bu gün faksmil sənədlərin göndərişi üçün çoxsaylı pro-
qramlar yaradılmışdır. Bu proqramlara misal olaraq Symantec 
WinFax PRO, TalkWorks PRO, VentaFax, HotFax, FaxAmatic, 
FaxTalk Mesenger PRO, Interfax deluxe  və s. göstərmək olar. 
Bunlardan biri ilə - VentaFax proqramının iş prinsipi ilə tanış 
olaq.  

VentaFax sadə və rahat qrafiki işçi interfeysinə malik fak-
smil sənədlərin mübadiləsini təmin edən proqramdır. Proqram 
ilk dəfə yükləndikdə  Parametrlərin tənzimlənməsi (Настрой-
ка параметров) adlı dialoq pəncərəsi açılır (şək. 1).  

 
Şək. 1. 
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Bu pəncərədə istifadəçi proqramın və faks-modemin tən-
zimləmə parametrləri ilə tanış ola bilər və ya onları dəyişə bilər. 
Məsələn, istifadəçi qəbul olunan faksmil sənədinin avtomatik 
çap olunma rejimini, proqram pəncərəsinin fonunun rəngini və 
s. parametrləri dəyişə bilər. Parametrlərin tənzimlənməsi (На-
стройка параметров) pəncərəsinin OK düyməsini sıxdıqda 
proqramın əsas interfeys pəncərəsi açılır (şək. 2). İnterfeys 
pəncərəsi başlıq və menyu sətirlərindən, alətlər panelindən və 
şaquli istiqamətdə iki sahəyə bölünmüş işçi sahədən ibarətdir. 
Sol hissədə ağacvari formada  Sorğu kitabçası (Справочники), 
Jurnal (Журнал), Tapşırııqlar Siyahısı (Расписание) əlavə 
göstəriciləri, sağ hissədə isə «faks-aparatı» əks olunur. «Faks-
aparatı» vasitəsilə digər abonentə zəng etmək, sənəd 
göndərmək, zəngləri, faksmil sənədini qəbul etmək 
əməliyyatları yerinə yetirilir, zəng edən şəxsin telefon 
nömrəsinin avtomatik təyin olunması, zəng edən şəxsə 
avtomatik cavabvermə rejimləri müəyyən olunur. 

 
Şək. 2. 
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Göndərilmiş faksmil sənəd iki rejimdə: avtomatik və 
istifadəçi rejimlərində qəbul edilir. Avtomatik rejimdə 
göndərilmiş faksmil sənədlərini qəbul etmək üçün faks 
aparatının Auto düyməsinin sağında yerləşən indikator «yanar» 
vəziyyətdə olmalıdır. Əks halda  Auto düyməsini sıxmaqla  
avtomatik rejimi müəyyən etmək lazımdır. Avtomatik rejimdə 
sənəd daxil olduqda, bu barədə modemin siqnalından sonra 
faksmil sənədinin «qəbul» edilməsi prosesi pəncərənin sağ 
hissəsində əyani şəkildə əks olunur. Faks-aparatının 
informasiya sahəsində isə faksmil sənədin səhifələrinin sayı, 
daxil olduğu tarix və vaxt əks olunur. Sənəd tam qəbul 
edildikdə o, Məlumat meneceri (Менеджер сообщений) 
əlavəsinin işçi sahəsində əks olunacaqdır (şək. 3). 

 
Şək. 3. 

İstifadəçi burada daxil olmuş sənədin səhifələrinə müxtəlif 
miqyasda - 90, 180, 270 dərəcə bucaq altında fırladaraq baxa 
bilər, digər sifarişçiyə göndərə bilər, redaktə və  çap edə bilər. 
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Belə ki, səhifənin müxtəlif miqyasda görünüşü alətlər panelinin 
 və alətləri vasitəsilə, səhifənin 

fırladılması isə  aləti vasitəsilə təmin olunur. İstifadəçi 
Fayl (Файл) menyusunun Çap (Печать) əmrini yerinə ye-
tirməklə göndərilmiş sənədi tamamilə, qeyd olunmuş sənəd 
hissəsini və ya sənədin konkret səhifələrini bir və bir neçə 
nüsxədə çap edə bilər. Redaktə (Правка) menyusunun 
Redaktə etmək (Редактировать) əmrini yerinə yetirməklə 
isə cari səhifə üzərində  redaktə işi apara bilər. Daxil olmuş 

sənədi  digər sifarişçiyə göndərmək üçün  düyməsini 
sıxmaq və ardıcıl olaraq açılan Məlumatın göndərilməsi (Пере-
дача сообщений) ustasının pəncərələrində göndəriləcək sə-
hifələri, göndərmə rejimini, sifarişçinin məlumatlarını daxil 
etmək lazımdır1. 

Qeyd edək ki, eyni qaydada Məlumat meneceri (Ме-
неджер сообщений)  əlavəsi vasitəsilə sifarişçiyə göndərilmiş 
sənədlərin səhifələrinə müxtəlif görünüşdə  baxmaq, redaktə 
etmək, digər sifarişçiyə göndərmək və çap etmək olar. 

İstifadəçi rejimində2 göndərilmiş faksmil sənədini qəbul 
etmək üçün istifadəçi faksmil sənədin daxil olduğu haqda 
siqnalı eşitdikdə aparatın üzərindəki Start düyməsini sıxmaqla 
sənədin qəbul olunmasını təmin etməlidir. Bu halda da faksmil 
sənədinin «qəbul» edilməsi prosesi pəncərənin sağ hissəsində 
əyani şəkildə əks olunur və sənəd qəbulu bitdikdən sonra 
göndərilmiş sənəd Məlumat meneceri (Менеджер сообщений)  
əlavəsinin işçi sahəsində əks olunacaqdır.  

Sifarişçiyə sənədi faksla göndərmək üçün onu ilk 
növbədə faksmil sənədinə çevirmək lazımdır. Bu əməliyyat 
                                                 
1 Sənəd göndərişi aşağıda şərh olunmuşdur. 
2 Avtomatik rejimdən istifadəçi rejiminə 
keçmək üçün təkrar Auto düyməsini sıxmaqla 
rejim indikatorunun «sönmüş» vəziyyətdə 
olmasına nail olmaq lazımdır 
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virtual VentaFax printeri vasitəsilə həyata keçirilir. Belə ki, 
sənədi faksmil sənədinə çevirmək üçün ilk öncə göndəriləcək 
sənədi açmaq və Fayl (Файл, File) menyusunun Çap (Пе-
чать, Print) əmrini yerinə yetirmək lazımdır. Sonra açılan Çap 
(Печать, Print)  dialoq pəncərəsində çap qurğusu olaraq 
siyahıdan VentaFax printerini və çap parametrlərini: sənədin 
faksla göndəriləcək səhifələrini, nüsxələrin sayını və s.1 
müəyyən etmək və OK düyməsini sıxmaq lazımdır. Sənəd 
faksmil sənədinə çevrildikdən sonra avtomatik olaraq açılan 
Məlumatın göndərilməsi  (Передача сообщений) ustasının ilk 
pəncərəsində göndəriləcək səhifələri müəyyən etmək, ehtiyac 
olarsa, sənədə loqotip əlavə etmək, fonunu dəyişmək və 
Davamı (Далее) düyməsini sıxmaq lazımdır (şək. 4). 

 
Şək. 4. 

Sonrakı açılan pəncərədə göndərmə rejimlərindən birini-
Məlumatı avtomatik rejimdə, modemlə nömrəni yığmaqla 
göndərmək (Передать сообщение автоматическом  ре-
                                                 
1 Müxtəlif əlavələr üçün bu parametrlər 
müxtəlif ola bilər. 
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жиме, с набором номера модемом) və ya Məlumatı modemlə 
nömrəni yığmamaqla, qoşulmaqla göndərmək (Передать со-
общение при установленном соединении без набора номера 
модемом) seçmək və yenə Davamı (Далее) düyməsini sıxmaq 
lazımdır (şək. 5). 

 
Şək. 5. 

Birinci rejimi seçdikdə açılan növbəti pəncərədə mütləq 
sifarişçinin  faksının nömrəsini, faksmil sənəd  digər şəhərə və 
ya ölkəyə göndərildikdə isə əlavə olaraq şəhər və ya ölkənin 
kodunu daxil etmək lazımdır (şək.6). Kitabxanaçı həmçinin 
faksın çatacağı təşkilatın və şəxsin adını klaviaturadan və ya 
açılan siyahıdan daxil edə bilər.  Faksmil sənədi xarici ölkəyə 
göndərdikdə faksın düzgün oxunması məqsədilə faksın 
sərlövhəsinin dili olaraq ingilis variantını seçmək məsləhətdir. 
Bundan sonra Tamam (Готово) düyməsini sıxmaq lazımdır. 
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Şək. 6. 

İkinci göndərmə rejimini seçdikdə  sənəd avtomatik 
olaraq tapşırıqlar cədvəlinə  əlavə olunur və sifarişçi ilə əlaqə 
yaradıldıqdan sonra göndərilir. Hər iki rejimdə faksın qəbulu 
kimi göndəriş prosesi ekranda əyani şəkildə əks olunur. 

Sənədi konkret qrafik əsasında göndərmək üçün ilk öncə 
Məlumatın göndərilməsi (Передача сообщений) ustasının 
göndərmə rejiminin seçilməsi pəncərəsində göndərmə rejimi 
olaraq Avtomatik göndəriş üçün məsələlər siyahısına əlavə 
etmək (Поместить задание в расписание для автоматиче-
ской рассылки) variantını seçmək və Davamı (Далее) 
düyməsini sıxmaq lazımdır (şək. 5). Bu zaman açılan növbəti 
pəncərədə sifarişçinin faks nömrəsini daxil etmək və Davamı 
(Далее) düyməsini sıxmaq lazımdır (şək. 6). Ustanın açılan 
daha sonrakı pəncərəsində, göndərmə qrafikini və tarixini,  
ehtiyac olarsa, təkrarlanmanın sayını və sənədin «prioritet 
dərəcəsini» müəyyən etmək və Tamam (Готово)  düyməsini 
sıxmaq lazımdır (şək. 7). 
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Şək. 7. 

Bundan sonra Fayl (Файл) menyusunun Göndəriş (Рассыл-
ка) əmrini yerinə yetirmək lazımdır. 

Göndərişlərin tapşırıqlar siyahısına baxmaq üçün 
Tapşırıqlar siyahısı (Расписание) əlavəsini F10 funksional 
düyməni sıxmaqla yükləmək lazımdır. Bu zaman açılan  
proqram pəncərəsində yerinə yetiriləcək məsələlərin siyahısı 
əks olunur (şək. 8).  
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Şək. 8. 

İstifadəçi konkret məsələni siyahıdan silə bilər, digəri ilə əvəz 
edə bilər, göndərmə qrafikini dəyişə bilər, yerinə yetirilmiş 
məsələni təkrar yerinə yetirə bilər. Bunun üçün məsələni qeyd 
etmək və Tapşırıqlır (Задание) menyusunun aşağıdakı 
əmrlərindən birini müvafiq olaraq yerinə yetirmək lazımdır: 
Ləğv etmək (Удалить), Əvəz etmək (Заменить), Qrafiki 
dəyişmək (Заменить график), Təkrar yerinə yetirmək (По-
вторить выполнение). 

Proqramda abonentin məlumatlarının daxil olunmasını 
avtomatlaşdırmaq və yaddaşda saxlamaq üçün Telefon 
kitabçası (Телефонный справочник)  əlavəsi nəzərdə 
tutulmuşdur. Əlavəni yükləmək üçün Əlavə (Приложение) 
menyusunun Telefon kitabçası (Телефонный справочник) 
əmrini yerinə yetirmək lazımdır. Açılan proqram pəncərəsində 
istifadəçi telefon kitabçasında abonentlərin siyahısı ilə tanış ola 
bilər, yeni abonentin məlumatını əlavə edə bilər, qeyd olunmuş 
abonentin məlumatını ləğv və redaktə edə bilər, axtarış apara 
bilər. Yeni informasiya əlavə etmək üçün Redaktə (Правка) 
menyusunun Əlavə (Добавить) əmrini yerinə yetirmək və 
açılan dialoq pəncərəsinin müvafiq sahələrinə məlumatları 
daxil etmək və OK düyməsini sıxmaq lazımdır (şək. 9).  
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Şək. 9. 

Abonenti siyahıdan  ləğv etmək üçün onun adını siyahıdan 
tapıb qeyd etmək və Redaktə (Правка) menyusunun Ləğv 
etmək (Удалить) əmrini yerinə yetirmək lazımdır. Abonentin 
məlumatlarında dəyişiklik aparmaq lazım gəldikdə isə siyahıda 
abonentin adını qeyd etmək, Redaktə (Правка) menyusunun 
Redaktə etmək (Редактировать) əmrini yerinə yetirmək və 
açılan dialoq pəncərəsində məlumatları dəyişmək lazımdır.  
Abonentlərin sayı çox olduqda istifadəçi lazım olan abonenti 
axtarış aparmaqla tapa bilər. Bunun üçün Redaktə (Правка) 
menyusunun Axtarmaq (Найти) əmrini yerinə yetirmək 
lazımdır. Bu zaman açılan pəncərə axtarışı müxtəlif para-
metrlərə görə: soyada, təşkilata və s. aparılmasını təmin edir 
(şək. 10).  
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Şək. 10. 

Pəncərənin müvafiq sahəsinə axtarış parametrini daxil edib, 
Axtarmaq (Найти) düyməsini sıxmaq lazımdır. Axtarışın 
nəticəsi olaraq abonent siyahısında kursor tapılmış abonentin 
üzərində dayanacaq.  

Telefon kitabçasındakı informasiyanı Outlook Express 
və ya MS Outlook proqramına ixrac etmək, həmin 
proqramlardan idxal etmək olar. Bu əməliyyatlar müvafiq 
olaraq Fayl (Файл) menyusunun İxrac (Експорт) və İdxal 
(Импорт) əmrlərini yerinə yetirməklə həyata keçirilir. 

§2.3. Elektron poçtla elektron sənəd göndərişinin təşkili 

Elektron poçt kitabxanalarda geniş istifadə olunan müasir 
elektron informasiya xidmətlərindən biridir. Elektron poçt 
xidməti xüsusi poçt proqramları vasitəsilə həyata keçirilir. Bu 
gün  ən geniş istifadə olunan poçt proqramlarından biri Outlook 
Express proqramıdır. Proqramı yüklədikdə açılan proqram 
pəncərəsi  Sərlövhə, Menyu və Cari vəziyyət sətirlərindən, 
Alətlər panelindən və İşçi sahədən ibarətdir (şək. 1). 
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Şək. 1. 

 İşçi sahə dörd hissəyə bölünmüşdür: 
1. Əlaqələr paneli 
2. Qovluqlar siyahısı 
3. Tərkib sahəsi 
4. Məlumat sahəsi 

Qovluqlar siyahısında qovluqlar ağacvari formada, tərkib 
sahəsində qovluqların tərkibi, məlumat sahəsində isə 
məlumatların mətni əks olunur (şək. 2).  
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Şək. 2. 

İstifadəçinin ünvanına gəlmiş məktublara baxmaq üçün 
ilk növbədə alətlər panelinin Poçtu çatdırmaq (Send and 
Receive) düyməsini sıxmaq və ya Servis (Tools) menyusunun 
eyni adlı əmrini yerinə yetirmək lazımdır. Bu zaman 
provayderin poçt serveri ilə əlaqə yaradılır və avtomatik olaraq 
istifadəçiyə çatacaq elektron məktublar proqramın Daxil 
olunmuşlar (Inbox) qovluğuna köçürülür. Həmin qovluğu 
açdıqda Outlook Express pəncərəsinin tərkib sahəsi iki üfüqi 
hissəyə ayrılır. Yuxarı hissədə məktubun qayıdış ünvanı, 
mövzusu və göndərilmə tarixi haqqında məlumat, aşağı hissədə 
isə oxunmuş məktubun1 mətni əks olunur (şək. 2). 

Daxil olmuş məktubu oxuduqdan sonra Redaktə (Edit) 
menyusunun Ləğv etmək (Delete) əmri vasitəsilə ləğv etmək 
olar. Bu zaman o, ləğv olunmuşlar qovluğuna əlavə olunacaq. 
Məktubu oxuduqdan sonra Müəllifə cavab vermək (Reply) 
                                                 
1Məktubun yarlığı açıq konvert şəklindədirsə, o məktub oxunmuş hesab 
olunur. 
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düyməsini sıxmaqla məktuba cavab göndərmək olar1. 
Həmçinin göndərilmiş məktubu digər şəxsə göndərmək olar. 
Bunun üçün Məlumatı başqasına göndərmək (Forward) 
düyməsini sıxmaq və açılmış pəncərənin Hara (To) ünvan 
sətrində həmin şəxsin elektron poçt ünvanını yazıb Göndərmək 
(Send) düyməsini sıxmaq kifayətdir (şək. 3). Məktubu Fayl 
(File) menyusunun Çap (Print) əmri vasitəsilə çap etmək olar. 

Məktubu hazırlamaq üçün Məlumat (Message) 
menyusunun Yeni məlumat (New message) və ya İstifadə 
etməklə (New message using)əmrlərindən birini yerinə 
yetirmək lazımdır. Birinci halda məktub, boş səhifədə - blankda 
yaradılır. İstifadə etməklə (New message using) əmrini yerinə 
yetirdikdə isə əlavə olaraq məktubu müəyyən blanklarda 
yaratmaq olar (şək 3). Hər iki variantda açılmış pəncərənin 
Hara (То), Surəti (Cc),  Mövzu (Subject) sətirlərində müvafiq 
olaraq məktubun, məktubun surətinin alıcılarının ünvanları və 
məktubun mövzusu yazılır. 

 

                                                 
1 Bunun üçün açılmış pəncərənin işçi sahəsinə məktubun mətnini daxil 
etmək və Göndərmək (Send) düyməsini sıxmaq tələb olunur. 
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Şək. 3. 

Məktubun mətni klaviaturadan və ya Daxil etmə (Insert) 
menyusunun Mətn faylları (Text from file) və Daxil olunan 
fayllar (File attachment) əmrləri vasitəsilə hazır sənədlərdən 
daxil oluna bilər1. Daxil etmə menyusunun müvafiq Üfüqi xətt 
(Horizotal line), Şəkil (Picture), Hiperistinad (Hyperlink) 
əmrləri vasitəsilə məktuba üfüqi xətt, şəkil, hiperistinad daxil 
etmək olar.  

İş prosesində səhv etmək ehtimalı olduğu üçün Servis 
(Tools) menyusunda Yazılış qaydası (Spelling) və Ünvanı 
yoxlamaq (Check name) əmrləri müvafiq olaraq orfoqrafiyanı 
və ünvanın ünvan formatına uyğun olub-olmamasını 
yoxlamağa xidmət edir. Məktubu kənar şəxslərin oxumasının 
qarşısının almaq üçün Servis (Tools) menyusunun Kodlaşma 
(Encrypt) əmri vasitəsilə Rəqəmli imza ilə kodlaşdırırlar. 
Bunun üçün Rəqəmli vəsiqəyə sahib olmaq lazımdır. Rəqəmli 
imza Rəqəmli vəsiqənin tərkib hissəsi olub məktubun məhz 
məktub göndərən şəxsdən gəldiyini təsdiq edir.  

Redaktə (Edit) və Format (Format) menyuları 
məktubun mətnini redaktə etməyə və tələb olunan müəyyən 
formaya salmağa imkan verir. Redaktə (Edit) menyusunun: 
• Ləğv (Undo) və Təkrar  (Redo) əmri müvafiq olaraq 

axırıncı yerinə yetirilmiş əmrləri ləğv və təkrar edir. 
• Kəsmək (Cut) əmri qeyd olunmuş mətn fraqmentini 

kəsib, mübadilə buferində saxlayır. 
• Surətini almaq (Copy) əmri qeyd olunmuş mətn 

fraqmentinin surətini mübadilə buferində saxlayır. 
• Hiperistinadı ləğv etmək (Удалить гиперссылку, 

Remove Hyperlink) əmri qeyd olunmuş hiperistinadı 
ləğv edir. 
Format (Format) menyusunun: 

                                                 
1 Sənəd bu zaman açılmış pəncərədəki fayllar siyahısından seçilir. 
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• Stil (Style) və Şrift (Font) əmrləri uyğun olaraq mətninin 
stilini, şriftini müəyyən etməyə xidmət edir.  

• Boşluğu artırmaq (Increase Indent) əmri mətn üçün 
səhifənin solundan boş məsafəni artırır. Boşluğu 
azaltmaq (Decrease Indent) həmin əməliyyatın əksini 
yerinə yetirir. 

• Fon (Background) əmri məktubu şəkilli və ya rəngli 
səhifədə yaratmağa imkan verir.  

• Kodlaşma növü (Encoding) əmri müxtəlif əlifba 
kodlaşmasından istifadə etməyə imkan verir.  

• HTML şəklində (Rish Text HTML) və Adi mətn 
(Plain text) əmrləri məktubu HTML formatında və ya adi 
mətn sənədi kimi yaratmağa imkan verir.  

• Blank tətbiq etmək (Apply Stationery) əmri istifadə 
olunan blankı yenisi ilə əvəz etməyə imkan verir. 
Yaradılmış məktubu göndərmək üçün Fayl (File) 

menyusunun Göndərmək (Send) düyməsini və ya Sonradan 
göndərmək (Send later) əmrini yerinə yetirmək lazımdır. 
Birinci halda məktub dərhal, ikinci halda isə məktub 
Göndərilən (Outbox) qovluğunda toplanılır və Outlook 
Express proqramı ilə iş seansı bitdikdən sonra ünvan sahibinə 
göndərilir1. 

Gələcəkdə məktubun mətni lazım olarsa, onu Fayl (File) 
menyusunun Necə saxlamalı (Save as) əmri vasitəsilə 
Qaralama (Drafts) və ya digər məqsədəuyğun hesab etdiyiniz 
qovluqda saxlamaq məsləhətdir. 

§2.4. FTP xidməti vasitəsilə elektron sənəd göndərişi 

Elektron sənəd göndərişində böyük həcmli informa-
siyanın mübadiləsi üçün İnternetin FTP xidmətindən istifadə 
olunur. FTP xidməti FTP arxivlərində    toplanmış 

                                                 
1 Ünvanda səhv olduqda məktub ünvan sahibinə göndərilə bilmir. 
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informasiyanın mübadiləsini təmin edir. Bu xidmət xüsusi FTP-
klient proqramları ilə reallaşır. Bu proqramlardan biri Windows 
Commander proqramıdır. Windows Commander proqramı 
C.Ghisler&C° (İsveçrə) şirkətinin prezidenti Kristian Qisler 
tərəfindən yaradılmışdır. Proqram yükləndikdə açılan proqram 
pəncərəsi başlıq və əsas menyu sətirlərindən, alətlər  
panelindən, düymə və siyahı şəklində disk götəricilərindən, cari 
qovluq sətrindən, sağ və sol fayl panellərindən, əmr və cari 
vəziyyət sətirlərindən, funksional düymələr panelindən 
ibarətdir (şək. 1).   

 
Şək. 1. 

Qeyd edək ki, alətlər  panelinin, düymə və siyahı şəklində disk 
göstəricilərinin, cari qovluq göstəricisinin, əmr və cari vəziyyət 
sətirlərinin, funksional düymələr panelinin ekranda əks 
olunması Configration menyusunun Options əmrini yerinə 
yetirdikdə açılan Configration dialoq pəncərəsi vasitəsilə 
tənzimlənir (şək. 2).  

 

 

133 

 
Şək. 2. 

İstifadəçi həmçinin alətlər panelinin ekranda əks olunmasını və 
alətlərin sayını,  alətlərin nişanlarını öz tələbatına uyğun 
tənzimləyə bilər. Bunun üçün o,  Configration menyusunun 
Button Bar əmrini yerinə yetirməlidir. Açılan Change button 
bar dialoq pəncərəsində (şək. 3) aləti qeyd edib Delete 
düyməsini sıxmaqla aləti ləğv etmək, kursoru İcon sahəsində 
lazımı nişanın üzərinə qoyub siçan  qurğusunun sol düyməsini 
sıxmaqla qeyd olunmuş alətin nişanını dəyişmək olar. Alətlər 
panelinə yeni alət daxil etmək üçün isə ilk öncə alətin paneldə 
mövqeyini müəyyən edib, Append düyməsini sıxmaq və Com-
mand sətrində alətin yerinə yetirəcəyi əməliyyata uyğun əmri 
müəyyən etmək lazımdır. Əmr klaviaturadan, açılan siyahıdan 
və ya  düyməsini sıxmaqla açılıan  Browse dialoq pəncərəsi 
vasitəsilə Language qovluğundan seçilir. Alətlər panelində 
edilmiş  dəyişikliklərin aktiv olması üçün Change button bar 
dialoq pəncərəsinin OK düyməsini sıxmaq lazımdır. 
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Şək. 3. 

Fayl panellərində informasiya daşıyıcısının, şəbəkə ehtiyatının 
və ya FTP arxivinin fayl strukturu müxtəlif görünüşdə əks 
olunur. Bu görünüşlər Show menyusunun müvafiq əmrləri ilə 
tənzimlənir. Paneldə konkret informasiya daşıyıcısının əks 
olunması üçün  informasiya daşıyıcısına müvafiq düyməni 
sıxmaq və ya disk göstəricisi siyahısından informasiya 
daşıyıcısının adını seçmək lazımdır. Paneldə şəbəkə ehtiyatının 
əks olunması üçün  düyməsini sıxmaq və ya disk götəricisi 
siyahısından şəbəkə götəricisini-Network Neighborhood adını 
seçmək lazımdır. Bundan sonra paneldə əks olunan şəbəkə 
göstəricisi vasitəsilə şəbəkəyə daxil olub, tələb olunan  şəbəkə 
ehtiyatını seçmək lazımdır. Qeyd edək ki, paneldə İşçi stolun 
tərkibi alternativ olaraq,  Command menyusunun Open Desc-
top Folder  əmrini yerinə yetirməklə də təmin olunur.  

FTP arxivi ilə əlaqə yaratmaq üçün Net menyusunun 
FTP Connect əmrini yerinə yetirmək, açılan Connect to ftp 
server dialoq pəncərəsində müvafiq FTP arxivinə qoşulmanın 
adını qeyd edib, Connect düyməsini sıxmaq lazımdır (şək. 4). 
Qeyd edək ki, bir seans müddətində on ədəd FTP arxivinə 
qoşulmaq olar. 
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Şək. 4. 

Qoşulmanın nəticəsi növbəti açılan pəncərədə əks olunur. 
Qoşulma uğurla nəticələndikdə FTP arxivin fayl strukturu cari 
paneldə əks olunacaq. Fayl arxivinə yeni qoşulma yaratmaq  
üçün Connect to ftp server dialoq pəncərəsinin New Connection  
düyməsini sıxmaq və açılan pəncərədə qoşulmanın adını və 
arxivin ünvanını müəyyən etmək, ehtiyac olarsa,  qoşulma üçün 
istifadəçinin adını və parolu daxil etmək və OK düyməsini 
sıxmaq lazımdır (şək.5). Bu zaman yeni qoşulma qoşulma 
siyahısında  əks olunacaq.  

 
Şək. 5. 
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FTP arxivindəki informasiyanı əldə etmək üçün ilk öncə digər 
paneldə informasiyanın saxlanacağı diskin və ya qovluğun fayl 
strukturu əks olunmalıdır.  Bundan sonra arxivdəki 
informasiyanı qeyd edib, klaviaturanın və ya funksional 
düymələr panelinin F5 düyməsini sıxmaq və açılan Download 
pəncərəsində əməliyyatın yerinə yetirilməsi üçün OK 
düyməsini sıxmaq lazımdır. Bu zaman FTP arxivindən 
informasiyanın əldə olunma prosesi pəncərədə əks olunur. 
Böyük həcmli  informasiyaların FTP arxivindən əldə olunması 
zamanı  Download pəncərəsinin Download in background 
[separate thread] parametrini seçib OK düyməsini sıxmaq 
məsləhətdir. Bu zaman FTP arxivindən informasiyanın əldə 
olunma prosesi yeni pəncərədə əks olunur və istifadəçi 
informasiyanın əldə olunmasını gözləmədən digər əməliyyatları 
yerinə yetirə bilər.  

Eyniadlı informasiya cari diskdə və ya qovluqda olduqda 
bu zaman açılan ftp dialoq pəncərəsində Overwrite düyməsini 
sıxmaqla informasiyanı yeniləşdirmək,     Rename düyməsini 
sıxmaqla əldə olunan informasiyanı yeni adla saxlamaq, Cansel 
düyməsini sıxmaqla isə FTP arxivindən informasiyanın əldə 
olunma əməliyyatından imtina etmək olar (şək. 6). Əgər FTP 
arxivindən   informasiya əldə  olunma əməliyyatı müəyyən 
səbəblərdən   tam başa çatmadıqda, arxivə qoşulub 
informasiyanı təkrar əldə olunma əməliyyatını yerinə yetirmək 
və bu zaman açılan ftp dialoq pəncərəsində Resume Aborted 
download  düyməsini sıxmaq lazımdır. Bu zaman 
informasiyanın əldə olunması əməliyyatı «bərpa» olunacaqdır.   
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Şək. 6. 

İnformasiya daşıyıcısında olan informasiyanı FTP arxivinə 
əlavə etmək üçün digər paneldə göndəriləcək faylları  müəyyən 
edib, qeyd etmək və yenə də  klaviaturanın və ya funksional 
düymələr panelinin F5 düyməsini sıxmaq və açılan ftp 
pəncərəsinin OK düyməsini sıxmaq lazımdır (şək. 7).  
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Şək. 7. 

Windows Commander həmçinin bir sıra mühüm əmə-
liyyatların-informasiyanın arxivləşdirilməsini, arxivin açıl-
masını, böyük həcmli faylın informasiya daşıyıcısının tutumuna 
uyğun bölünməsini, bölünmüş faylların yenidən 
birləşdirilməsini, sənədin çap olunmasını təmin edir. Qeyd 
olunmuş informasiyanı arxivləşdirmək üçün Files menyusunun 
Pack əmrini yerinə yetirmək və açılan Pack Files pəncərəsində 
arxivin formatını və ünvanını müəyyən edib OK düyməsini 
sıxmaq lazımdır. Arxivi açmaq üçün isə onu qeyd etmək və 
Files menyusunun Unpack SpecificFiles əmrini yerinə 
yetirmək və açılan Unpack files pəncərəsində arxivdən azad 
olunacaq faylların ünvanını və formatını müəyyən edib OK 
düyməsini sıxmaq lazımdır (şək. 8). 
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Şək. 8. 

Böyük həcmli faylı informasiya daşıyıcısının tutumuna uyğun 
«bölmək» üçün faylı qeyd etmək və Files menyusunun Split 
File əmrini yerinə yetirmək lazımdır. Bundan sonra açılan 
pəncərədə açılan siyahıdan  informasiya daşıyıcısının tutumunu 
müəyyən edib OK düyməsini sıxmaq lazımdır (şək. 9). 

 
Şək. 9. 

«Bölünmüş» faylları birləşdirmək üçün onları qeyd etmək və 
Files menyusunun Combine Files əmrini yerinə yetirmək 
lazımdır. Qeyd edilmiş sənədi çap etmək üçün isə Files menyu-
sunun Print əmrini yerinə yetirmək lazımdır. 

 

§ 2.5. Ariel 1.4.1 proqramı vasitəsilə elektron sənəd 
göndərişi 

Ariel elektron sənəd göndərişi xidməti üçün hazırlanmış 
və əksər qabaqcıl Qərb ölkələrinin kitabxanalarında uğurla 
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tətbiq olunan proqramdır. Proqram kağız üzərindəki sənədin 
elektron obrazının digər Ariel stansiyasına və «patrona» çat-
dırılmasını təmin edir. Qeyd edək ki, Ariel stansiyası dünyanın 
müxtəlif nöqtələrində yerləşmiş  Ariel proqramı yüklənmiş 
kompüterlər, «patron» isə digər informasiya sifarişçiləridir. 

Kağız üzərində olan sənədi patrona və ya Ariel stansiyas-
ına göndərmək üçün ilk öncə, onu  skanerləşdirməklə elektron 
formaya çevirmək lazımdır. Bunun üçün sənədin  səhifəsini 
skanerin oxunma sahəsində yerləşdirib, Document menyu-
sunun Send əmrini yerinə yetirmək və ya  alətlər panelinin  
düyməsini sıxmaq lazımdır1. Bu zaman Scan dialoq pəncərəsi 
açılır (şək. 1). 

 
Şək. 1. 

İstifadəçi dialoq pəncərəsində skanerləşdirmə parametrlərini 
müəyyən etməlidir. Belə ki, o, Paper Size açılan siyahısından 
qrafiki obraz üçün  səhifənin ölcüsünü, Resolution açılan 
siyahısından keyfiyyət  ölçüsünü, Format siyahısından qrafiki 
                                                 
1Bu əməliyyat həmçinin kontekst menyunun 
Scan əmrini yerinə yetirməklə də həyata 
keçirilə bilər.  
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obrazın formatını (rəngli, ağ-qara və s. olmasını), Dispositon  
sahəsində isə səhifənin alınmış qrafiki obrazının Ariel 
stansiyasına, patrona göndərmək və ya arxivdə saxlamaq 
rejimlərindən birini müəyyən etməlidir. Sonra View düyməsini 
sıxmaq məsləhətdir. Bu zaman skaner işə düşərək səhifənin 
qrafiki obrazını hazırlayır və o, görünüş sahəsində əks olunur. 
Qrafiki obraz kitabxanaçını qane etmədikdə o, skanerləşdirmə 
parametrlərini dəyişib, Rescan düyməsini sıxmaqla yenidən 
səhifəni skanerləşdirə bilər. Skanerləşdirmə müvəffəqiyyətlə 
yerinə yetirildikdən sonra Scan düyməsini sıxmaq lazımdır. 
Səhifənin qrafiki obrazı Dispositon  sahəsində seçilmiş 
rejimdən asılı olaraq Send  Queue, Delivery  Queue, Received 
Queue, Archive  Queue pəncərələrində əks olunur. 

Ariel stansiyasına, patrona göndəriləcək, daxil olunmuş 
və arxivdə saxlanılmış sənədlərə baxmaq üçün müvafiq olaraq 
Send  Queue, Delivery  Queue, Received Queue, Archive  
Queue pəncərələrində sənədi qeyd etmək və Document 
menyusunun View əmrini yerinə yetirmək lazımdır. Sənədin ilk 
səhifəsi açılan  View Document dialoq pəncərəsində əks olunur 
(şək. 2).  
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Şək. 2. 

Sənədin növbəti və cari səhifədən əvvəlki səhifəyə keçid dialoq 
pəncərəsinin Next Page və Previos Page düymələri vasitəsilə 
təmin olunur. Sənədin konkret səhifəsinə keçid isə dialoq 
pəncərəsinin Go To düyməsini sıxmaqla həyata keçirilir. 
Düyməni sıxdıqda açılan  Goto Page dialoq pəncərəsində 
səhifənin nömrəsini müəyyən etmək və OK düyməsini sıxmaq 
lazımdır (şək. 3). Kitabxanaçı sənədin səhifələrinin effektiv 
görünüşünə nail olmaq üçün konkret səhifəni 90, 180 və 270 
dərəcəli bucaq altında fırlada bilər. Bunun üçün   Rotate Page 
düyməsini sıxmaq və açılan eyniadlı dialoq  pəncərəsində 
dönmə bucağını müəyyən edib, OK düyməsini sıxmaq  
kifayətdir (şək. 4). 
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         Şək. 3.                    Şək. 4. 

Bundan əlavə kitabxanaçı göndəriləcək və ya arxivdə 
saxlanılacaq sənəddə keyfiyyətsiz səhifəni digəri ilə əvəz, 
təkrar olunan və ya əhəmiyyətsiz hesab etdiyi səhifəni ləğv, 
çatışmayan səhifəni  sənədə əlavə edə və səhifədən fraqment 
kəsə bilər. Cari səhifəni başqası ilə əvəz etmək üçün yeni 
səhifəni skanerin oxuma qurğusunda yerləşdirdikdən sonra 
Replace Page düyməsini sıxmaq və açılan dialoq pəncərəsində 
(şək. 5) Scan düyməsini sıxmaqla skanerləşdirmək lazımdır. 
Skanerləşən səhifənin qrafiki obrazı Preview sahəsində əks 
olunacaqdır. Qrafiki obraz normal keyfiyyətə malik olarsa, OK 
düyməsini sıxmaqla səhifənin əvəz edilməsinə nail olmaq olar. 
Sənədə çatışmayan səhifələr daxil etmək üçün isə çatışmayan 
səhifəni skanerin oxuma qurğusunda yerləşdirdikdən sonra 
İnsert Page düyməsini sıxmaq və açılan dialoq pəncərəsində 
Scan düyməsini sıxmaqla skanerləşdirmək lazımdır.  Ska-
nerləşmə uğurla bitdikdən sonra OK düyməsini sıxmaq 
lazımdır. Sənədin təkrar olunan və ya əhəmiyyətsiz hesab 
olunan səhifəsini ləğv etmək üçün dialoq pəncərəsinin Delete 
Page düyməsini sıxmaq kifayətdir. 
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Şək. 5 

Səhifədən müəyyən fraqment kəsmək üçün dialoq pəncərəsinin 
Crop düyməsini sıxmaq və kursoru hərəkət etdirməklə 
fraqmenti müəyyən etmək lazımdır (şək. 6).  

Daxil olan sənədi çap etmək üçün isə sənədi Send Queue 
pəncərəsində qeyd etmək və Document menyusunun Print 
əmrini yerinə yetirmək lazımdır və açılan Print dialoq 
pəncərəsində çap parametrlərini müəyyən etmək və OK 
düyməsini sıxmaq lazımdır. 
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Şək. 6. 

   Send Queue və  Delivery Queue  pəncərələrindən 
sənədin göndərişini, Received Queue pəncərəsində isə çap 
olunan sənədin çapını müvəqqəti olaraq dayandırmaq üçün 
Document menyusunun Hold əmrini yerinə yetirmək lazımdır. 
Bu zaman sənəd «Helt» statusuna malik olacaqdır və «növbəyə 
qoyulacaqdır». «Növbəyə qoyulmuş» sənədi yenidən 
göndərmək və ya çap etmək üçün  Document menyusunun 
Release əmrini yerinə yetirmək və ya  düyməsini sıxmaq 
lazımdır. Bu zaman sənəd üçün «Ready» statusu müəyyən 
olacaq. 

Daxil olunmuş və göndəriş üçün nəzərdə tutulmuş 
sənədin surətini arxivdə saxlamaq üçün Document 
menyusunun Save əmrini yerinə yetirmək və ya  alətini 
sıxmaq lazımdır. Bu zaman açılan pəncərənin (şək. 7) müvafiq 
sahələrinə sənədin identikləşmə nömrəsini, faylın adını, ehtiyac 
olarsa, sənəd haqqında şərhi daxil edib OK düyməsini sıxmaq 
lazımdır. 



 

 

146

 
Şək. 7. 

Kitabxanaçı  Send və Received  pəncərələrində qeyd olunmuş 
qeyri-aktiv sənədi ləğv edə bilər. Adətən bu sənəd 
pəncərələrində müəyyən sayda sənəd saxlanılır. Bu saydan artıq 
sənəd avtomatik olaraq ləğv olunur. Sənədi ləğv etmək üçün 
Document menyusunun Delete  əmrini yerinə yetirmək 
lazımdır. Bundan əlavə Settings menyusunun Preferences 
əmrini yerinə yetirməklə açılan References pəncərəsində  Send 
and Delete və Print  and Delete parametrlərini seçməklə 
müvafiq olaraq sənədi göndərdikdən və ya çap etdikdən sonra 
avtomatik ləğv olunmasına nail olmaq olar. Bu pəncərədə 
həmçinin pəncərədə əks olunan qeyri-aktiv sənədlərin 
maksimal sayını müəyyən etmək olar (şək. 8). Həmçinin dialoq 
pəncərəsinin Limit Documents To sahələrinə Send və Received  
pəncərələrində əks olunacaq sənədlərin maksimal sayını daxil 
etmək olar. 
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Şək. 8. 

Sənədi həmçinin idxal edib stansiyaya və patrona göndərmək 
olar. Sənədi idxal edib növbəti stansiyaya göndərmək üçün ilk 
növbədə  Document → Import  → Send əmrini yerinə yetirib 
açılan pəncərədə göndəriləcək elektron sənədi informasiya 
daşıyıcısından seçmək və Open düyməsini sıxmaq lazımdır. 
Açılan növbəti  pəncərədə Document İD sahəsində sənədin 
identikləşmə nömrəsini,  To sahəsində stansiyanın İP və ya FTP 
ünvanını1 müəyyən etdikdən sonra bibliographic düyməsini 
sıxmaq və  növbəti pəncərədə sənəd üçün biblioqrafik 
məlumatları daxil etmək  lazımdır (şək. 9). 

                                                 
1İP və ya FTP ünvanlarını həmçinin Select 
düyməsini sıxmaqla siyahıdan seçmək olar. 
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Şək. 9 

Sənədi idxal edib patrona göndərmək üçün Document → 
Import → Send To Patron əmrini yerinə yetirmək və açılan 
İmport pəncərəsində göndəriləcək sənədin ünvanını müəyyən 
edib, Open düyməsini sıxmaq lazımdır. Növbəti açılan Send to 
Patron pəncərəsində patronu seçib, sənədə identifikasiya 
nömrəsi müəyyən etdikdən   sonra Bibliogkaphic düyməsini 
sıxmaqla biblioqrafic məlumatları daxil etmək lazımdır. 
Bundan sonra isə Send  düyməsini sıxmaq lazımdır (şək. 10).  

Qeyd edək ki, patron yeni şəxs olduqda pəncərənin Add 
düyməsini sıxmaqla patron haqqında informasiyanı açılan 
ünvan kitabçasının müvafiq sahələrinə daxil etmək və OK 
düyməsini sıxmaq lazımdır (şək.11). Bundan   sonra yeni 
patron patron siyahısına əlavə ediləcəkdir. Edit və Edit E-mail 
düymələrini sıxmaqla  müvafiq olaraq qeyd olunmuş patronun 
şəxsi məlumatlarını və elektron poçt ünvanını redaktə etmək 
olar 
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Şək. 10 

.  

Şək. 11. 

Göndərilmiş  sənədi kitabxanaçı digər patrona və ya Ariel 
stansiyasına göndərə bilər. Bunun üçün sənədi qeyd etmək, 
Document menyusunun Send əmrini yerinə yetirmək, açılan 
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pəncərədə yeni Ariel stansiyasının ünvanını müəyyən etmək və 
OK düyməsini sıxmaq lazımdır. Bundan sonra monitorda 
göndərilmə əməliyyatı haqqında məlumat pəncərəsi əks olunur.  

§2.6. Adobe Acrobat Professional 6.0 

Adobe Acrobat Professional 6.0 proqramı kitabxanalarda 
elektron sənəd göndərişində, elektron kitabxana ehtiyatlarının 
yaradılmasında geniş istifadə olunur. O, kağız üzərində 
maddiləşmiş informasiyaların və müxtəlif tipli elektron 
sənədlərin PDF formatına çevrilməsini təmin edir.  

Adobe Acrobat 6.0 proqramı kursoru Baş menyunun 
Proqramlar bölməsində və ya İşçi stolda yerləşən proqram 

yarlığının-  üzərinə qoyub siçan qurğusunun sol düyməsini 
iki dəfə sıxmaqla yüklənir. Bu zaman   proqramın əsas interfeys 
pəncərəsi ekranda əks olunur. İnterfeys pəncərəsi aşağıdakı 
elementlərdən təşkil edilmişdir və istifadəçi ilə proqram 
arasında əlaqəni təmin edir: (şək. 1) 

• Menyu sətri 
• Alətlər paneli 
• Sənəd pəncərəsi 
• Naviqasiya paneli 
• Kömək paneli. 
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Şək. 1. 

Menyu sətri 8 ədəd menyudan təşkil edilmişdir1. Hər bir 
menyu, menyuya daxil olduqda əks olunan əmrlər siyahısından 
ibarətdir. Proqramın yerinə yetirdiyi bütün əməliyyatlar əsasən 
bu əmrlər vasitəsilə yerinə yetirilir. Bir sıra əməliyyatlar 
alternativ olaraq müvafiq alətlər panelinin alətləri və «qızğın 
düymələr» vasitəsilə də yerinə yetirilə bilər. Menyunun 
alternativ yerinə yetirilən əmrinin adının sol tərəfində alətin 
işarəsi, sag tərəfində isə «qızğın düymə» verilmişdir. Alətlər 
paneli özündə bir sıra əsas əməliyyatları yerinə yetirən alətləri 
özündə saxlayır. Proqramda aşağıdakı alətlər panelləri nəzərdə 
tutulmuşdur: Advanced Commeting, Advanced Editing, Basic, 
Commenting, Edit, File, How To, Meeasuring, Navigation, Ro-
tate View, Tasks, Zoom.  Adətən interfeys pəncərəsində bütün 
                                                 
1 Menyu sətrinin pəncərədə əks olunması 
View→Menu Bar əmri vasitəsilə tənzimlənir. 
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alətlər panelləri deyil, yalnız istifadə olunan alətlər panelləri 
əks olunur.  Konkret alət panelinin pəncərədə əks olunması 
View → Toolbars əmrini yerinə yetirdikdə açılan alt 
menyunun alətlər panelinin adına uyğun əmrini yerinə 
yetirməklə tənzimlənir. Alətlər panelləri sürüşkən olduğuna 
görə, istifadəçi onları pəncərənin istənilən yerində yerləşdirə 
bilər.  

Yeni yaradılan, baxış və ya redaktə olunmaq üçün in-
formasiya daşıyıcılarından çağrılan sənəd, sənəd pəncərəsində 
əks olunur. Sənədin bir səhifəsindən digər səhifələrinə keçid 
naviqasiya alətlər paneli vasitəsilə həyata keçirilir.  

Sənəd pəncərəsinin və sənədin səhifələrinin görünüşü 
View menyusunun müvafiq əmrləri vasitəsilə tənzimlənir: Belə 
ki, sənəd pəncərəsi üfüqi və şaquli istiqamətdə yerləşmiş 
xətkeşlərə və şəbəkəyə malik ola bilər. Sənəd pəncərəsində 
xətkeşlərin və şəbəkənin əks olunması müvafiq olaraq View → 
Rules, View → Grid əmrləri vasitəsilə tənzimlənir. İstifadəçi 
tərəfindən müəyyən olunan müxtəlif miqyasda sənədin 
səhifələrinin görünüşünə nail olmaq olar. Buna View → Zoom 
To əmrini yerinə yetirdikdə açılan dialoq pəncərəsində müvafiq 
miqyası müəyyən etməklə nail olmaq olar (şək. 2).  

 
Şək. 2. 

Bundan əlavə View menyusunun  Actual Size və Fit 
Page əmrlərini yerinə yetirməklə müvafiq olaraq sənədin real 
görünüşünə, yalnız bir səhifənin  görünüşünə, Automaticaly 
Scroll əmrini yerinə yetirməklə isə  sənədlərin səhifələrinin oxu 
üçün avtomatik sürüşdürülməsinə nail olmaq olar. Menyunun 
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Rotate View → Clockwise və Rotate View → Counterclock 
Wise əmrləri isə sənəddə səhifələrin saat və saat əqrəbinin ək-
sinə fırlanmış formada görünüşünü  təmin edir.  

Naviqasiya paneli Bookmarks, Signatures, Layers, Page, 
Comments bölmələrindən ibarətdir və sənədin konkret yerinə 
və səhifəsinə.  sənədə daxil edilmiş qeydlərə avtomatik keçidi 
təmin edir. View → Navigation Tabs  → Open Navigation 
Panel əmrini yerinə yetirməklə naviqasiya panelinin pəncərədə 
əks olunmasına, View Navigation Tabs → Close Navigation 
Panel əmrini yerinə yetirməklə isə naviqasiya panelinin 
pəncərədən «gizlədilməsinə» nail olmaq olar. 

Kömək paneli proqramla işləmək üçün arayışdan 
istifadəni təmin edir. Paneli «gizlətmək» üçün Hide düyməsini 
sıxmaq lazımdır. 

Adobe Acrobat 6.0 sənədinin yaradılması, yaddaşda sax-
lanılması və çapı 

Yeni Adobe Acrobat 6.0 sənədini, informasiya da-
şıycısında yerləşən bir və ya bir neçə Autcad, Micrasoft Office, 
HTML fayllarını və həmçinin skanerləşdirməklə  alınan 
səhifənin qrafiki obrazını PDF formatına çevirməklə yaratmaq 
olar.  

Sənəd bir fayl əsasında yaradıldıqda, File → Create PDF 
→ From File əmrini yerinə yetirmək və açılan dialoq 
pəncərəsində faylın tipini və ünvanını müəyyən etdikdən sonra 
Open düyməsini sıxmaq lazımdır. Sənəd bir neçə fayl əsasında 
yaradıldıqda isə ilk öncə File → Create PDF → From Multi-
ple Files əmrini yerinə yetirmək və açılan Create PDF From 
Multiple Documents pəncərəsinin (şək. 3) Browse düyməsini 
sıxmaqla açılan növbəti dialoq pəncərəsində faylları müəyyən 
etmək və Add düyməsini sıxmaq lazımdır. Seçilmiş fayllar Cre-
ate PDF From Multiple Documents pəncərəsinin Files to Com-
bine sahəsində əks olunduqdan sonra isə cari pəncərənin OK 
düyməsini sıxmaq lazımdır.  
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Şək. 3. 

Sənədi, Web səhifəni PDF formatına çevirməklə 
yaratmaq üçün isə File → Create PDF From Web Page 
əmrini yerinə yetirmək və açılan Create PDF From Web Page 
dialoq pəncərəsində səhifənin URL ünvanını müəyyən etmək və 
Create düyməsini sıxmaq lazımdır. 

Səhifənin qrafiki obrazı əsasında PDF sənədinin 
yaradılması üçün səhifəni skaner qurğusunun oxunma sa-
həsində yerləşdirmək və File → Create PDF → From Scan-
ner əmrini yerinə yetirmək lazımdır. Bu zaman açılan Create 
PDF From Scanner adlı dialoq pəncərəsinin Device açılan 
siyahısından kompüterə qoşulmuş skanerin adını, Format 
açılan siyahısından isə qrafiki obrazın formatını müəyyən 
etmək və Scan düyməsini sıxmaq lazımdır (şək. 4)1. Bundan 
sonra skanerlə əlaqə yaradılır və skanerləşdirmə ustasının ilk 
pəncərəsində skanerləşdirmənin tipini və  keyfiyyətini müəyyən 
edib Scan düyməsini sıxmaq lazımdır. Bu zaman skanerləşmə 
prosesi başlayır2. Cari səhifə skanerləşdikdən sonra növbəti 
səhifəni skanerləşdirmək üçün istifadəçi onu skanerin oxuma 
sahəsində yerləşdirib, ekranda əks olunan Acrobat Scan Plug-in 

                                                 
1 Kitabxanaçı həmçinin ehtiyac olarsa 
obrazın sıxılma dərəcəsini sürüşdürücünü 
hərəkət etdirməklə dəyişə bilər. 
2 İstifadəçi skanerləşmə prosesinin gediş-
ini açılan pəncərədə izləyə bilər.  
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dialoq pəncərəsinin Next düyməsini sıxmaqla skanerləşdirmə 
işini davam etdirə bilər (şək. 4a). Bütün səhifələr 
skanerləşdikdən sonra Acrobat Scan Plug-in dialoq  
pəncərəsinin  Done düyməsini sıxmaq lazımdır. Bu zaman 
skanerləşmiş səhifələrin açılan qrafiki obrazlarından yaradılmış 
yeni PDF sənədi sənəd pəncərəsində əks olunur.  

  
               Şək. 4.                 Şək. 4a. 

Sənədi həmçinin mübadilə buferində olan informasiya 
əsasında da yaratmaq olar. Bu üsulla PDF sənədi yaratmaq 
üçün ilk öncə digər sənədlərdə müəyyən hissənin surətini 
mübadilə buferində saxlamaq lazımdır. Bundan sonra isə File 
→ Create PDF → From Clipboard Image əmrini yerinə 
yetirmək lazımdır. 

Yaradılmış PDF sənədini yaddaşda saxlamaq üçün File 
→ Save əmrini yerinə yetirmək və açılan dialoq pəncərəsində 
sənədin ünvanını müəyyən etmək lazımdır. Qeyd edək ki, bu 
əmrdən həmçinin mövcud sənəd üzərində edilmiş 
dəyişikliklərin yaddaşda saxlanılması üçün də istifadə edilir. 
Mövcud sənədin ünvanı əvvəlcədən müəyyən olunduğu üçün 
sənədin ünvanını müəyyən etməyə ehtiyac olmur və bu 
səbəbdən dialoq pəncərəsi açılmır. Sənədi həmçinin sertifikatlı 
sənəd kimi yaddaşda saxlamaq olar. Bu məqsədlə istifadəçi 
rəqəmli ID nömrəsinə malik olmalıdır. Bu üsul sənədin etibarlı 
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qorunmasını təmin edir və yalnız sertifikata malik şəxslərin 
sənəddən istifadəsini təmin edir. Elektron kitabxanalar ümumi 
istifadə üçün yaradıldığına görə bu üsuldan nadir hallarda, 
xüsusi təyinatlı elektron sənədlərin yaradılması üçün istifadə 
olunur. 

Praktikada sənəd haqqında müəyyən məlumatlar-sənədin 
müəllifi, sərlövhəsi, aid olduğu mövzu sahəsi, açar sözlər və s. 
daxil etmək tələb olunur. Bu məqsədlə File → Documenties 
Properties əmrini yerinə yetirmək və açılan dialoq 
pəncərəsinin müvafiq sahələrinə tələb olunan məlumatları daxil 
etmək lazımdır. 

Sənədi çap etməzdən əvvəl File → Print Setup əmrini 
yerinə yetirmək və açılan dialoq pəncərəsində səhifənin ölçü 
formatını (A4, A 5 və s.) və çapın istiqamətini müəyyən etmək 
lazımdır. Bundan sonra File → Print əmrini yerinə yetirib, 
açılan Print pəncərəsində çap parametrlərini - çap olunacaq 
səhifələri, nüsxələrin sayını və s. müəyyən etmək lazımdır. 
Qeyd edək ki, sənədi çap etdikdə ona əlavə edilmiş qeydlər çap 
olunmur. Qeydləri sənədlə birlikdə və ya ayrıca çap etmək üçün 
File → Print With Comments əmrini yerinə yetirmək və 
açılan Summarize Options dialoq pəncərəsində şərhin çap pa-
rametrlərini (sənədlə birlikdə və ya ayrıca çapolma parametrini, 
tarixə, müəllifə, tipinə və ya yerləşdiyi səhifənin nömrəsinə 
görə nizamlanma parametrini, şriftin  ölçü parametrini və s.) 
müəyyən etmək lazımdır (şək. 5). 
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Şək. 5. 

Sənədi həmçinin uzaq məsafədə yerləşən istifadəçiyə 
elektron poçt vasitəsilə göndərmək olar. Bunun üçün File → 
Send By Email for Review əmrini yerinə yetirmək və açılan 
dialoq pəncərəsində ünvan sahibinin ünvanını müəyyən etmək, 
ehtiyac olarsa pəncərənin Message to Reviewwers  sahəsinə 
istifadəçiyə ünvanlanmış əlavə məlumat yazmaq  və Send 
düyməsini sıxmaq lazımdır (şək. 6). 
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Şək. 6. 

 
Sənəd üzərində redaktə əməliyyatları 

PDF sənədini redaktə etmək üçün ilk öncə onu sənəd 
pəncərəsinə çağırmaq lazımdır. Bu əməliyyat File → Open 
əmrini yerinə yetirdikdə açılan dialoq pəncərəsində redaktə 
olunacaq sənədin ünvanını müəyyən etməklə yerinə yetirilir. 
Sənəd qrafiki təsvirdən və mətndən ibarət ola bilər. Mətn 
üzərində redaktə əməliyyatı aparmaq üçün ilk öncə Tools → 
Advanced Editing → TouchUp Text Tool, qrafiki təsvirlər 
üzərində redaktə əməliyyatları aparmaq üçün isə Tools → Ad-
vanced Editing → TouchUp Object Tool əmrini yerinə yetir-
mək və  müvafiq olaraq redaktə olunan mətn və qrafiki təsvir 
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sahəsini müəyyən etmək lazımdır1. Redaktə olunan mətn 
sahəsində qeyd olunmuş mətn fraqmentinin yerini dəyişmək və 
qeyd olunmuş mətn fraqmentinin surətini redaktə olunan mətn 
sahəsinin müxtəlif yerlərinə daxil etmək olar. Belə ki, Edit → 
Cut və Edit → Paste əmrlərini ardıcıl yerinə yetirməklə qeyd 
olunmuş sahənin yerini dəyişmək, Edit → Copy və Edit → 
Paste əmrlərini yerinə yetirməklə isə qeyd olunmuş sahənin 
sənəddə surətini almaq olar. Həmçinin klaviatura vasitəsilə 
mətn üzərində dəyişiklik etmək (əlavə etmək, əvəz etmək, ləğv 
etmək) olar. Qrafiki təsvir üzərində dəyişiklik etmək üçün 
təsviri qeyd edib, kontekst menyunun2 Edit İmage əmrini 
yerinə yetirmək lazımdır. Bu zaman qrafiki təsvirin formatına 
uyğun olaraq qrafiki redaktor pəncərəsində təsvir redaktə üçün 
əks olunacaqdır. Bundan əlavə sənəd üzərində aşağıdakı 
redaktə əməliyyatlarını aparmaq olar: 

1) Sənədi bütövlükdə digər sənədlərə, o cümlədən digər 
əlavələrdə hazırlanmış sənədlərə daxil etmək üçün mübadilə 
buferində saxlamaq. Bunun üçün Edit→File to Clipboard 
əmrini yerinə yetirmək lazımdır. 

2) Mətn sahəsinin qeyd olunmuş hissəsini və ya cari 
Bookmark adını  mübadilə buferində saxlamaq. Bunun üçün 
Edit→Copy əmrini yerinə yetirmək lazımdır. 

3) Mətn sahəsinin və Bookmark adının qrammatik yazılış-
ını yoxlamaq. Bunun üçün Edit→Check Spelling→In Com-
ments and Form Fields əmrini yerinə yetirmək və açılan dia-
loq pəncərəsində Start düyməsini sıxmaq lazımdır. Proqram 
«səhv» aşkar etdikdə öz lüğət bazasından sözün düzgün yazılış-
ını təklif edir. Lüğət bazasını zənginləşdirmək üçün Edit → 
Check Spelling → Edit Dictionary əmrini yerinə yetirmək 

                                                 
1 Redaktə olunan sahə, kursoru müvafiq 
istiqamətlərdə hərəkət etdirməklə ayrılır. 
2 Kontekst menyusu siçanın sağ düyməsini 
sıxdıqda ekranda əks olunur. 
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açılan dialoq pəncərəsində sözü mətn sahəsinə daxil edib Add 
düyməsini sıxmaq lazımdır. 

4) Yeni Bookmark əlavə etmək. Bookmark sənədin qeyd 
edilmiş sahəsinə avtomatik keçidi təmin edir.    Bookmark 
vasitəsilə elektron kitablarda mündəricat yaradılır. Bunun üçün 
Edit → Add Bookmark əmrini yerinə yetirmək, naviqasiya 
panelinin Bookmark bölməsində yeni yaradılmış Bookmark 
adını daxil etmək lazımdır.      Bookmark adını həmçinin 
mübadilə buferindən Edit → Paste əmri vasitəsilə daxil etmək 
olar. Çoxsərlövhəli sənəd üçün Bookmark yaratmaq üçün ardı-
cıl olaraq sərlövhəni qeyd etmək və Edit → Add Bookmark 
əmrini yerinə yetirmək kifayətdir. Edite → Delete əmrini 
yerinə yetirməklə isə cari Bookmark ləğv olunur. 

5) Cari sənəddə, informasiya daşıyıcılarında yerləşən PDF 
sənədlərində simvol və ya söz birləşmələrini axtarmaq. Bunun 
üçün Edit → Shearch əmrini yerinə yetirmək və açılan sağ 
paneldə simvolu və ya söz birləşməsini daxil edib Search 
düyməsini sıxmaq lazımdır (şək. 7). Axtarışın nəticəsi-tapılmış 
sənədlərin adı hiperistinad kimi panelin Results sahəsində əks 
olunacaq (şək. 8). Bu istinadlardan hər hansı birini  
aktivləşdirdikdə avtomatik olaraq ona uyğun sənəd açılacaq və 
kursor axtarılan simvol və ya söz birləşməsinin üzərində dura-
caq. 
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     Şək. 7.                     Şək. 8. 

6) Cari sənədə digər sənədlərdən yeni səhifə əlavə etmək, 
cari sənəddən səhifə ləğv etmək, ayırmaq, səhifəni döndərmək. 
Cari sənədə yeni səhifə əlavə etmək üçün ilk öncə Document 
→ Page → Insert əmrini yerinə yetirmək və açılan dialoq 
pəncərəsində  faylı müəyyən etdikdən sonra  Select düyməsini 
sıxmaq lazımdır (şək. 9). Bu zaman açılan növbəti pəncərədə 
daxil olunacaq səhifənin cari səhifədən əvvəl və ya sonra daxil 
olunmasını, birinci, sonuncu və ya konkret nömrəli səhifənin 
daxil olunacağını müəyyən etmək lazımdır. 
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Şək. 9. 

Sənəddən səhifə ləğv etmək üçün Document →  Page 
→ Delete əmrini yerinə yetirmək və açılan Delete Page dialoq 
pəncərəsində ləğv olunacaq səhifələrin nömrələrini müəyyən 
etmək lazımdır (şək. 10). Sənəddən səhifə ayırmaq üçün əmrini 
Document → Page → Extract yerinə yetirmək və və açılan 
Extract Page dialoq pəncərəsində ayrılacaq  səhifələri müəyyən 
etmək və ehtiyac olarsa, ayrılmış səhifələrin sənəddən ləğv 
olunması parametrini seçmək və OK düyməsini sıxmaq 
lazımdır (şək. 11). Ayrılmış səhifələr yeni sənəd formasında ek-
randa əks olunur. 
 

 
           Şək. 10.                 Şək. 11. 

Sənəddən fraqment kəsmək üçün Document → Page → Crop 
əmrini yerinə yetirmək və açılan pəncərədə səhifəni və 
kəsiləcək fraqmentin ölçüsünü müəyyən etmək lazımdır (şək. 
12). 
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Şək. 12. 

Sənəddə səhifələri 90 və 180 dərəcə  döndərmək üçün Docu-
ment → Page → Rotate əmrini yerinə yetirmək və açılan 
pəncərədə dönmə bucağını, səhifələri müəyyən etmək lazımdır 
(şək.13).  
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Şək. 13. 

Cari sənədin səhifələrini digər sənədin səhifələrilə əvəz etmək 
üçün ilk öncə Document → Page → Replace əmrini yerinə 
yetirmək və açılan dialoq pəncərəsində digər sənədi seçmək və 
Select düyməsini sıxmaq lazımdır.  Bu zaman açılan növbəti 
dialoq pəncərəsində əvəz olunacaq və əvəz edən səhifələri 
müəyyən etmək lazımdır.  

7) Sənədin səhifələrini nömrələmək, sənədə yuxarı və 
aşağı kolontitulları əlavə etmək. Bu məqsədlə Document → 
Add Headers & Footers  əmrini yerinə yetirmək və açılan 
pəncərədə kolontitulun mövqeyini, kolontitulun mətnini 
müəyyən edib, ehtiyac olarsa kolontitul üçün şrifti, sərhəddi, 
nömrə üçün stili, səhifə diapazonunu, kolontitul üçün səhifənin 
kənarlarından buraxılan boş məsafələri  müəyyən etmək və OK 
düyməsini sıxmaq lazımdır (şək.14). İstifadəçi Preview 
düyməsini sıxmaqla kolontitulun sənəddə görünüşünə baxa 
bilər. Qeyd edək ki, tək və cüt səhifələrdə fərqli kolontitullar 
daxil etmək üçün dialoq pəncərəsinin Alernation açılan siyahı-
sından müvafiq olaraq Even Pages Only və Odd  Pages Only 
parametrlərini seçmək lazımdır. 
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Şək. 14. 

8) Sənədə digər sənədlərdən fon və qoruyucu nişanlar 
əlavə etmək. Bunun üçün ilk öncə  Document → Add Wa-
termark&Background əmrini yerinə yetirmək və açılan Add 
Watermark&Background pəncərəsinin Browse düyməsini 
sıxmaqla açılan növbəti pəncərədə fon faylını  müəyyən etmək 
lazımdır. Bundan sonra pəncərədə faylın fon  kimi istifadə 
olunan səhifəsinin nömrəsini, fonun hansı səhifələr üçün 
qoyulacağını, yerləşmə formasını (mərkəzdə, sağda, solda, 
yuxarıda, aşağıda) dönmə bucağını və şəklin parlaqlığını 
müəyyən etmək lazımdır (şək. 15). 
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Şək. 15. 

9) Sənədə qeyd daxil etmək.  İstifadəçi sənəddə əks 
olunan müəyyən fikrə öz münasibətini qeyd şəklində bildirə 
bilər. Belə ki, istifadəçi sənədə mətn tipli və sənədin 
xarakterinə uyğun «ştamp» formasında qrafiki qeyd daxil edə 
bilər, mətnin müəyyən hissəsini «nişanlamaqla», sətirlərin 
altından və üzərindən xətt çəkməklə sənəddə konkret fikrə 
oxucunun diqqətini cəlb etdirə bilər. Sənədə mətn tipli qeyd 
daxil etmək üçün Document →  Add a Comment əmrini 
yerinə yetirmək və sənəddə əks olunan qeyd çərçivəsində 
qeydin mətnini daxil etmək lazımdır. Sənəddə müəyyən 
sətirləri «nişanlamaq» üçün Tools → Highligting → High-
lighter Tool əmrini, sətirlərin üzərindən xətt çəkmək üçün 
Tools → Highligting → Cross-Out Text Tool əmrini, 
sətirlərin altından xətt çəkmək üçün isə Tools → Highligting 
→ Underline Text Tool əmrini  yerinə yetirmək və kursoru sə-

 

 

167 

tirlərin üzərində hərəkət etdirmək lazımdır. Bu zaman 
nişanlanmış sətrirlər sarı fona malik olacaqdır, sətirlərin 
altından yaşıl, üzərindən isə qırmızı xətt çəkiləcək.   

Sənədə həmçinin digər sənədlərdən mətn  qeydləri idxal 
etmək olar. Bunun üçün Document → İmport əmrini yerinə 
yetirmək və açılan pəncərədə sənədi müəyyən edib Select 
düyməsini sıxmaq lazımdır. Qeydlərin sənədin hansı 
səhifələrində yerləşməsi haqqında məlumat almaq üçün Docu-
ment → Summarize Comments  əmrini yerinə yetirmək 
lazımdır. Əmr yerinə yetirildikdə «book» genişlənməsinə malik 
və özündə qeydlər haqqında məlumatları saxlayan yeni sənəd 
hazırlanır və sənəd pəncərəsində əks olunur (şək. 16). Sənədə 
daxil edilmiş bütün qeydlər Comments panelində əks olunaca-
qdır  və onun vasitəsilə avtomatik olaraq konkret qeydə keçid 
təmin olunur. 

 
Şək. 16. 
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Qeyd edək ki, cari sənədə daxil edilmiş qeydləri digər Adobe 
Acrobat sənədlərinə və MS Word sənədinə «ixrac» etmək olar. 
Bunun üçün müvafiq olaraq Document → Export Comments 
və Document → Export  Comments To Word əmrlərini 
yerinə yetirmək və açılan pəncərədə sənədin ünvanını müəyyən 
etmək lazımdır. 

10) Sənədə digər sənədlər, o cümlədən səs faylları 
birləşdirmək. Bunun üçün müvafiq olaraq Tools → Advanced 
→ Attach → Attach File Tool Add a Comment və Tools → 
Advanced → Attach → Attach Sound Tool Add a Comment 
əmrlərindən birini yerinə yetirmək və açılan dialoq 
pəncərəsində faylın ünvanını müəyyən etmək lazımdır. 
Daxiletmə əməliyyatı   qurtardıqdan sonra sənəddə göy rəngli 
«skrepka» işarəsi əks olunur. Kursoru onun üzərinə qoyub, 
siçan qurğusunun sol düyməsini sıxdıqda daxil edilmiş fayl 
açılacaqdır.  
 Sənəddə edilmiş dəyişikliklərdən imtina etmək lazım 
olduqda Fayl menyusunun Reveret əmrini yerinə yetirmək 
lazımdır. 

Proqramın əlavə imkanları 

Proqram vasitəsilə həmçinin aşağıdakı əməliyyatları 
yerinə yetirmək olar: 

 İngilis dilində olan sənədlərdə mətni «oxumaq»-səs-
ləndirmək olar. Sənədin cari səhifəsini «oxumaq» üçün View 
→ Read Out Loud → Read This Page əmrini, sənədin bütün 
səhifələrini «oxumaq» üçün isə Only View → Read Out Loud 
→ Read To End  of Document  əmrini  yerinə yetirmək 
lazımdır. 

 Sənəd skanerləşmiş səhifələrin qrafiki obrazlarından 
ibarət olduqda qrafiki obrazları mətnə  çevirmək olar. Bu halda 
qrafiki obraz ən azı 300 dpi keyfiyyətinə malik olmalıdır. Bu 
əməliyyatı yerinə yetirmək üçün Document → Paper Capture 
→ Start Capture əmrini yerinə yetirmək lazımdır. 
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 Sənəddəki şəkilləri avtomatik olaraq ayrıca rəsm faylları 
kimi yaddaşda saxlamaq olar. Bunun üçün Advanced → 
Export All İmage əmrini yerinə yetirmək və açılan dialoq 
pəncərəsində rəsm fayllarının yerləşəcəyi qovluğu müəyyən 
edib Save düyməsini sıxmaq lazımdır. 

 Sənədi  qeyri-leqal istifadədən parolla və elektron imza 
ilə qorumaq olar. Sənədi parol vasitəsilə qorumaq üçün Docu-
ment → Security → Rectrict Opening and Editing əmrini 
yerinə yetirmək və açılan pəncərədə sənədin açılması və 
redaktəsi üçün parolu müəyyən etmək lazımdır (şək. 17).  

 
Şək. 17. 

Sənədi rəqəmli imza ilə qorumaq üçün Document → Digital 
Signatures →  Sign this Document əmrini yerinə yetirmək və 
açılan dialoq pəncərələrində müvafiq parametrləri müəyyən 
etmək lazımdır. 

§2.7. Elektron kitabxanalar 
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Elektron kitabxanalar informasiyalaşmış cəmiyyət 
quruculuğunun sosial sifarişidir. Belə ki, o, informasiyalaşmış 
cəmiyyətin baza prinsiplərinə: informasiyanın əmtəəyə 
çevrilməsi, informasiya bazarının formalaşması, cəmiyyət 
üzvlərinin peşə və təhsil hazırlığının yüksəlməsinə, qlobal 
informasiya mühitinin yaranmasına xidmət edir. Elektron 
kitabxanalar oxuculara informasiya xidmətinin 
kompüterləşməsinin nəticəsi olub, bəzi şəxslərin təsəvvür etdiyi 
kimi ənənəvi kitabxanalara alternativ bir qurum deyil, yalnız 
bir xidmət növüdür. 

Elektron kitabxanalar  keçən əsrin 90-cı illərindən 
başlayaraq fəaliyyət göstərməkdədir. Bu günə kimi elektron 
kitabxanalar ciddi kəmiyyət və keyfiyyət  dəyişikliklərinə 
məruz qalmışdır. Bu dəyişiklikləri cəmiyyətdə informasiyanın 
rolunun artması, cəmiyyətin operativ informasiyaya tələbatı 
diktə etmiş və onlar informasiya texnologiyasının son 
nailiyyətlərini tətbiq etməklə həyata keçirilmişdir. Elektron 
kitabxanalar uzaq məsafədən oxuculara daha dolğun 
informasiya xidməti göstərərək, bu xidmətin zaman və 
məkandan asılılığına son qoyur. Ənənəvi kitabxanalarda 
informasiya xidməti yalnız kitabxananın iş saatı  müddətində və 
məhdud sayda oxuculara  göstərildiyi halda, elektron 
kitabxanalar sutkanın iyirmi dörd saatı müddətində fəaliyyət 
göstərir və dünyanın istənilən nöqtəsində yerləşən qeyri-
məhdud sayda oxuculara eyni zamanda xidmət edir. Elektron 
kitabxanalar rahat və sərfəli bir xidmət növüdür. Bu xidmətin 
təşkili kitabxanalara qısa müddətə və az xərc sərf etməklə 
böyük informasiya ehtiyatlarının oxucuların istifadəsinə 
verilməsini və oxucu təlabatının operativ yerinə yetirilməsini 
təmin edir.  

Elektron kitabxanalarının informasiya ehtiyatını  daha 
etibarlı mühafizə etmək  mümkündür. Elektron kitabxanalar 
çox məhdud yer - yalnız kompüterin diskində yer tutur.  
Elektron kitabxanalar  çox nüsxəli kitabların alınmasına olan 
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ehtiyacı aradan qaldırır, kitabların bərpasına və mühafizəsinə 
sərf olunan xərcləri minimuma endirir, böyük kitabxana 
sahəsindən  imtina etməyi təmin edir.  

Elektron kitabxana ümumi istifadə üçün açıq olan lokal 
və uzaq məsafədə yerləşən paylanmış informasiya ehtiyatlarına 
malik olur. Elektron kitabxanaların informasiya ehtiyatı 
rəqəmli formada hazırlanmış müxtəlif formatlı sənədlərdən 
ibarətdir. Bu sənədlərin bir qismi kitabxananın mülkiyyəti olub, 
mərkəzləşmiş formada elektron kitabxananın Web və  FTP  
serverlərində toplanır və ənənəvi ədəbiyyatın elektron 
nüsxələrindən və kitabxana tərəfindən ödənişli və ya mübadilə 
üsulu ilə alınmış elektron sənəd və nəşr  toplusundan ibarətdir. 
Onların biblioqrafik təsviri mütləq  kitabxananın elektron 
kataloquna əlavə edilməlidir.  

Uzaq məsafədə yerləşən ehtiyatlara  kitabxana tərəfindən 
lisenziya-«istifadə hüququ» əldə edilmiş tammətnli məlumat 
bazaları, arxivlər, həmçinin kitabxana tərəfindən seçilmiş, 
dəqiqliyinə və etibarlılığına zəmanət verilən  «istifadə üçün 
açıq» olan İnternet ehtiyatları aiddir. Adətən kitabxananın 
lisenziya ilə istifadə olunan informasiya ehtiyatından yalnız 
qeydiyyatdan keçən oxucular istifadə edə bilir. Qeyd edək ki, 
elektron sənəd bazaları, elektron sənəd arxivləri böyük 
informasiya ehtiyatına və mükəmməl axtarış aparatına malik 
olduğundan bu ehtiyatların  kataloqlaşmasına ehtiyac olmur. 
Məsələn, BDU-nun Elektron kitabxanası öz oxucularına 
EBSCO bazasından istifadə etməyi təmin edir. Bu istifadə  
yalnız BDU-nun lokal şəbəkəsindən və qeydiyyatdan keçmiş 
oxucular üçün nəzərdə tutulmuşdur. EBSCO bazası dünyanın 
39 ölkəsinin 4000-dən artıq jurnal və qəzet materiallarını 
saxlayan 5 müstəqil bazadan ibarətdir: 

 Academic Search Premier.  Bazada PDF faylı şəklində 
2500-dən artıq tarix, təhsil, ekologiya, beynəlxalq münasibətlər, 
tibb, siyasi və sosial elmlər və kompüter texnologiyasına aid 
jurnalların elektron nəşrləri, xülasə və referatları yerləşir. 
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 Business Source Premier. Bazada iqtisadiyyat, idarəetmə,  
menecment, marketinq, sığorta, mühasibat, bank işi, beynəlxalq 
biznesə aid 1600-dən artıq jurnal materialı, 2 milyondan artıq 
amerikan və beynəlxalq firma və kompaniyalar haqqında 
məlumatlar, dünya ölkələrinin iqtisadiyyatı haqqında icmal 
xarakterli məlumatlar toplanmışdır. 

 Public Library. Bazada 1990-cı ildən başlayaraq 1810 
jurnalın elektron mətni, 1984-cü ildən isə 2780-dən artıq 
jurnaldakı məqalələrin  referatları toplanmışdır. 

 Newspaper Source. Bazada 1800-dən artıq məşhur dövri 
nəşrlər, o cümlədən  6 000 000 məqalə saxlanılır. Həmçinin 
1965-ci ildən elmin müxtəlif sahələri üzrə elektron mətn arxivi 
vardır. 

 Medlıne.  Biologiya və tibbə aid ən məşhur məlumat 
bazasıdır. 

Açıq istifadə üçün nəzərdə tutulan informasiyalar elektron 
kitabxananın yaradıcıları-əsasən hazırlıqlı kitabxanaçılar 
tərəfindən oxucu sorğusunun təhlili və mövzunun aktuallığına 
görə İnternetdən seçilir və istifadə üçün məsləhət görülür. 
Bununla onlar bu informasiyanın dolğunluğuna və informasiya 
mənbəyinin etibarlılığına zəmanət verilir.  

İnformasiya ehtiyatlarının böyük kütləsi tam mətnli 
elektron sənədlərdir. Hazırlanma texnologiyasına görə elektron 
sənədləri iki qrupa -kağız  üzərindən konversiya olunmuş 
sənədlər və elektron nəşrlər qruplarına  bölmək olar. 
Konversiya olunmuş sənədlər çap məhsullarının elektron surəti 
olub, onları uzaq məsafədən oxuculara çatdırmaq üçün 
yaradılır. Elektron nəşrlər kütləvi istifadə üçün bilavisitə xüsusi 
proqramlar - redaktorlar vasitəsilə yaradılmış elektron 
sənədlərdir. Bunlara elektron kitablar, elektron jurnal və 
qəzetlər, seçmələr aiddir. Elektron kitabxanalar  həmçinin 
elektron cədvəllərdən, qrafiki fayllardan, rəqəmli xəritələrdən 
ibarət informasiya ehtiyatına malik ola bilər. Bu ehtiyatların 
həcmi elektron kitabxananın təyinatından asılıdır. 
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Son illər elektron kitabxanalar informasiya ehtiyatlarını 
daha çox multimedialı sənədlər əsasında komplektləşdirməyə 
üstünlük verirlər. Multimedia sənədləri özündə informasiyanın 
bütün tiplərinin: mətn, qrafika, audio, animasiya və video 
informasiyaların inteqrasiyasını təmin edir. Multimedia 
sənədləri informasiyanı oxucuya daha dolğun çatdırır və uzun 
müddət onunla tanış olan şəxsin yaddaşında qalır.   

Elektron kitabxana müasir Web texnologiyası əsasında 
fəaliyyət göstərir. Web texnologiya lokal və uzaqda yerləşmiş 
informasiya ehtiyatlarının inteqrasiyasını təmin edir. Axtarış və 
naviqasiya vasitələri onun mühüm elementidir. Məhz onun 
sayəsində oxucular kitabxananın informasiya ehtiyatlarından 
istifadə edir. Axtarış aparatı oxucu sorğusu əsasında 
informasiya ehtiyatının metaverilənlər bazasında axtarış 
aparmağı təmin edən xüsusi  moduldan ibarətdir. Naviqasiya 
elementləri isə konkret sənədə və ya sənədin konkret 
hissələrinə istinadı təmin edən hiperistinad siyahısından 
ibarətdir. 

Elektron kitabxanadan  istifadə çox sadədir. Elektron ki-
tabxana ehtiyatlarından istifadə İnternet şəbəkəsi vasitəsilə, 
xüsusi proqramlar - brauzer və  FTP klient proqramları ilə,   
müvafiq olaraq http və ftp protokolları əsasında təmin olunur. 
Kitabxanadan istifadə etmək üçün oxucudan İnternet-ə qoşul-
muş kompüter və İnternetin WWW, FTP xidmətindən istifadə 
vərdişi tələb edir. 

§2.8. Kitabxanada informasiya təhlükəsizliyi 

Kitabxananın elektron informasiya ehtiyatlarının, pro-
qram təminatının təhlükəsizliyini təmin etmədən etibarlı infor-
masiya xidməti göstərmək mümkün olmaz. İnformasiya 
təhlükəsizliyi dedikdə, təbii və ya süni xarakterli, təsadüfi və ya 
qəsdli təsirlərdən informasiyanın və kompüter sisteminin 
müdafiəsi nəzərdə tutulur. İnformasiya təhlükəsizliyinin 
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məqsədi informasiyanın tamlığına, məxfiliyinin pozulmasına, 
informasiya daşıyıcılarının sıradan çıxmasına yönəlmiş 
təhdidləri, bu təhdidlərin mənbəyini, onların realizə üsullarını 
və məqsədlərini, həmçinin təhlükəsizliyi pozan digər hal və 
hərəkətləri müəyyən etməkdir.  

Məxfiliyin pozulmasına yönəlmiş təhdidlər məxfi və ya 
gizli informasiyanın üstünün açılmasına yönəlib. Belə 
təhdidlərin reallaşması nəticəsində informasiya ondan istifadə 
etmək hüququ olmayan şəxslərə məlum olur ki, bundan da 
onlar  çox halda öz “maraqlarının” ödənilməsi üçün istifadə 
edirlər. Kompüter şəbəkəsində saxlanılan və ya rabitə kanalı ilə 
ötürülən informasiyanın tamlığının pozulmasına təhdidlər onun 
dəyişdirilməsinə və ya təhrifinə yönəlib ki, bunlar da onun 
keyfiyyətinin pozulmasına və tam məhvinə səbəb ola bilər. İn-
formasiyanın tamlığı “bədniyyətli” şəxslər tərəfindən qəsdən və 
ya sistemi əhatə edən mühit tərəfindən obyektiv təsirlər 
nəticəsində pozula bilər. Bu kitabxana üçün xüsusilə aktualdır. 
Kompüter sisteminin iş qabiliyyətinin  pozulması təhdidləri elə 
situasiyaların yaranmasına yönəlib ki, bu zaman müəyyən 
qəsdli hərəkətlər ya sistemin iş qabiliyyətini aşağı salır, ya da 
sistemin müəyyən ehtiyatlarından istifadəni mümkünsüz edir. 
Təhdidlər həmçinin vurulmuş ziyanın kəmiyyətinə görə, baş 
vermə ehtimalına görə, meydana çıxma səbəblərinə görə (təbii 
fəlakətlər, qəsdli hərəkətlər), vurulmuş ziyanın xarakterinə görə 
(maddi, mənəvi), obyektə münasibətinə görə (daxili, xarici) də 
təsnif olunur. Praktikada təhdidlərin 80 faizi daxili, yəni 
müəssisənin öz işçiləri tərəfindən və ya onların bilavasitə və ya 
dolayısı yolla iştirakı ilə baş verir. Yalnız təhdidlərin 20 faizi 
kənardan icra olunur. 

Xarici təhdidlər beynəlxalq, reqional və ya sahəvi kom-
püter şəbəkələri vasitəsilə icra olunur. Bu şəbəkələrin əsas 
xüsusiyyəti kompüterlərin böyük ərazidə  paylanmasıdır. 
Şəbəkənin konkret kompüterinə qarşı uzaq məsafədən hücum-
lara təşəbbüslər edilir. Pozucu hücum edilən obyektdən 
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minlərlə kilometr məsafədə ola bilər, bu zaman nəinki konkret 
kompüter, həmçinin şəbəkə kanalları ilə ötürülən informasiya 
hücuma məruz qala bilər. 

İnformasiya təhlükəsizliyinin təmin olunması problemi 
kompleks yanaşma tələb edir. Onun həlli üçün görülən 
tədbirləri aşağıdakı qruplara bölmək olar: 

− Qanunvericilik tədbirləri  
− İnzibati tədbirlər 
− Təşkilati tədbirlər 
− Proqram-texniki tədbirlər. 

Qanunvericilik tədbirləri hər bir ölkənin, yerli idarəetmə 
və icra orqanlarının, qəbul etdiyi qanun, qanunvericilik 
aktlarında, sərancamlarda,  müvafiq nazirlik, komitə, təşkilat 
tərəfindən qəbul edilmiş standart və normativ sənədlərdə öz 
əksini tapır. Bu tədbirlərin yerinə yetirilməsi isə inzibati 
tədbirlərlə təmin olunur. İnzibati tədbirlər cinayət və inzibati 
xətalar məcəlləsinin müvafiq maddələri əsasında prokurorluq, 
hüqüq-mühafizə və məhkəmə orqanları vasitəsilə yerinə 
yetirilir. 

Təşkilati tədbirlər kitabxana və ya kitabxananın fəaliyyət 
göstərdiyi müəsissə tərəfindən kitabxana ehtiyatlarının 
müdafiəsi üçün qəbul edilmiş tədbirlər  kompleksidir. Bu 
tədbirlər müəssisənin təhlükəsizlik siyasəti əsasında müəyyən 
olunur və yerinə yetirilir. Təhlükəsizlik siyasətinin tərkibinə 
şəxsi heyətin, idarəetmə aparatının və texniki xidmətin 
ünvanına tələblər əks olunur. İnformasiya təhlükəsizliyi 
siyasətinin işlənməsinin əsas istiqamətləri aşağıdakılardır: 

− Hansı informasiya ehtiyatlarının və hansı ciddiliklə 
qorunmasının zəruri olduğunu müəyyən etmək, 

− İnformasiya aspektində təşkilata kimin hansı ziyanı vura 
bilməsini müəyyən etmək. 
Təhlükəsizlik siyasətinin işlənməsi təşkilatın rəhbərliyi 

tərəfindən təsdiq olunma və ətraflı sənədləşdirmə ilə başa 
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çatdırılır. Bundan sonra planda göstərilən bütün tədbirlərin  fəal 
şəkildə reallaşdırılmasına başlanılır. 

Təşkilati tədbirlər əsasən kompüter-telekommunika-siya 
qurğularının elektrik və yanğın təhlükəsizliyinin, mühafizəsinin 
təmin olunmasına, texnikadan istifadə qaydalarına, 
təhlükəsizlik rejiminin, gigienik-sanitar normalara əməl 
olunmasına yönəlmişdir. Bu tədbirlər xüsusi təlimat şəklində 
hazırlanır və şəxsi heyət bu barədə təlimatlandırılır. 

Proqram-texniki tədbirlər informasiya təhlükəsizliyinin 
təmin olunmasında ən vacib aspektdir. Bu tədbirlər həm daxili, 
həm də xarici təhdidlərə qarşı yönəlmişdir. Təhlükəsizliyi 
təmin etmək üçün proqram-texniki vasitələrlə aşağıdakı 
tədbirlər görülür: 

1. İnformasiyanın elektron arxivinin yaradılması və  
müntəzəm olaraq yeniləşdirilməsi. Bu tədbir bu və ya digər 
səbəbdən xarab və ya itirilmiş informasiyanın qismən bərpa 
olunmasını təmin edir. Adətən, müasir serverlər, lent və disk 
saxlayıcıları informasiyanın surətini insanın iştrakı olmadan 
arxivə əlavə edir. Kitabxanada belə qurğular olmadıqda 
kitabxanaçı bu işi özü və maksimum dərəcədə müntəzəm olaraq 
görməlidir. 

2. İnformasiya ehtiyatlarından və kitabxananın kompüter 
sistemindən qeyri-leqal istifadənin qarşısının alınması. Bu 
tədbir kitabxananın lokal şəbəkəsinin işçi stansiyalarının 
proqram-sistem təminatının, qəsdən və ya səriştəsizlik üzündən 
xarab olmasının qarşısının alınmasını, şəbəkə serverinin 
İnternet vasitəsilə kənar hücumlardan qorunmasını nəzərdə 
tutur.  Bu tədbir aşağıdakı üsullarla həyata keçirilir: 

a) İdentifikasiya və autentifikasiya. İdentifikasiya 
özünü adlandırmağa (öz adını bildirməyə) imkan verir. 
Autentifikasiyanın köməyi ilə ikinci tərəf əmin olur ki, subyekt 
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doğrudan da özünü qələmə verdiyi şəxsdir1. Subyekt özünün 
əslliyini, aşağıdakı mənbələrdən ən azı birini təqdim etməklə 
təsdiq edə bilər: 

− onun bildiyi nəyisə (parolu, şəxsi identifikasiya nöm-
rəsini, kriptoqrafik açarı və s.); 

− onun sahib olduğu nəyisə (şəxsi kartı və ya digər təyinatlı 
analoji qurğunu); 

− yalnız ona məxsus nəyisə (səs, barmaq izləri və s., yəni 
özünün biometrik xarakteristikalarını). 

Təəssüf ki, etibarlı identifikasiya və autentifikasiya bir sıra 
prinsipial səbəblərdən çətinləşir. Birincisi, kompüter sistemi 
informasiyanın alındığı şəklinə əsaslanır, başqa sözlə desək, 
informasiya mənbəyi naməlum qalır. Məsələn, bədniyyətli 
əvvəlcədən «əldə etdiyi» başqasının identifikasiya 
məlumatlarını daxil edə bilər. Deməli, identifikasiya və 
autentifikasiya məlumatının təhlükəsiz daxil edilməsi və 
verilməsi üçün tədbirlər görmək lazımdır. Şəbəkə mühitində bu 
xüsusilə çətindir. İkincisi, demək olar ki, bütün autentifikasiya 
elementlərini oğurlamaq, öyrənmək və saxtalaşdırmaq 
mümkündür. Üçüncüsü, praktikada autentifikasiyanın 
etibarlılığı ilə istifadəçinin və sistem administratorunun 
arasında ziddiyyət yaranır. Məsələn, təhlükəsizlik baxımından 
müəyyən tezliklə, autentifikasiya məlumatlarını təkrar daxil 
edilməsini istifadəçidən xahiş etmək olar. Bu isə yorucu 
olmaqla yanaşı, həm də daxil etməyə göz yetirmə ehtimalını 
artırır. Dördüncüsü, etibarlı müdafiə vasitələri olduqca bahadır. 
Xüsusilə, biometrik xarakteristikaların ölçülməsi vasitələri daha 
çox bahadırlar. 

Autentifikasiyanın ən geniş yayılmış növü paroldur. 
Sistem daxil edilmiş və verilən istifadəçi üçün əvvəlcədən 

                                                 
1 Autentifikasiya sözünün sinonimi kimi 
bəzən “əsliliyin yoxlanılması” sözü də 
işlədilir. 
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verilmiş parolu müqayisə edir. Üst-üstə düşdüyü halda 
istifadəçinin həqiqiliyi təsdiqlənmiş sayılır. Tədricən po-
pulyarlıq qazanan digər vasitə gizli kriptoqrafik açarlardır. 
Parolla autentifikasiyanın əsas üstünlüyü - sadəlikdir. Düzgün 
istifadə edildikdə parollar bir çox təşkilatlar üçün, o cümlədən 
kiçik və orta kitabxanalar üçün qəbul edilən təhlükəsizlik 
səviyyəsini təmin edə bilər. Buna baxmayaraq, xarakteristikalar 
məcmusuna görə onları ən zəif autentifikasiya vasitəsi hesab 
etmək lazımdır. Parolların ən prinsipial çatışmazlığı onların 
elektron ələ keçirilməsidir1. Bu çatışmazlığı istifadəçilərin 
təlimi və ya adminstrə edilmənin təkmilləşdirilməsi ilə 
kompensasiya etmək mümkün deyil. Praktiki olaraq yeganə 
çıxış - rabitə xətləri ilə ötürülməzdən qabaq parolların 
kriptoqrafik şifrələnməsidir. Ancaq hər halda aşağıdakı ölçülər 
parol müdafiəsinin etibarlılığını artırmağa xeyli imkan verir: 

− texniki məhdudiyyətlərin qoyulması (parol çox qısa 
olmamalıdır, parolda hərf, rəqəm, durğu işarələri ol-
malıdır və s.); 

− parolun fəaliyyət müddətinin idarə olunması, onların 
vaxtaşırı dəyişdirilməsi; 

− parollar faylına icazənin məhdudlaşdırılması; 
− sistemə uğursuz daxilolma cəhdlərinin sayının məh-

dudlaşdırılması; 
− istifadəçilərin təlimi; 
− parol generasiya edən xüsusi proqramlardan istifadə. 

Sadalanan tədbirləri həmişə, hətta parolla yanaşı digər autenti-
fikasiya metodları istifadə olunduğu halda da tətbiq etmək  
məqsədəmüvafiqdir. Son vaxtlar autentifikasiya üçün 
tokenlərdən istifadə olunur. Token əşyadır (qurğudur). Ona sa-
hib olma istifadəçinin əsililiyini təsdiq edir. Yaddaşa malik 

                                                 
1 Xüsusi xaker proqramları bu işin 
öhdəsindən asanlıqla gəlir. 
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tokenlər - passiv tokenlər1 və intellektual tokenlər - aktiv 
tokenlər istehsal olunur. Passiv tokenlərin ən geniş yayılan 
növü maqnit zolaqlı kartlardır. Belə tokenlərdən istifadə etmək 
üçün klaviatura və prosessorla təchiz olunmuş oxuma qurğusu 
lazımdır. Adətən istifadəçi klaviaturada özünün şəxsi identifi-
kasiya nömrəsini yığır, prosessor onu kartda yazılanla 
müqayisə edir, həmçinin kartın əsliliyini yoxlayır. Faktiki 
olaraq autentifikasiyanın iki üsulundan istifadə olunur ki, bu da 
bədniyyətlinin hərəkətlərini xeyli çətinləşdirir. Bəzən (adətən 
girişə fiziki nəzarət üçün) kartlar bilavasitə, şəxsi identifikasiya 
nömrəsi tələb olunmadan istifadə edilir. Şübhəsiz, üstünlükləri 
ilə yanaşı yaddaşı olan tokenlərin müəyyən çatışmazlıqları da 
var, hər şeydən əvvəl onlar parollardan xeyli bahadırlar. Xüsusi 
oxuma qurğusu tələb olunur. İstifadə üçün rahat deyil və s.  

İntellektual tokenlər özünün hesablama gücünün olması 
ilə xarakterizə olunur. İntellektual tokenlərin əsas üstünlüyü 
onların açıq şəbəkədə autentifikasiya üçün istifadə edilməsi 
imkanıdır. Generasiya olunan və cavab olaraq verilən parollar 
daim dəyişirlər ki, bədniyyətli hətta cari parolu ələ keçirsə belə, 
hiss olunacaq fayda götürə bilməz. Praktiki nöqteyi-nəzərdən 
intellektual tokenlər birdəfəlik parollar mexanizmini realizə 
edir. İntellektual tokenlərin digər üstünlüyü onların potensial 
çoxfunksiyalı olmasıdır. Onları yalnız təhlükəsizlik məqsədi ilə 
deyil, məsələn, maliyyə əməliyyatları üçün də istifadə etmək 
olar. Onların əsas çatışmayan cəhətləri qiymətinin yüksək ol-
ması, istifadəçinin müəyyən narahatçılığıdır. İntellektual 
tokenlərin adminstrə edilməsi maqnit kartları ilə müqayisədə 
kriptoqrafik açarları idarəetmə səbəbindən mürəkkəbdir. 

Biometrik xarakteristikalara nəzarət qurğuları mürəkkəb 
və bahadırlar, buna görə də yalnız təhlükəsizliyə yüksək 
tələblər olan təşkilatlarda istifadə olunurlar. Kitabxanalarda bu 
qurğulardan az hallarda,  yalnız qiymətli məxfi, informasiya-
                                                 
1 Onlar yalnız informasiyanı saxlayır, amma emal 
etmirlər. 
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ların və proqram təminatının qorunması üçün istifadə oluna 
bilər.  

Çox mühüm məsələ identifikasiya və autentifikasiya 
xidmətlərinin administrə olunmasıdır ki, bu bircins olmayan 
şəbəkə mühitində xüsusilə asan deyil.  Buna adətən əsliliyi yox-
layan ayrıca serverlərin (Kerberos kimi) və ya 
mərkəzləşdirilmiş administrəetmə vasitələrinin tətbiqi ilə nail 
olmaq olar. Qeyd edək ki, mərkəzləşdirmə nəinki sistem ad-
ministratorlarının, həmçinin istifadəçilərin də işini 
yüngülləşdirir. İstifadəçi bir dəfə əslilik yoxlamasındın keçərək, 
öz səlahiyyətləri çərçivəsində şəbəkənin bütün ehtiyatlarına 
icazə əldə edir. 

 b) İcazələrin idarə olunması. İcazələrin idarə olunması 
şəbəkə ehtiyatlarında «hüquqlu» rejimlə istifadəni nəzərdə tu-
tur. Şəbəkə administratoru tərəfindən hər bir istifadəçiyə 
səlahiyyətinə uyğun istifadə hüququ verilir. İcazələrin idarə ol-
unması - çox istifadəçisi olan sistemlərdə «hüquqsuz» 
istifadəçilərə xidməti qadağan etməklə, informasiyanın tam 
məxfiliyini və tamlığını təmin edən əsas mexanizmdir. İcazə 
hüququna nəzarət proqram mühitinin müxtəlif komponentləri - 
əməliyyat sistemi, əlavə təhlükəsizlik vasitələri, verilənlər ba-
zasını idarəetmə sistemi, ara vasitəçi proqram təminatı 
(məsələn, tranzaksiyalar monitoru) tərəfindən həyata keçirilir. 

c) Protokollaşdırma və audit. Protokollaşdırma dedikdə, 
informasiya sistemində baş verən hadisələr haqqında 
məlumatın toplanması və cəmlənməsi başa düşülür. Audit - to-
planan informasiyanın operativ (demək olar ki, real vaxtda) və 
ya dövri (məsələn, gündə bir dəfə) aparılan təhlilidir. Protokol-
laşdırma və audit vasitəsilə informasiya təhlükəsizliyini pozma 
cəhdlərini, sistemdə     problemləri aşkar etmək olar. Audit 
nəticəsində nəinki təhlükəsizliyi pozan səbəbi, həmçinin 
səbəbin günahkarını tapmaq, vurulmuş ziyanın miqyasını 
qiymətləndirmək olar. Butün bunlar isə  sistemi normal işə qay-
ıtmaq üçün çox əhəmiyyətlidir. 
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d) Kriptoqrafiya. İnformasiyanın məxfiliyinin təmin 
edilməsi və tamlığına nəzarət üçün ən güclü vasitələrdən biri 
kriptoqrafiyadır. Bir sıra hallarda kriptoqrafiya digər proqram-
texniki tədbirlərin realizə olunması üçün əsas rol oynayır, 
bəzən də yeganə müdafiə vasitəsi olur. Məsələn, informasiya 
hətta «oğurlansa» belə kriptoqrafiya  məxfiliyə təminat verir. 
Kriptoqrafiya informasiyanın xüsusi alqoritm əsasında 
şifrələnməsini nəzərdə tutur. Bu zaman informasiya müvafiq 
şifrəni bilməyən istifadəçi üçün «başa düşülməz» formada ola-
caq. Kitabxanada bu üsuldan demək olar ki, nadir hallarda, yal-
nız dövlət əhəmiyyətli, xüsusi qrifli bəzi sənədlərin mühafizəsi 
üçün istifadə olunur. 

 e) Elektron rəqəm imzası. Elektron rəqəm imzası in-
formasiyanın əsliliyinin təsdiqi və onun tamlığı məsələsini 
nisbətən asan və ucuz həll etməyə imkan verir. Elektron imza 
ən azı üç funksiya yerinə yetirir: birincisi-imzalayan şəxsin 
təsdiqini, ikincisi-imzalayan şəxs imzaladığı sənəddən boyun 
qaçıra bilməz, üçüncüsü-göndərənin başqa sənədi deyil, məhz 
göndərdiyi sənədi imzaladığını təsdiq edir. Başqa sözlə, imza 
sahibinə başqa və ya oxşar sənədi zorla qəbul etdirmək olmaz, 
çünki onda orijinalın imzalanmış surəti var. Qeyd edək ki, bir-
inci iki funksiya sənədin nəzərdə tutulduğu şəxsin maraqlarını, 
üçüncü isə imzalayanın maraqlarını müdafiə edir. Ümumi halda 
elektron  rəqəm imzası  konkret məlumata (mətnə, fayla və ya 
ixtiyari uzunluqlu istənilən bitlər yığınına) əlavə olunan və 
yuxarıda qeyd olunan üç funksiyanı təmin etməyə imkan verən 
sabit uzunluqlu informasiya blokudur. Kitabxanada bu üsuldan 
rəsmi yazışmalar, elektron sənəd göndərişi zamanı istifadə ol-
unur. 

 3. Kompüter texnikasının saz vəziyyətdə olmasının təmin 
olunması. Bunun üçün müntəzəm olaraq profilaktik və 
diaqnostik tədbirlər görürməlidir. Bu tədbirlər arasında ən 
zərurisi virusa qarşı mübarizədir. Bu mübarizə yalnız aşağıdakı 
şərtlərə əməl olunduqda effektli ola bilər: 
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a) Bir neçə, müxtəlif antivirus proqramlarından istifadə 
etmək; 

b) Müntəzəm olaraq İnternet vasitəsilə antivirus pro-
qramlarını yeniləşdirmək; 

c) Lisensiyasız və ya «pirat» yolla əldə edilmiş in-
formasiyalardan istifadə etməmək; 

d) «Şübhəli» poçt məlumatlarını oxumamaq; 
e) Mənbəyi  məlum olmayan informasiyalardan istifadə 

etməmək; 
f) Kompüterə «kənar» və yoxlanılmamış informasiya 

daşıyıcılarını - disketləri, CD və DVD diskləri, fləş 
yaddaşları və s. daxil etməmək. 
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